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Inside System Preferences: System
Tweak your trackpad settings in
System Preferences

Use Hot Corners in macQOS

Set up and use Split View

Recover files with Time Machine

Use Disk Utility to check the health of
your hard drive and repair it

Use AirDrop to share files
Set up and explore iCloud Drive

Get to grips with Family Sharing



The next step

Set up email on your Mac

New features in Mail for High Sierra

Feature

Configure websites in Safari 11 126 Create a
Start using Apple Maps masterpiece
in iMovie

Browse the internet

Get to know the Mac App Store

Download apps from the Mac Store

Delete and reinstall apps on your Mac

Clean your Mac and get more space _ : ;
Get started with iTunes GOII'Ig further Wﬂrklng with macOS

Organise your iTunes music library

| | iMovie editing masterclass 150 Master the new features of Notes
Download music from iTunes

Master iMovie's precision editor 152 Keep your contacts in an

Set up and use Apple Music address book

Keep your Photos library organised

RE‘“IT and buy "T“?'”I'E‘-‘-i on ifunes Search your library by objects 154 Build documents with Pages
NAVIgaD= the riew ISooKs Take control with Photos’ Curves 156 Create and save a custom template
Get to know the Calendar How to use Drum Designer 158 Create a spreadsheet in Numbers
Add an alarm to a Calendar event e Hrsies with Teimpa Tick 160 Visialica déta in Niabers

Set up Messages for every device techniques in GarageBand 162 Add notes in Keynote

Discover FaceTime for Mac Learn to stay in tune with the Tuner

Essential apps

164 50 essential Mac apps

"Macs are great, whether it's work
or play you have in mind”

Mac for Beginners 7



I Ultimate guide

x E m 9% ¢

Featured Top Charts Categories Purchased Updates

New Apps and Games We Love

™ Habitify: Habit Tracker Weathar Guni: Hourly Tip r A Spectra - Video & Audi

GRS £7.99 + GET - | £19.99 =

c19.9 799 1 < 4 | CIXIE

Shazam star Chet; Cooking Ga Maan Invaice - Easy In 1A Writer

[ ] f i I - i 4

R Ha "R R R 5 K3t TR E R & ‘H SRR R G ATIAO
L OET v OET = | OIT = | £28.99 =

n-App F | d Pl
Artstudio Pra: Draw Pai Foly Bridge The Long Journey Home The Unarchaver
- 8 B

 £38.99 « | 999 ~ 134.99% L INSTALL =

Anamorphic Pro Stave'n'Tabs

Starman GoodTask 3
S S B .

Y,

F N & 4
rwriorm i, fany! I'--|.-\.|_-\.--\..--|-l--.||

[T ED L GET -

8 Mac for Beginners




»lal B Y.

AR Vel

iA Writer

CrazyTalk’ 3

macS High Seerra

Apps Made by Apple

Miéw ta thé Mac App StoreT
Great Frep Apps & Games
Final Cul Pro X

e

:_:1|JI|'_ Frp A

Apps Towr Designess
Motificabon Center Widgets
n the Direclor's Chair

Macs In Class

Explore Your Creativity
haking Music

Log That &

Personal Projects

O

ultimate
guide to
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Taking you through everything you need to
know to get started on your Mac

elcome to the Mac, and welcome to the Mac community. If this
Wi5 the first time you've owned a Mac, trust us, you're in for a real

treat. The Mac is a multi-talented computing phenomenaon, part
entertainment device, part office workhorse, part creative tool, part media
hub. But among all its talents, there's one constant; you'll enjoy using it. If
you're used to fighting to get a PC to do the simplest thing, you'll find your
new Mac a breath of fresh air. It doesn't get in the way, and the many joys of
discovering your Mac's benefits lie ahead.

"‘Among its talents, there's one
constant: you'll enjoy using it”

However easy the Mac is to use — its reputation in this regard is well
earned — it's also true that starting out on a new computer or on a new
platform can seem daunting at first. Parts of it will inevitably seem unfamiliar.
That's where this book comes in. Over these pages we'll take you through
everything you need to get going and start enjoying your iMac or MacBook
and the latest High Sierra operating system. Soon you'll be taking off with
the Mac. It won't be long before you find yourself offering tips you've
discovered to other Mac users — and gently extolling the benefits of the Mac
to others.

Mac for Beginners 9
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18 Jul 2007 ot 23:55

macO5 is the operating system (O5) that all Macs
use to run their software; the current iteration
is macOS High Sierra. It is free to download and
system updates are regularly available to boost your
Mac's performance by going to Software Update in
the Apple menu and checking for updates.

macO5 has developed over the years to bring
a wealth of goodness from iPhone and iPad to
the Mac, which complements the features of the
previous operating systems — such as Launchpad,
which enables you to see and open your apps in a
manner very reminiscent of the touch-screen i0%
dynamics. macO5S Sierra, brought Apple’s intelligent

o4 KB O e athe

Applecainn

L OZEHGOLPEE LV & L000Y4

assistant Siri to your mac. High Sierra has added a
few improvements to Siri; it can now identify music
and offer recommendations. Since OS X Yosemite,
in-built apps include Messages, which lets you send
free messages between all Apple devices; Maps to
explare the world on your desktop; and MNotes,
which lets you jot down quick and easy
notes that are synced to your iCloud,
Speaking of iCloud, this system
binds all of your devices together,
integrating your emails, calendars,
contacts, reminders, documents
and more, so that whenever you




T .. | E @ 6 c
m hL

Date and time

You can view the time as
an analogue or digital clock
by clicking and holding the

mouse button here

B

Cover Flow

You can view folders
and their contents as
scrollable thumbnails in
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Background
The desktop wallpaper is set
to Wave by default, though
you can change this in the
Systemn Preferences’ Desktop
& Screen Saver menu

add, delete or change something on your Mac,
these changes also occur automatically on your
other devices too. Other features such as the
Natification Centre, guarantee you'll never miss
an important email or message again,

Entertainment

The Mac has made a name for itself as a creative
device, but it'll also help you relax. All your
favourite media can be browsed on a Mac, and
thanks to the brilliant iTunes, it can all be accessed
at the click of an icon.

In the mood to watch a movie or catch the
latest episades of your favourite TV series? iTunes
has expanded from its original role as a music
player and organiser, and now it can handle your
whole video collection just as easily as it does
your audio library. What's more, your downloaded
videos will be catalogued neatly, organised how
you like it so you can easily locate what you want
to watch when you want to watch it

The iTunes Store also holds a growing video
collection that you can either rent and watch
on your Mac. Both current and classic films are

Browsing

If we were to make the bold claim that the Mac
offers the best way to browse the web, you would
probably ask for evidence.

So here's exhibit one; Safari, the Mac's built-in
web browser, It's not only one of the fastest and
best-looking browsers around, but it also complies
with modern web standards, which means that
the latest cutting-edge websites should appear
exactly as they were intended. Safari also comes
with clever features such as private browsing,
which hides your browsing history from prying
eyes, and a neat "Top Sites’ view that presents
small previews of your most-visited sites on one
page and lets you visit them with a single click.
Very convenient. Safari allows you to turn off auto-
play for videos, so when you enter a website you
are not met with unwanted noise.

"Browsing the web on a Mac you're far less
susceptible to viruses than on a PC”

available, and there's a good cheice of television
episodes too, particularly when it comes to
comedy. You may have a limited time to watch
rented media, but it'll be cheaper for it!

Don't forget podcasts either. Some of the video
podcasts in the iTunes Store - all free, remember
- offer excellent quality.

While you can play videos fullscreen from
within iTunes, you can also opt to activate AirPlay
- Apple's wireless streaming technology — which
lets you stream video as well as audio from your
Mac over a Wi-Fi network through Apple TV. 50
even if you download your videos to a MacBook,
iMac or any other Apple device, you can still enjoy
them on a really big screen.

Don't forget that you can also watch live or
archived television foatage on your Mac through
a web browser. The BBC's iPlayer (www.bbc.
co.uk/iplayer) has earned a fine reputation, but
several other channels also offer either a live
view or an on-demand service of previously
broadcasted television shows.

If vour entertainrnent interests are more
cerebral, what about reading a book? iBooks is
the go-to app in your Dock, The app works in
the same way as the 105 version and all of your
previous mobile purchases will be synced with
your Mac and appear on yvour iBooks shelf, While
reading, an intuitive interface lets you make
bookmarks, highlight passages of text and add
notes, and the store is just a click away,

Another great feature, for those of us who
hate the ads that clutter webpages, is Safari's
Reader mode, With a single click, webpages are
transformed to show the important textin a
simple scrolling, image-free window:. In Safari's
settings you can set it so the browser always
enters Reader mode if the webpage allows the
feature. When it comes to reading online, nothing
should interrupt the experience.

Exhibit two: choice. It might surprise many;
but Macs come with a far bigger range of
web browsers than PCs do. You may not find
Microsoft's Internet Explorer here, but on top
of other big browsing names (Chrome, Firefox
and Opera), there are niche alternatives such as
Omnigroup's OmniWeb (www.omnigroup.com)
for you to try.

Exhibit three: security. You'll be more
comfortable browsing the web on a Mac because
you're far less susceptible to viruses or other
malware than on a PC. Especially as Apple has
introduced Intelligent Tracking Prevention, a
system that identifies those wha may track your
data, perhaps for advertising, and Safari removes
it. And if it's the kids you're worried about, you can
rest assured that your Mac comes with a full set of
parental controls - found in System Preferences.
There are other cool features to enjoy, such as
the Sidebar, which provides easy access to your
bookmarks, Reading List and your browsing
history, and a faster all-round performance.

Mac for Beginners 11
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Music

As the creator of the iPod, the most successful
music player in history, Apple has long had a special
relationship with music. "Why music?” asked Apple
legend Steve Jobs rhetorically in 2001, the year
iTunes was launched. "We love music. It's part of
everyone's life.” Nowhere is this view more apparent
than within iTunes.

Some will use the app as a simple music player,
either with music imported from their CD collection
or with that bought directly from the iTunes Store,
Through iTunes it is easy to browse and preview
single tracks, buy them with a single click and be
listening to them on your Mac seconds later. Gone
are the days of waiting until the shops are open to
get your hands on a much-anticipated release!

Others will use their Mac as an audio hub. iTunes
can sync your music library to iPods, iPhones and
iPads wirelessly by using your personal iCloud
account, so you can take your tracks wherever
you go. What's more, with the recent addition of
Apple Music, the service has taken a huge market-
leading leap. Apple Music is a subscription-based
music streaming facility allowing you to access a
limitless number of songs and albums for a single
meonthly payment.

ITunes also comes with a cool feature called
AirPlay. If vou have a compatible device, such as
AirPlay-enabled speakers, an AirPort Express wireless
device or an Apple TV, you can stream your music
from your Mac straight to them. Home Sharing also
allows you to share your music with other iTunes
users connected to your home network.

The Mac isn't just great for listening to music,

You Can create it too, thanks to GarageBand.
GarageBand allows you to create your own music,
either using the built-in instruments or by recording
a real instrument by plugging it into your Mac. Even
if vou're an absolute beginner, GarageBand can be
fun. You can drag pre-built ‘loops’ of audic onto
tracks to build up a song, and even begin to learmn
how to play an instrument by downloading free
basic music lessons from within the program,

12 Mac for Beginners

. Air Canada 858
FLGHTY
o R
@ ACASS - Departing 2R a1 TI5E.. '4':; A e
T : -
BiIWWIE

T fligtiaware.com o
B Nighiredar?a com
sealgury com

Alr Canadn

ACESS

IIIIIIII o |

At rd

Dy M

Moiom I F Mo |t R

02: Changing
brightness and volume

We all like to work in different ways,
especially when it comes to sound volume
and image brightness. You can control
sound volume using sliders within an app
like iTunes, or instead drag the master
volume slider up or down from the top
right of the main menu bar. To change
Brightness, simply use the slider in the
System Preferences=Displays option.
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04: Minimising and
maximising windows

The desktop can soon get cluttered with
multiple open Finder or app windows.
You can use Mission Control to tile them,
then click on the one that you want to
view full size. Alternatively, click on the
yvellow Minimize icon at the top left of any
window and it'll shrink down to the Dock.
The green Maximize icon will make the
window expand back up to full size,

Top 10 tips

01: Using Spotlight
macOS's Spotlight enables you to find
text, images or movie files anywhere on
EUAoE vour Mac. Click on the search icon at the
suura top right of the screen and type into the
| search field. Then click Show All to see
search results from a variety of sources.
You can also customise Spotlight to
meet your spedific needs. Spotlight
can even be used to search for flight
p— details such as arrival/departure times by
e entering the flight number.

Slalus
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03: Setting
up passwords

If you pop out of the office and leave
your Mac unattended, you can get it
to lock when the screensaver activates.
Go to Systemn Preferences=Security &
Privacy and then select the General
tab. Click the option to ‘Reguire
password after sleep or screensaver
begins, then pick a time for this
password protection to kick in,
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macQOS is a joy to use compared to Windows, with many user-friendly and powerful features
that make your life easier. Here are some top tips to get started with macQS, from changing the
appearance of your desktop to creating multiple user accounts and securing your system

Tha w8 b d e rars Foy yoor hors baiden

(B i s o ﬂl Ll 0 hoasrd e s iyl
how wdamale paraseniod

Ar rigemat connecion wil bo moogubed ehan
iy wsar kogs oo Ihe symiem ko ire Fran Gme.

{a} Loginoy
+ ]

L4
Bl Ches mve ot o pemvir fushir Chasges

Canpel Crtarin Ueas

o g Rl Foy , macior 3o TellEtEE

i T Marve app =11, ]

i e iru] ¥
B g4 Mode sfiscepe [ Tevices foos D
-m i oo censLoac
Py Sppicatorm | i@l oeee o
o Oea! Byt W AR

05: Change
the background

To make yourself feel more at home
you can change the default desktop
background. Go to Apple=System
Preferences=Desktop & Screensaver.
Browse through a variety of themed
folders for an eye-catching image

[or rummage through your Photos
Library for something more personal).
Click to select a new background.

06: Set up multiple
user accounts

To stop others tinkering with your files or

settings, give them their own user account.

Go to Apple=Systemn Preferences>lsers &
Groups. Click the padlock and enter your
Admin password. Click '+ to add a new
account. This user can then choose their
own password. Any changes they make to
things like the desktop background will be
unique to their account,

07: Create and
rename folders

To create a new folder, click on the Gear

icon at the top of an existing folder and

then choose New Folder from the drop-

down menu. Alternatively, on the menu

bar at the top, head to File=New
Folder. By default, each folder is
labelled as ‘untitled’, Click on the
label and then type something
more infarmative,

08: Add applications
to your Dock

Docking a favourite application
makes it easier 1o access. Browse
to the Applications folder to see a
specific application's icon and then
drag it to the Dock. You can then
launch it by clicking on its docked
icon. Remove unwanted docked
applications by dragging them
from the Dock. They'll vanish in an

09: Use Siri from your Dock

If vour Mac has a microphone built-in - as
most Macs do - or you have one connected
then you can access Apple'’s intelligent
assistant Siri. Click on the Siri lcon, enable the
service if it's not currently on and then you can
ask it to send messages, search for content on
your Mac or ask it questions all just from using
your voice,

Are you sure you want bo quit all
applications and log out now?

B you g nothing, you will b logged out sutomaticaily
i 58 ssconds.

Reopen windows when logging back in

Cancel Log Out

10: Log off and shut down

To log off after a hard day's work (or a fun
gaming session) go to Apple=Log Out. Click

the Log Out button. This will take you to the
macOS screen, where you can click Shut Down
(or let someone else log in to use their account).
Alternatively, press your Mac's power button and
choose the Shut Down option.

Mac for Beginners 13
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The Dock at the bottom of the screen enables you to e
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access commonly used applications with ease

Launchpad -~
Clicking this icon will bring
up a window containing all

of the apps on your machine,
making it easy to launch them

Finder
Think of this as
a doorway to
other folders and
applications. The
Finder helps you
find and access
any file

Siri
Using a microphone
you can talk to
your mac and ask
it questions, find
files on your Mac or
perform tasks

% B

Photos

If the extent of your photo organisation in the past
has been 1o loosely organise them in folders on
your PC, or even just to shove prints in a shoebox,
you'll be stunned by the organisational prowess of
your Mac's Photos app.

Photos gives you a whole new way to easily
sort and group your photos. For example, its Faces
feature automatically recognises faces in images,
groups them together and lets you add names to
them. This automatic recognition was also improved

14 Mac for Beginners

Imagination is a gift.
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Safari
Fire up Apple’s native
web browser by clicking
here, then enjoy a safe
and pop-up-free surf

}
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Mission Control
Click this icon to view all
of your open files and
apps, making it easy to
find any files or windows
currently open on your
desktop quickly

including a clock,
calculator, calendar and
even a weather forecast

in the update to High Sierra giving you even more
accurate results.

This technology is also used for the new
Memories feature. The sidebar in the Photos app has
been tweaked, here you will find the Memaories tab.
Photos will scan your images for a theme, location
or even pets and then collect these into their own
album. Every time you upload images to your Mac,
check the Memories tab to see if it has created any
new albums. These can be viewed as a slideshow or
video and then shared with friends and family:.

If there's a downside to digital photography, it's
the tendency for shots to be kept on your computer
rather than shared. Photos, however, encourages
you to post images to Facebook or photo sharing
site Flickr. And it can even be used to design
letterpress cards, books and calendars.

the step-by-step
instructions to set
up an account

e
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MNotes

LContacts
-

This app lets you
store vital contact
info. With Mavericks
you can update this
by using all of your
Facebook contacts

The new MNotes app
lets you create quick
and easy notes, place
them on your desktop
and then sync them
across all devices
using iCloud

Dashboard Mail Calendar Reminders
Click here to access Launch the Mail Keep track of Create quick and
a variety of handy app by clicking important dates easy to-do lists,
floating widgets, here and follow and events using set yourself alerts

this powerful but and then get them
easy-to-master synced across all of
calendar app your O5/i0S devices

Storing your images in the Photos app also makes
them available in other iLife and iWork programs,
making it easy to add images to slides in Keynote,
Thanks to the High Sierra update, Photos is an
all-singing, all-dancing photo editor in the vein of
Photoshop thanks to its advanced editing toagls. You
can correct the image's colour, light and reduce the
noise among a number of other features. If you'e
new to editing, you could always simply tap the
Auto function and tap Reset Adjustments to undo
any changes.

Perhaps the best feature of all though is that
through your personal iCloud, you can activate
Photo Stream, which automatically pushes photos
taken on your iPhone or iPad to all of your devices,
including your Mac, without the need to plug
anything in or manually transfer files.
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Maps
Another welcome Q5
X addition, the Maps

app lets you explore the
world in fullscreen and
marvel at the wonder
of awesome 3D Flyover
mode

iTunes

Subscribe to Apple

Music, browse the
iTunes Store and play

everything on your
Mac. You can also buy

i05 apps here
|

Terminal
If you want to go
really in-depth
with how your Mac
operates, this allows
you to customise it

APSore
This Bustling online
storé Tewhere you can
purchase apps for your
Mac. The fijhl;ﬂ'l at makes
it easy to séarch and
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using commands browse through apps

by category
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Photos
This app enables you
to store and edit your
photos, It neatly organises
them by date and time
and allows you to create
and share albums

Messages
The new Messages app lets
users send free iMessages
to any other Macs, iPhones,
iPads and iPod touch
devices, including those of
your friends

-
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Video

What do True Gritand The Social Network have

in common? Apart from being two box-office
blockbusters, both movies were edited on a Mac
using Mac-only software. It's a growing trend, and
one that's becoming accessible to more people -
not just professional film-makers. Ten years ago, you
would have needed to sell your house and car to be
able to afford that sort of editing functionality, but
now you can do it using equipment costing just a
few hundred pounds.

Time Machine
If you plug an external
hard drive into your

System Preferences
You can do a host
of things here, from

Mac, you can then use changing the desktop
this app to back up wallpaper to modifying
the entire contents of the size, shape and
your computer location of the Dock

If you've got a video camera and a Mac, you
already have all the hardware you need. If your
camera is a relatively recent model, it's a decent bet
that you'll be able to start working with it without
even having to install drivers or tweak settings.

While many top-of-the-range movies are edited
using the high-end Final Cut Pro on the Mac,
iLife’s own bundled iMovie is the gold standard of
home video editing. Editing in iMovie is as simple
as importing your footage and then placing it
into a project area, Simply drag and drop to add
transitions between scenes or titles, and there's
a full array of sound effects that you can use to
enhance the audio quality. Even if your original
footage isn't top quality, iIMovie can improve it.

It has a stabilisation tool to correct shaky video
and individual clips can be colour-corrected. The
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Trash

Click on this icon to
have a quick check
of its contents, then
Control-click on it
to find the Empty
Trash option

professional look is enhanced through iMovie 11's
templates that help you quickly create short and
mermarable trailers for your work.

The real beauty of iLife applications is the way
that they work together, With the iLife media
browser, you can add a soundtrack from iTunes or
images from Photos or even export your video 1o
iDVD to create permanent keepsakes on disc. That's
not the only export option either: you can also
share directly to popular video-sharing sites such as
YouTube or Vimeo.

And naturally, there's an easy transition to even
more powerful tocls, Final Cut Pro X isn't too
expensive (£299.99/529999), and it is the latest
version of the famous Final Cut editing suite. It
imports existing iMovie projects while allowing you
to work with multiple audic and video tracks.
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Gaming

It used to be said that the Mac lagged behind
Windows when it came to games, but that's far
less true now. There are plenty of reasons for this
change. The attention of games developers has
been grabbed by the Mac’s ever-increasing market
share. Also, the Mac’s transition to running on

Intel processors a few years ago resulted in both
performance improvements and easier porting of
games from the PC platform.

[he arrival of the Mac App Store has also proved
critical. It has given exposure to Mac games
developers who would otherwise struggle for
the limelight. That has benefited the developers
of games like Call Of Duty and Batman: Arkham
Asylurm, which have been sorme of the App Store’s
biggest sellers since it launched in January 2011.

The arrival of the Mac App Store has also
encouraged existing iPhone and iPod game
developers, already familiar with the App Store
format and Apple's development tools, to try their
hand at the Mac games.

The conversion process is comparatively simple,
and as a result, titles that originally grabbed
attention on the iPhone, such as Angry Birds, Flight
Control and Plants Vs Zombies, have been ported
successfully to the Mac, Crucially, in many cases, this
transfer has come ahead of their arrival on PC or
console systems.

And Mac users don't just have a better choice of
games now. The arrival of Game Center means it
has never been easier to shop for Mac games (via
Game Center's internal link to the Games section of
the App Store), and you can also use it to compare
scores and challenge your friends online.

There's another reason for the Mac's growth:
the arrival on the Mac platform of Steam, a digital
distribution platform that boasted 25 million user
accounts before it arrived on the Mac. However,
now Mac gamers have feature parity: Steam games
release simultaneously on Windows and Mac. If
you're a Windows Steam user, though, there's great
news: if you already own the PC version of a game
on Steam, you get Mac versions at no extra charge.
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Shortcut tips

The brilliant thing about macQO5S is the way it lets We'll cover shortcuts that work with macQO5,
you control the way your Mac behaves with a few plus show you some generic key combinations
taps on the keyboard. These keyboard shortcuts that will work in most applications (like copying
can speed up the way you interact with your Mac,  and pasting). Many shortcuts use the key with
so you are able to clear away clutter, find files fast the Apple logo on it — well refer to this as the
or jump between open applications in a click. By Command key in our tips, since some wireless
knowing the keyboard shortcut for a command, keyboards don't feature the Apple logo on the
you no loenger have to drag the mouse up to the Command key. The key with Alt on it is the
main menu and rummage around in submenus! Option key.

Command+Z Option+Shift+Command+Escape
This is the Undo function If you hold these keys down for three seconds, you'll Force Quit
in most applications. the currently-open app. Only do this if an app freezes up.

-

Command+C Command+Shift+3
Copies selected text, Takes a screenshot of your display and saves
documents or even images. it as an image file to the desktop.

Command+V Command+S
Pastes anything you copied This shortcut saves the current
with the Cmd+C shortcut. document, using the same name.

Command+N Command+Tab

This will give you a new This activates a handy mini-Dock.
document in any application Keep pressing Tab to switch between
you're using. currently open applications.
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Spacebar

Tap the Spacebar when you've
selected an image or document
in Finder to get a Quick Look at its

contents without having to open it.

Fg:'.l:'f ina an older (%)
Activates Mission Control to tile
all open documents into handy
little thumbnails.

windows in your currently
active application.

Command+Space
This shortcut opens the
Spotlight Search window.
You can immediately start
typing a search term.

F4

This summons your
Mac's widgets.

all T *
Office

If you didn't think of the Mac as an office workhorse,
think again. Easy to use, supremely resistant to
viruses and coming with a reputation for reliability,
Apple desktops and laptops tick plenty of hard-
nosed business boxes.

But what about the software? The good news is
that the dominant office software is available on the
Mac - and it's just as good as the one on Windows.
Microsoft Office 11 for Mac has virtually the same
functionality as its PC sibling, but looks better. You
can swap Word and Excel files with PC users and
even share Outlook calendars on a connected
server. Plus, recent Macs come with built-in support
for Microsoft Exchange Server 2007, so if you use
Exchange at work, the chances are that you can
access all your emails and calendars at home too.

Apple has been making its own steps into the

office space too. Its Mac-only iWork suite, the
components of which are now free to download,
also features word processing, spreadsheet and
presentation capabilities. If its word processing
and spreadsheet tools lack the complete range
of functions of Microsoft's equivalent tools, they
are at least arguably easier to use. iWork's Keynote
presentation software is a genuine alternative to
PowerPoint, with its more polished templates and
more impressive transitions.

iWork files are also Office compatible: files saved
in Office on the PC can be opened in Pages,
Numbers and Keynote, while you can export them
from iWork in PC format too. What's more, you can
sync documents to your iCloud and access them
from any computer or iO5 device in the world to
continue working on them — and everything saves
automatically so you don't have to worry about
work being lost. The anly thing missing in both
the Microsoft Office and iWork suites is a decent
database, but even here you're spoiled for choice;

pick between Filemaker (www.filemaker.com) or

iDatabase (www.apimac.com/mac/idatabase),
which presents a budget alternative.

Office work isn't all about spreadsheets, letters
and slideshows, though. What about managing
your accounts? There's

plenty of choice here

too. AccountEdge (www.
mamut.com/uk/mac/
accountedge) and
Business Accountz (www,

accountz.com) are

Command+F3
or F1 | Command+Escape

 This opens Front Row, so
you can enjoy media like
maovies and photos.

"Shortcuts
can speed
up the
way you
wWork”

@ Control+F3

This displays all the open
D This command hﬁﬁhe—s—ail open
windows to the side so you can

see the desktop.

i Option+Command+Eject
— When it's coffee break time, this will put
your Mac to sleep. Push any key on the

keyboard to wake it up again.

Command+Backspace
This shortcut sends the selected
file(s) to the Trash, so you don't
have to drag them there.

Option+Command+D
In System Preferences, you can make the Dock pop up when
you move the mouse over it, or press Option+Command+D.

-~

MAGIC
M 0 U S E '?If::sl no wheel on this

mouse; just slide your
finger down the middle

Right click e bath reasonably priced

If you do this while and capable desktap
selecting a word in Control+Scroll applications. So you see
Safari, you can choose This combo enables Mics eover il Bases WhJE'ﬂ
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‘Look Up in Dictionary’ you to zoom in to geta
from the context- magnified view of what's

sensitive pop-up menu. on the screen.

— J

it comes to personal and
professional use,
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@ iTunes top tips

PdeUCthIty Organise your music collection with iTunes, stream over 30 million
Keeping yourself organised has never been more tracks with Apple Music and sync songs with mobile devices
demanding. But your Mac, and its built-in calendar

application, can help you to keep on top of The way that we manage music has changed collection, as well as discover and buy new music
things. Calendar (formerly iCal) supports multiple dramatically since iTunes and mobile devices like (or movies) via the iTunes Store. That's moved on
calendars - so you can track work and family the iPod and iPhane came along. Once you've even more with the addition of Apple Music, with
commitments separately — and you can view copied your CDs into your iTunes app, you'l its paid-maonthly subscription service and 24-hour
calendars in several ways: by day, week or manth. rediscover music you haven't listened to for years. radio station, Beats One, Here's are some of the
You can invite others to events you create and set [hink of iTunes as your personal digital jukebox! ways you can take advantage of iTunes 12, the

an alarm to remind you before it starts. You can use it to store and organise your music latest version.

The calendar also lets you sync appointments
with iPhone, iPod touch or iPad Calendar apps,
using iTunes as a handy go-between. If you use
Apple’s iCloud service, you will also have the
ability to sync your calendar without a physical
connection, and you will be able to share
calendars between multiple Macs too.

Beyond its calendar, the Mac has been built
to take control of the chores while you do what
you want ta do. For example, every computer
user knows they cught to back up regularly, but
the organising of backup discs and choosing
what to copy invariably gets in the way. Not on
a Mac. Here, backing up is as simple as attaching
an external drive. Apple’s Time Machine backup
utility takes care of the rest.

To be truly productive, you need to get as
much done as possible while avoiding those
repetitive tasks that can take up a lot of your
time and become quite frustrating. Automator is
a drag-and-drop tool for automating common '
chores. You build a workflow by piecing together — BLLY TRLENT Ii [.%w“-’u! vy
actions and the saved result autormates the task in P i) B mm Rainbow

Ei-_-:-'ﬁ w8 E s e TS e Q =

the future, With some applications, you can just
record your mouse and keyboard movernents
and save the result to an Automator workflow,
where they can be stored and replayed. It's like
programming without the hard work,

Another often overlooked productivity
treat for many Mac users is Services, which MacBook
cormprises small pieces of
functionality that can be
shared between different
applications. Accessed
from the application menu (if you are

iﬁiﬂ@ﬂﬂiﬁ B L~ 12 B

in iTunes, for example, Services can be found

under the iTunes menu), services suitable for the e e e B e New softwarg . |
current application automatically appear — so if pr— ™ - Like other apps, iTunes is always evolving to include
you're working in a word processar, you might o i improved performance and extra features. You

see a service to send the currently selected text in spoa. may be informed that newer versions of iTunes are
an email. Furthermore, if you don't find a service o available when you open the app, but you can also
you would like to see, you can easily build one of . check out any updates by going to the iTunes menu
your own — using Automator, of course, There e (look next to the Apple icon in the top menu bar)
are plenty of options on your Mac to make you i and choosing Check For Updates. You can then
more productive. download and install the latest version of iTunes.
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MiniPlayer

To reduce the size of the iTunes interface, simply go to
Window=Switch to MiniPlayer. This turns iTunes into a small
floating mini player that enables you to perform useful
commands like playing, pausing, jumping forward to the next
song or even searching your library. You can adjust volume

Add to My Music

If you're using the Apple Music trial
or you're all officially signed up, you
have access to the entire iTunes schine -
catalogue, which totals a staggering
30 million tracks. When you come
across music that you want to add
to your library (you don't have to
buy it), and click on the download
icon or find the three-dot icon and
select Add to Playlist. That track or
alburm will now live in the My Music
tab in iTunes,

L

"Once you've co
[Tunes app, you

4 ILrvn o Povciey 21011 () +

here too by using the slider in the AirPlay menu.

I ke 0 TEE L= -
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Play Later
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Delete From Library
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B Get Album Artwork |
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ened to for years'

For You

The more you use Apple Music, the better it gets at
predicting what you want to hear. If you spend a little
time telling the streaming service what you like (head

to your user account and select Choose Artists For Youj,
including genres and artists, then your For You tab will

pe filed with personal playlists guaranteed to make you
smile. For You also picks up on every time you ‘favourite’
a track or album by dlicking on the heart symbol. You'll be
amazed by how accurate Apple Music soon becomes.

Get Album
Artwork

If an album in your Library
isn't displaying the cowver,
right-click on it and choose
Get Aloum Artwork. iTunes
will then trawl an online
Batety database for appropriate
covers. If no album art can
be found then you may add
yvour own. Right-click on
the album, choose Get Info,
then Artwork and click Add
Artwork 1o select a file,

wri

nay rediscover music you

Sync an
Phoe or iP
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01: Plug in your gadget
When you plug your iPhone (or iPad)

into your Mac via a USB cable, click on

the relevant icon under Devices. Click
Summary. Tick ‘Open iTunes when this iPad
(or iPhone) is connected'. Tick 'Sync only
checked songs and videos.

larwed LY

2: Choose what to sync

Click on the Music tab in the main window.
Tick Sync Music to see songs on your Mac,
Tick Selected playlists, artists, albums and
genres. Tick the playlists or albums that you
want to sync onto your iPad/iPhone,

3:Sync

You can also tick boxes to sync apps,
movies, TV shows and photos. Use the
Info tab to sync Contacts and even Safari
bookmarks. Click Apply to start syncing.
This will transfer content from your iTunes
Library onto your mobile device.
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MacApp [
Store

Browse thousands of Mac [ ‘Broaves

applications, all located in one Click here to browse
convenient App Store apps by categories.

These span from

: - Business to Weather,
Launched back in July 2008, Apple's original App Store taukilrzq ins Music as*: dr

was initially accessible via an app on the iPhone - and Photography along
subsequently the iPod touch and iPad — enabling users the way too

of those devices to peruse thousands of downloadable

apps designed for i05 devices. Apps span a wide range

of categories (from Photography to Education) and let

you extend your iPhone’s functionality in many exciting "
ways. The iPhone-centric App Store has proven incredibly

Featured Top Cha

The Unarchiver

successful, so there was little surprise when a macOS App i i el b
Store appeared early in 2011. On its first day, the new Mac @ Mabitify: Habet Tracker Weather Guru: Hourly
App Store sold a million apps. A Produc tivit Neaths
The Mac App Store enables you to find useful software v, ‘
for your iMac or MacBook in one convenient place, without { sl e
having to trawl the internet. To browse it, you'll need the ¥
Mac App Store app, which was available by default from OS ey o | star Chet: Cooking Ge
* Mavericks onwards (you can use yvour Apple>Software o M R
Update menu command to install the latest version of older @ e 5 RanNgs e e Rating
operating systems). Once you've updated macOS, the Mac 08T & [OFF &
App Store will appear in your Dock. Double-click on the i Select i e
app's icon to fire it up. ll Once you've selected
As there are thousands of Mac apps to explore, finding a category, a series of Aﬂf'"‘.’fu s [?T,a“ L P?_l?rfrmge
what you need can be daunting, so it's worth rummaging Lesrt; ﬁﬁﬁi’;ﬂﬁ? - |
through one of the 21 categories first. As with the i0S App takes your fancy, Ehck?g (E3899 - I
Store, these Mac app categories cover a wide range topics, go to the app's page for
including Games and Social Networking. Once you've found more information
a category that you're interested in, you can refine your Starman GoodTask 3
search by looking at the Top Paid or Top Free Apps to see g &\
what is popular. Alternatively, you can search the App Store OIS PE1088

with a relevant keyword. Once you've clicked on an app that
catches your eye, you can find out more about it by viewing
screenshots of its interface. More importantly, you can read
the reviews of people who've already downloaded the app

to see whether it's worth your time (and moneyl).
[ I:
| % §
S T

- Communication

The Mac is all about communication, whether
by email, text message or video. Apple Mail, the
email program that sits in the Dock of every
Mac, is a superb way to keep in touch with
friends, family and colleagues. It can handle
multiple email accounts and, thanks to the Mac’s

=
- Spotlight search engine, all its messages can be
__ﬂl"".
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searched in an instant. Want to add files or photos
to your email? Just drag them over your message
window or use Mail's photo browser to grab snaps
from your Photas collection. In Mail, email doesn't
need to be drab: you can style it using beautifully
designed templates.

Mail is clever too, analysing the contents of
incoming messages, not just to check whether
they contain spam - in which case they will be
neatly removed from view — but also to interpret
the contents. So if you get an email asking you to
meet someone tomorrow at one, you can click on
this invitation to add it to your calendar. And Mail
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Creativity

The Macg, at its heart, is a creative tocl. It seems to
have always been that way. The desktop publishing
industry began on the Mac back in the Eighties
and, 30 years later, today's web design industry still
favours the platform. How can that be? Perhaps the
Mac'’s ease of use has something to do with it, or
the fact that creative peripherals, such as drawing
tablets, are designed to work seamlessly on it.

It's as likely, though, that the quality of Apple's
hardware strikes a note with creatives. And that
applies from a practical, as much as an aesthetic,
point of view. Those Mac screens — particularly the
larger iMac displays — not only look great, but offer
great colour reproduction. And the Mac's built-in

& sHazam

Search

If you've heard about
a particular Mac app
and want 1o leam
more, type Its name
into this handy search
field to go to its page

HARITIEY

Fantasti@z) 2

Sea Al Quick Links i
siisatdut ColorSync technology ensures that what's great-
Tii "l 5ne-:tra Video & Audi PR looking on screen will look just as good (and colour-
) Busines l . S accurate) when it prints out.
e Above all, it's the software that appeals. A quick
Em JRpaT

scan of the Mac App Store will reveal dozens of
cool budget drawing and illustration tools — not

macDs High Swrra . - )
forgetting Pages’ superb layout tools — while the

Moon Invoice - Easy In A Writar Apps Made by Apple , : : :
Bissing 2 A Priductivi i 1o S M s ki industry-standard design applications all work well
e e e e i 4 e e e ok A 29 Ratings Great Free Apps & Games on the Mac, from QuarkXPress to Adobe's Creative
ibd £28.90 - Final Cut Pro X Dron-d Suite, which comprises popular applications such as
i Logic Pro X rng ERvRT1 InENIM image editor Photoshop, drawing tool lllustrator and
e ¥ ’ Apps for Developers ﬁirﬁ:: ir‘zg:m;“'r'i”ﬁmer‘” page layout application InDesign.
e i iy F h T""“ SR Apps for Designers uickly E'-.-]v-ith {:ﬁ?h I The web is the catalyst for much creative work
kA hRE 15 mating Notfication Center WIdgets | ik on the link at the top nowadays. For those who want to put a creative site
¢ IR B o T e together without having to get their hands dirty
Macs In Class : . .
R Ry with code, Pages, which comes as part of the iWork
ks ki " suite, is a great start. You can base your website on
Anamorphic Pro Stave’n'Tabs Log That & Top 10 | pre-built templates and customise it by dragging
Fernorat Bioiscts EurtSerdmlwn 'T FT 'th% other iLife components - video from iMovie, images
PEI008 v R PRI e from Photos or audio from iTunes - into it. Instead

works neatly with the Mac's own application for
storing contacts — Address Book — which syncs with
your iPhone or iPad via iCloud, so your contacts are
with you all the time, Searching through you emails
is easy, as you type, a section called Top Hits' will
appear. These are the most relevant emails to your
search term, All other emails that might relate are
displayed beneath,

While most people are happy using the Facebook
website, there are plenty of Mac applications that
integrate with it. Even Photos offers a way to upload
your images directly to your Facebook account -
and comments about the photo made by Facebook

ot v | @wark

Top 10 Paid Apps. Scroll
down to see a list of the
Top Free and the Top
Grossing Apps too

friends can be seen within Photos. You can also
use the web to keep up with your Twitter contacts
— although it's easier to use cne of the Mac's own
applications: the Twitter application itself is a free
download from the Mac App Store.

FaceTime is another cool feature that allows you
to have a video chat with other FaceTime users,
whether on the Mac, iPhone or iPad. If you prefer to
do your talking via text message, then Apple's own
Messages app is perfect.

But if you want to keep up with friends using
other text messaging services, look no further than
the excellent Adium (www.adium.im),

of having to hand-code functionality to add features
such as embedded YouTube videos, you can just
drag a widget to your page. Publishing to the web is
a single click away.

If Pages whets your appetite to get more serious
about web development, there are plenty of more
powerful tools available to help. Another Mac-only

tool, Coda (www.panic.com/coday, offers a single

window coding environment that's popular with
Mac web coders and developers.

“There are dozens
of cool budget

drawing and
illustration tools in

the Mac App Store”
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s macO5 updates go, High Sierra

isn't exactly earth-shattering —

but this is a good thing. We had
precious few gripes with how macQ5S
10.12 operated, so there seemed little
point in altering things unnecessarily
merely tor hollow crowd 'whoops.

So what High Sierra does is only focus

on areas where genuine improvements
could be made, such as how you can

tailor individual site settings in Safari,

P fore o ._- "|'_| i.-—I.:.
ﬂn‘Updatﬁ-s at JORtREInterface. You
should see the High Sierra U["djt‘z' at the top
of the screen. Click 'Update’

getting better responses from Siri and
making it easier to navigate your photo
library and apply more varied edits to
your images.

Of course, much of what the High
Sierra update offers is behind the scenes.
For example, in APFS macOS has a new
file system for the first time in about
three decades, a new video compression
technology for 4K (High Efficiency Video
Cading, or H.265 for short) and the arrival

02: Alternate method

You can alrr.r rhr’k on Thﬂ Apple menu and
C. On the System

1r'|’rnrrr1 ation screen, ur"njer 'Overview' will be

the ‘Software Update' button.

of Metal 2, the very latest version of
Apple's graphics APl - future-proofing
macOS for new tech such as virtual reality
and bringing macOS and iOS closer
together than ever before,

So while at face-value the marquee
features may seem in short supply, there
is plenty to digest in High Sierra and over
the coming pages we are going to drill
down to expose all of what is new and
help you become an instant expert.

ma:.ﬂs High. Ehrra 3

g Ml ﬂ'ﬂ-‘l

03: Go to ‘Featured’

If the High Sierra update isn't displayed in

Updates, click on ‘Featured’ and you should

see it flagged ot the top of the screen.
Click on it and then click ‘Download’
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macOS High Sierra

A’ more pers

al Safari

How to get the most out of High Sierra's improved Safari experience

Safari has probablybenefited the most

from the High Sierra update, certainly

In terms of prac

blaying videos and infernal pop-up v
High Sierra update now allows you to tailor each

Site you visit to be exactly how you w

Safari
notifications
The 'Notifications’
tab was previously
in Preferences
but is now in the
new ‘Websites'
section.

How to adjust the settings for a website

Although you can tailor the settings for websites that you visit regularly in the Safari preferences, you can also do so for new sites on the fly. So if you are visiting
a new site for the first time you can quickly tailor the settings to suit your needs,

Wy Vo e e s D b | P e Pt il Tawoc | -

e
|
|

Foria Wloborsport T revies: Sarmiung Gelaxy B winy
pharme of ehe year 58 Mablla

Choice Comeumer Smands

FHeh poser styla, firse pear

wubmlancs

Pl =

01: Right-click
While on the new web page, right-click on the
Search/URL bar and a floating menu of options

will appear that includes the Copy' and 'Paste and
Search’ options.

\

e
o ST | Tkt i i
R writing artlst maswe wses
b i B bt il s e
. oo LT - ]

04: Enable content blockers

If the ‘Enable content blockers' option isn't on by
default then it is a good idea to tick its box as soon
as possible — unless you like being bombarded by
pop-up windows, of course.
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02: Selecting settings

You will also see the 'Settings for this Website'
option, so select that and a new menu of options
will appear in which you can adjust options
individually per site,
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xel 2: pixel perfect? Read our hands-on review
nt rather than Pixel revolution

05: Page zooming

If you prefer the text size to be larger on some
websites or smaller on others, click on the ‘Page
Zoom' menu and select a new default size for
the page.
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03: Enabling Reader
If you prefer certain websites in Reader mode,
whereby the pages are de-cluttered and the text

made more legible then tick the ‘Use Reader when
available’ option.
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06: Disable auto-play

It's annoving when videos start playing on wepb
pages without your consent, Put a halt to this by
clicking on the ‘Auto-Play’ menu and selecting the
‘Never Auto-Play’ option.



Safari site options

How to access and tailor bespoke site settings

- @ Right-click bar
By right-clicking on Safari's

@ Reader mode —hi
By enabling the ‘Use Reader i

1g the ‘Use - T " dual URL/Search bar you will
when available’ option, the ; e\ | bring up a small menu. Here
current site will always load g you will see an option called :
in Reader mode, as evident \ “ervendile tears” 'Settings for this Website’ - -
by this Iﬂ%«aader icon. In Reader : selecting this will open up
mode sites are cleaner, much this menu of bespoke site
less cluttered and the text is options for you : 1
easier to read | . |

ol gl ] g

iCertain websites may present
“an extended range of bespoke
options. For example, if you

visit apple.com then you will
have additional settings relating
to Camera, Microphone and

v i

2

® Disabling aphy Location. In this instance you
o ise toolbar ¢ Auto-playing videos can be a _dru cl | r L r id I "F’lfr'i J r. th e_m enu
Remember that you can right-click on the real pain when surfing the web :r|e_~,,_1 to e :u._f: of f, on and chones
toolbar at the top of the Safari interface to but now, mercifully, we can between Ask, Deny or Allow.

turn them off on the sites we Make a point of accessing this
like by changing the Auto-Play |- S (s L0 a8 (=14

setting to ‘Never Auto-Play favourite websites to see what
I e O T options for personalising it

set it up however you want. For example,
dragging the ‘iCloud Tabs' icon to the

toolbar will provide quick and easy access
to sites open on your iOS devices

are available,

New-look
Extensions

. B= : = : The place to go to add

functionality to Safari

01: Preferences 02: Click on Websites 03: Adjusting

Safar Extermiom #

While in Safari, click on the "Safari’ Jump straight to the new "Websites' mU|tIP|E SEttanS

menu and choose 'Preferences. You section and You will see a menu of If you click on 'Autg-Pla}.r" you will see 0 B, e&. &
will bring up the main preferences categories on the left and a list of sites you've already configured at B+ 92 @
window that features a few Eha.‘"ll;]E'S CUTFE'HU}-’ Qpen websites in a window the bottom and other open sites not 1'_.:- :" o
since the High Sierra update. to the right. configured at the top. = 4= 8= b=

e 0NN o
""""""""" i5- S You can expand and tailor your
i | = =B Safari experience further with
= B =53 extensions. These provide extra
E ——— SR gl functionality to your Safar
oy SN —_ interface and now have their own

:.h;-“- i : - . : \
04: Change settings 05: Block-changes

iC App Store. To
255 them, while in Safari, click

on the ‘Safari’menu item and

06: Tailoring plug-ins

You can now configure other open There is another option within Another useful feature is the freedom choose ~atal Exter ISIONS. You will
sites from one window, as opposedto  each category that allows you to High Sierra gives you to turn individual then De directed to the Aj
individually within the Safari browser.  apply the same settings to all other plug-ins on or off easily. Scroll down >afari Extensions website wher
You can also click on configured sites  sites you visit. Click the 'When visiting ~ the left column to see the full list and e A5k ““l“ S r*" ;
and click 'Remove’ to delete them other websites' menu and adjust your  configure the ones you want. This is a ;‘Tt”'ﬂ” section within the App
should you need to. settings accordingly, very handy feature. el 5 2
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ImacOS High Sierra

Apple
has improved
the ‘People’
album with larger
image thumbnails
and more accurate
groupings.

= -

ot T .
L

..m. '_1'-"' r @ . T :_;-.-f - r Ltk 5 .... "E‘F‘“‘ ""j

albums in Photos

An even more accessible photo library and
even more features and effects

Click on ‘Media Types'in the
siclebar and then choose ‘Live
Phatos: Dauble-click on the Live
Photo you wish to edit and you

will see the various options at the

bottom of the screen.

v The Photos app is an area that has enjoyed greater array of editing tools and filters to make your photos
“ particular attention in the High Sierra update. An stand out. We will explare the numerous key changes here
ever-present sidebar makes it easier than ever in more detail and also highlight some of the lesser-known
to find images and an improved editing suite provides a changes to the Photos app.

02: Choose an effect

Click on the 'Live"menu and you

will be able to choose other

effects, such as 'Loop, Bounce' and

01: Select a section 02: Click on Curves 03: Drag to adjust Long Exposure! For the purposes

of creating a GIF, select the 'Loop’

Double-click on an image to open it, If you click on ‘Adjust’ you will see a You can make adjustments to the :
click on the ‘Edit’ option in the top- selection of categories in the right tonal range of your image - such as option.
right corner and then use the tabs column. New categories include lightening a dark scene or boosting

at the top of the interface to make ‘Curves’ and Selective Colour, the contrast - by clicking the diagonal
adjustments, add filters or crop. Click Curves, RGB line and dragging it.

03: Re-apply sound

Your Live Photo will now be

+ : e A b | R TR T ] i |

05: Selective Colour 06: Using filters

played repeatedly, but by default

04: Adjust separately

the sound will be cut. You can
You can also focus on Red, Green Another cool new addition is the Clicking on ‘Filters' lets you try out re-apply the sound by clicking on
and Blue separately by dragging the Selective Colour feature, which lets the new filter effects, which are he F’i e R ﬂ;ﬂ_‘ left |lTu
anchor points on the graph. The you accentuate certain colours within -~ now variations on three styles: Vivid, r-a ! ']‘J-r;r] - s 1 I'_ r l ” F };Fh il
image changes in real time as you your image, adjusting the Hue, Dramatic and B&W. You can also y p_ Al el A
make adjustments. Saturation and Lurninance. continue to edit with filters applied. be saved.
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. Browse how

HG fo ﬁnq ynur Way amund thE High \ you want
d Phﬂt@ [ﬁtEl’fﬂCE 1 You can view your photos
:__ i | : organised by when they were H s

taken by clicking on thetabs | ;
at the top of the interface :
which include 'Moments, -:H\ £
‘Collections’ and "Years' ~

o i B e WA Spnilm O

N\
- ®Drag to arrange
In the enhanced Photos

: interface you can re-arrange
1 the categories (Library,

N Devices, Albums, etcdin @ = T
the sidebar by clicking and o
holding and then dragging
them up or down, lacking

2 photos seiached il
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® Work with : g
multiple photos ® Using filters i

e o Bl

| Ehich o iy wi_f,lﬁj el b wi 3 \‘ - \ - ast then you can narrow down your i -

searches by using filters, Click on
with and then right-click on one of this menu and then choose from
them. You can now perform actions e —— categories such as Favorites, ‘Edited’
such as marking them as favourites o — and 'Videos'to find what you want
VT or rotating them Bl P ol T S Pl el Poclh Tesih il ik o 1 "~ quickly and easily

L = |r |-I II I-4 .| r: t. |.l |l .I. I. .s l|L | ]
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01: nght-cllck photo 02: Choose ‘Other’ 03: Open and edit

Right-click on an image in your photo library If the third-party app you wish to edit with isn't Clu:k Open and then ynu Wi II t_w: able to

(you can double-click on it to make it bigger displayed in the menu, choose the 'Other’ option = edits to vour oh

first if you wish) and then highlight the ‘Edit and then navigate to the app you wish to use in When you've finished, save the image aﬂd the

With' option from the menu. your Applications folder. changes will be reflected in Photos.
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A new split-screen interface in Mail

A cleaner interface for composing emails and enhanced search results

In macOS High Sierra, Apple has sprinkled  Well, the good news is that Mail also gets some Mac. Meanwhile, an enhanced interface provides a
W& 2 smattering of new features across the worthwhile additions as part of the update. With cleaner, more focused way to compose new emails,
e apps that we use most frequently — as we  more emphasis on space consumption, all of your They may seem like little changes, but they make
have already demonstrated with Safari and Photos. received emails will now take up less space on your Mail smoother and maore fluid to use.

Your Mail interface
Introducing the High Sierra Mall 4__3_“ ® Split-view

enhancement
Chels When using Mail in full-

screen mode a split-view
I mode will automatically

® Improved | -+ . EXTRA 20% OF e : : kick in when you choose to

search results 2o @ = . s e e 14 o i s compose a new email, only

8|
A new element called "Top Hits, s i b,ack AL i
which is powered by Spotlight send it, It's a cleaner interface |
provides a big boost to your Mail L. :ZETT::;Z:EMQ Ees
app's search capabilities. |t puts all s

of the emails most relevant to your | [l ===
search at the top of the results list o
based on the emails you've read, i

wha you reply to, your VIP contacts v
and more

® More space-conscious messages
As with other aspects of your Mac, High Sierra also
makes storage optimisations in Mail, with the messages
in your inbox using roughly 35 percent less space than
before, Every little helps, right?
. e ——————————

NG ENES Il Road-test the new split-view

Stween your inbox and the message that you

-----

--------

TR —

01: Enter full-screen mﬂde 02: Start composing 03: Send and cnntlnue

Ve

Click on the green ‘expand’icon in the top In full-screen mode, click on the ¢ OMPpose When you have finished compaosing y emall,
left corner. This makes Mail go full-screen. To con and your inbox will shift to the left and a click t'ﬂ send as usualand the app w '“ instantly
icel this, hover your mouse in the top-left composition window will take up the other half Snap out of sphit-view back to the expanded

f the screen and click the icon again. of the screen. usual interface.
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A supercharged Siri

Your personal assistant gets an intelligence hike in High Sierra

sounding voice, an expanded repertoire of answers for
a wider selection of questions and a new option to type
questions instead of asking them.

® Request genres

. Whereas previously you could ask
Siri to play something specific, like

a certain song or something by a
particular artist, you can now request
*something mellow’, for example, and
Siri will dig out semething interesting

Siri is another of the apps to have undergone
a few High Sierra enhancements. The most
notable of these include a more natural-

SuperstarDJ __

Want to listen to something differen
Let Siri guide your ears .

@ Subscribe

Unless you are asking

- for something specific
from your iTunes library
then you must be a
paid-up subscriber to
Apple Music in order to
get the best out of Siri
in this area as Siri will
source music from the
Radio section

i

W b m E e e wwsm mm

® Name that tune

§ Siri incorporates the power of the
Shazam service, so if you ask Siri to
‘ name a particular tune then it will
listen for a few seconds and then
tell you the name of the track and
| possibly the album it was on

. picked out for you then click on this
~ | staricon and select the ‘Play More

| Like This'option. This will ensure that W
your radio station is more tailored to T . -
your tastes ' s i — —

_—— — e

":r“i - — ‘ - | — Zi.
How to enable ‘Type to Siri’

Previously, one of the major stumbling blocks when it
came to Mac users not getting the most out of Siri was
probably having to audibly ask it questions. Thankfully,

Apple has now implemented a new option for the more
self-conscious among us to type questions rather than
speaking them.

02: Enable Type
to Siri’

Scroll down the left-hand column and
you will see a Siri section - click on this

and tick ‘Enable Type to Siri’

01: Open System
Preferences

Open Systern Preferences and click on
the Accessibility pane situated in the
same row of icons as the Siri pane,

03: Type your
questions

Click on the Siri menu bar item and it
says ‘Type to Sif’ = you can now use
your keyboard to type to Siri,

D bt e . .l *
5] Tl 1IN+ iaRIaR .'.'.;
- i

; :-..-".'.- K

menu bar (if you have this option
enabled). However, you can also
create a custom shortcut.

01 Open System
Preferences

Launch System Preferences and
then click on the Siri pane to
display all of the options relating
to Siri, such as the language,
voice style and more.

02 Shortcut menu

Click on the dropdown

menu next to the 'Keyboard
Shortcut’ option and you will

be able to choose an alternate
shortcut to launch Siri. Now click
on 'Customise’

-

T N e T TR T b i S T e o et
W mIER W e RN e s e

|ty b

— e

You will now be invited to type
in the new shortcut. You will be
alerted if the shortcut is used by
another command.
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ImacOS High Sierra

Everything else...

Get to know e s

® No App Store

iTunes 12.7 : 1 - | - If you click on the menu in the

_ ps : top-left corner of the iTunes 12.7
Discover what is new in the O " | L interface then you will notice that
iTLII"IE'S High SiEI'l'El update 1< : ; . '. ' the i05 App Store is no longer
g _ ; ' : included. It appears that all app
m— ™ o purchasing is now done exclusively
® Sidebar o=y ¥ on your i05 devices
The sidebar, which is viewable under &b 8 R e
the Library' tab, has a new entry -
Internet Radio. This allows you to
access your favourite iTunes radio
stations quickly and easily. Click and
hold on a category in the sidebar
and drag it up or down to reorder

@ Your profile

= ; = T ae A e B Select the For You'tab to create your
® Access Mini Player P i ' 8 own iTunes profile for connecting

If you hover your cursor over the playback display - = ol with friends and sharing new music.
window then a small icon will appear in the top-left - e You can choose to follow’ peaple
™ corner—click on this and you will immediately scale the exactly as you would in popular
iTunes window down 1o the less intrusive Mini Player social media services [

Collaborate iln iCloud Drive

S — . High Sierra adds a lot more versatility  on a file in your iCloud Drive folder
Ryan Butt to iCloud Drive, allowing you togrant  and then choose Share>Add People.
o= e other people access to your files so You will now be able to choose how

— you can ccllaborate, moving it closer  to send the invitation and choose
to the likes of Dropbox. Right-click the access privileges.

A T o
S P

i"e ¥ OO0 A
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The new file system

Introducing Apple’s new universal,
space-efficient file system
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Though you may not be aware.
of it, Macs have traditionally
utilised a file system known as
HFS+, but this has been changed
1o a much more universal system
in macQS High Sierra that works
across 105 too:

The new system, named Apple

File System (APFS) has already
been implemented on iOS with
the 103 update; it ensures that

all of your files take up less space

and has been optimised for
flash E‘Id«':'ﬂgﬂ.'-:

Rerapct

Y ;

L . Iy

The APFS systemn encrypts.
each file irudmdually for added
protection and records data
‘across multiple locations to
aid recovery in the event of a
system crash.

If you use the same flash
drives across multiple platforms
(such as Mac and Windows)
however, be aware that after
you have inserted a flash drive
into your Mac the APFS file
systern will be implemented
without prompting.

G EORICJl Shared iCloud storage

L I { B
[ e
g 2 rein
-] ‘u-l
o S ﬂEt-r-l
Brmye ey

8 L] serieem

o e

01: Manage Famlly

Hrondicier 1 VOu Rave ,-|[L-'-l.r" ot ur

M | |u.:'-"-.:'-rr':". es>iC|loud

» Mar aqe | amily
wofile DICTUre. INOW YOl

02 Apps and servlces

1Cloua Storage.

1 the left column, |_ ut Iu._| nowy, Click
% Services at the top and yo
including 'Purchase Sharing, Apple Music' and

Introducin
the Mac loc
screen

The new quick and easy
way to secure your Mac

Force Quit Finder  “COMYD

Sleer
Restart
| Shut Dowr...

| Lbck Screen

Log ou .. 0% |

- “ a

Our i05S devices have had lock screens
for ages so why not the Mac? If you
are stepping away from your Mac

and just want to protect whatis on it
without having to put it to sleep then
you can now click on the Apple menu

Spotlight has been given an
intelligence boost in macOS High
Sierra and now produces better
results than ever based on your
search criteria.

For example, you can now get
up-to-the-minute flight information

at the top of the screen and choose a
new option called 'Lock Screen: Once
you have selected this your Mac will
instantly switch to the standard lock
screen that requires a password to
get into.

A more
Eowe.rful
potlight

How to get flight
information from your
Mac's search engine

through Spotlight just by entering
your flight number into the Spotlight
search bar.

Within a second or two of entering
your flight number, Spotlight will
check back with gate numbers, flight
durations and more.

“You can now get up-to-the-minute flight info

through Spotlight just by entering your flight
number into the Spotlight search bar”

3y extra for additional space then
J6ud space to good use by sharing it with

O

O |.|_I —[_.[__

see the o pHon to otart
all of your connected family members wil
to share your iCloud storage plan. T

sharing files

03: Start sharing

s by clicking the + icon  click on the ‘i

Cloud S 12" option and you wil
__.H-_;l'if'!-:j_;'_ Click on

De able
his is handy for

on the go
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IGetting started

Gain control over your Mac computer
with all the essentials of this section

o)
N

32 Mac for Beginners

Connect to the internet
Get connected to Wi-Fi and browse the web

Add a new user account
Create multiple user accounts for the family

Where is everything kept on
your Mac?
Find out how files and folders are organised

Set up iCloud in macQOS

Learn to wirelessly sync your devices

Work with applications
Get acquainted with your Mac’s creative tools

Organise your apps with
Mission Control
Personalise with Mission Control in macOS

Organise Launchpad
Sort your apps into folders

Get started with Dashboard

Discover the useful world of widgets

Get to know Notification Centre
Get alerts and updates on your desktop

Add widgets to the
Notification Centre
Tailor your Notification Centre to suit you

Talk to Siri on your Mac
Get to know the new features

Use macOS5's manage
storage facility
Master the storage management tools

Take advantage of Spotlight

Learn about the latest search features

Inside System
Preferences: Personal
Tune your Mac's inner workings

Inside System
Preferences: Hardware
Get to grips with peripherals

a4

Organise
your apps

64 Inside System Preferences:
Internet & Wireless
Explore networking, syncing and
sharing options

Inside System Preferences:
System
Find out about more intricate system settings

68 Tweak your trackpad settings 80 Set up and explore iCloud Drive
Master multi-touch gestures Use the newest sharing feature in macOS

/0 Use Hot Comers In macJs 82 Get to grips with Family Sharing
Activate functions just by moving your cursor Share purchases with family members

/2 Set up and use Split View

Manage macOS's new split screen

“Your Mac
experience can
pe tailored to
your personal
preferences”

- 7

/4 Recover files with Time Machine
Restore lost files with this built-in backup app

/6 Check the health of your hard
drive and repair it
Discowver the Disk Utility function

Use AirDrop to share files
Learn how to transfer files fast

L]
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Use the Use Hot Sh_are via
Dashboard _ Corners AirDrop
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IGetting started

Connect to the Internet

Gain access to the world wide web by hooking up your Mac to Wi-Fi

s [P — T = .‘ @ * “ *
T RN ae T To get the most out of your new Wi On I
— SRt =S >< Mac or MacBook, you will want to hilpdcdigich i
Tia_8=2 ~\ connectit to the Internet. Luckily, i .
20 4@ 0™ this is a simple process regardless of whether : i =
- = you choose to use either a wired or wireless 1 Oceans 80 Esst %
2 6 6 4500 : SKYDOBIC i w
S aTasTEEESEE  connection to your router. Location: Automatie B | i o 2 %
e If you wish to connect your Mac to the = TALKTALE- RSO, 1
4 - . — B TALKTALK -
Internet with a wired connection, all you need o ; M. P u__:“ TALKTALK-BO10AA aw
to do is plug one end of an Ethernet cable ikl O LIS T i P4
into your Mac, and the other into your router. o SlsiotnPAN (@) e g vicky L
' a ol Connerhed - Join Other N |
If you plan to go wireless, then you don't need o Thind. 1 Bidon ¢, R sy
any more equipment than your Mac and a I S Knowe neworks i oa Open Network Preferances. .

15 mafaly SR @l

wireless-enabled router,

Follow the four simple steps outlined below
and you'll scon be able to access a whole
host of content: you'll be able to browse the
web with Safari, stay in touch with friends and
farmily on Facebook, send emails in the Mail
app, download tons of great new apps from
the Mac App Store, share videos in iMovie, and
much more. & whole world of entertainment
awaits you!

[ Show Wi-Fi status in menu bar

Asslst ma...

maCOS Turn Wi-Fi on and start surfing

ol 47% @) Sun13:32 Q =
Wi-Fi: Off

01: Turn it on 02: Look for networks

Although it should be on by default, your Mac’s Wi-Fi may be turned off. If it's Once you've turned Wi-Fi on, the icon should turn into a greyed-out series of
off, click on the icon to the left of the time and date in the top bar, then dick curved lines. Click on it, wait a couple of a seconds for a list of available networks
turn Wi-Fi on. to show, then click on your home network.
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Network Preferences

How to control your Wi-Fi connection

List of connections

Here are the various connection options
that your Mac offers, You're unlikely to have
a green light next to more than one at this

S : . : [ N 4
point in time. If you're connected via a wired
connection, ‘Ethernet’ should be connected

Wi-Fi

Connecised

® E?_El” n WLAN {}

MNOT L-ONNeCTod

Thund...lt Bridge »
- Mot C dﬂ """:-.l'";

LionnsCimg

Advanced

If you regularly connect to more than one
network, you can organise the preference
of these networks — among many other
things - in the Advanced section of the
Network Preferences menu

netwark “SKYDOB1C" requires a WPA2

|

Show password
Remember this network

03: Connect to your network

For the first time you connect, you'll have to enter your network’s passcode,
which may be written an the back of your router. Once you've entered it, click
Join' to connect to the Internet.

Metwork Q Saar

Location: | Automatic

Status: Connected Turn WJ-Fi O

@ Bluetoath PAN g Network Name: Balkin 8108 ¥

Status

When you're successfully on a
Wi-Fi network, this will always say
‘Connected’. Click the Turn Wi-Fi
Off button to do just that. You will
need to re-activate it if you want
1o get back online; however, you
might not need to enter your

| network’s password again

Wi-Fi iz connectad to Balkin.8108 and has
the P address 152 168,214,

| Ask to join new networks
Hnown nebeorks will ﬂi]nil'!lﬂ automatically. |
e Network name
This box displays the name of the network you
are connected to. Click this drop-down box to
see 3 list of other networks that you're able o
connect ta. However, you will need a network’s
password before joining it

B a0 4+ 2 % B xE) Sun133

Wi-Fi: On
Turn Wi-Fi Off

 Belkin.8108
Berkeley
BTHub4-ZKWS 2.4GHZ
BTWIFi-with-FON
CHIARI
QUEST STAFF
SKYDOB1C
TALKTALK-0242D0

DDDDDDEDDDEDE DDk

._ : '. =

Open Network Preferences... [

04: Edit preferences

Now you're connected, the greyed-out curved lines should be black. To edit
your connection preferences, click on the icon, then click on ‘Open Network
Preferences’ You will then be taken to the System Preferences app.
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Getting started

Add a new user account

Share your Mac with the family by creating multiple user accounts

"P e -' e \/ Your brand new Mac is packe:d u.vith
L = = e /\ s0 many great features, bn:-th_ln its
software and hardware, that it begs
to be used by the whole family. However,
) you may not want each member changing the
* = == computer’s settings or having access to your
personal files every time they wish to use it.
This is where multiple accounts come in.
Not only does having multiple accounts
enable you to protect your private data, it
also lets you protect children. It's simple to
set up an account with Parental Controls,
which enable you to limit access to apps and
websites, as well as set usage time limits.
There’s also a degree of customisation
available. Not only can you set your own
picture using the iSight camera (so you don't
need to settle for stock imagery), you can also
set which apps you would like to load as soon
as you log in. Multiple user accounts are a
great way to keep the whole family safe while
still enabling them to enjoy your Mac.

(|
i

N B
W flk jim
-

e s
i @ (@ i
e i
® I
£ L |
i{l
I®
1 -

maCOS Create and add a new user

L=

= g 6 @ i°
P g 9

Geanaral Deskiop & Dock b izaion Language Security Spotlight MNotificalions

Sorean Saver Controd & Reglon & Privacy

Disptays Enengy Kayhoand IS Trackpmd Printars & Sound
Saver Scanners
» @ v @ 0 W
iChoud Internet Extensions Metwork Biuatooth Eharing
Accounts

A ® @ ¢ & & @ @

Lisars & Parental ApD Ston Dictation  Date & Tima Startup Accassiility
Groups & Corntrois & Spoech Diisk Manmrm

01: System Preferences

Click on the System Preferences app (three grey cogs) in the Dock to open it up,
and another menu will appear. From this menu, click ‘Users & Groups, which is in
the fourth category down, "System’.
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Usars & Groups

' Jonathan Gordon

Audheiin Rezat Password...

pen Parental Controls.
Edlit Cancel Darvs

| i Uikaes & Giouns

Administrator
— New Account v Standard |
i Managed with Parental Controls
the : ;.
Full Nama Sharing Only h m—

hra Group
lest L Account Name: 7

phled, This will be used as the name for your home folder.

Password: () Use iCloud password
Use separate password

An Internet connection will be required when
this user logs into the system for the first time.

3 4 Cancel
{: ﬂ.' ) i 'Is.d_
02: Add new user

Click the padlock icon to enable changes, and click the + button to add a new
user, If setting an account for a child, click the New Account’ drop-down box
and select 'Managed With Parental Controls’.



Parental Controls Time Limits tab Simple Finder

This handy tab lets you limit time spent on the Mac. The Simiple Finder is a stripped-down
Keep a child safe when they're using your Mac You can set Weekaay time limits, Weekend time version of Apple’s desktop environment
limits and prevent access to the computer between There are only three folders on the

certain hours on school nights and weekends dock (one for applications, another for

documents, and one for sharing), and
opening iterns only takes one click

Webtab

[he options under this tab enable you
to restrict access to certain websites,

Apple provides a list of websites that it
deermns safe, but you are free to create
your own custom list of websites | Guest User

p— Use Simple Finder
‘.‘ ‘; Providas a simplifised view of the computer dasktop for young
or inexperienced usars.
M" @ Limit Applications

1 | .

. N £ 3 Parental Controls Q,

Bl Web People Time Limits  Other

o Allows the user to opeén cnlly the specified applications. An
adminlstrator password is reguired to open other applications.

7’

-

g Allow App Store Apps: Al id
Allowed Apps:

Limit apps

Check this box to limit access
to certain apps on your Mac.
Tap the armow next to 'Other
Apps' to show a list of all the
applications installed on your
Mac. Tick the boxes next to
the apps that you are happy
for your children to use

LOGIN OPTIONS / » @ App Store

In the main User & Groups » B Other Apps
menu, you can change L ] > © Widgets
which apps or services ot b 1 Utilities
open as s0on as you log '

in. To access these options,

click the ‘Login Items’

tab (next to 'Password’).

Here, you can click the +

symbol to add more apps

and services, and untick or + [ —[#¥]
tick their checkbox to add -

them to your login process. [l Click the lock to prevent further changes.

Prevent the Dock from being modified

[ [ pon =
2 e L4 Bl Parental Controls Q

|
an Gordon =
i Mo Web P le  Time Limit Other
_ Change Passwor Suest Use i R
a Tim ! . : Frosdoes & sempdihed view of the compuler deskiop 1of young
a- of InBNpErisnCed USars

i Allows the wser fo open only the specified applcatons, An
w AOMIALEIMAENGT DAEEWONAT IR rdgulmd 1H Ghén o BiECalansE

Allow App Store Apps: | up to 4+ H
Allowed Apps:

i:-an Parental Enntmls...:

Cancel Done Prevent the Dock from being modified

— |5

E Click the lock to make changes. Logs... ?

& lock to orevent further chanaes

03: Set the picture 04: Parental Controls

After entering a password and clicking ‘Create User’ you will have a new account After you've set your picture, click 'Open Parental Controls. .. to access the
on your Mac. To change the account’s default picture, click the irmage next to parental controls. The tabs across the top grant access to several different ways
‘Reset Password. . .. To take a picture click the Camera tab, then the camera icon. to limit access to your Mac, including the ability to set time limits on usage.
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Getting started

your files and folders

It happens to even the most experienced

of us - you absent-mindedly put

something somewhere and the next
thing you know you're searching around
wondering where you had it last. It happens to
your car keys and it happens to the files and folders
on your Mac. Luckily, your Mac makes it easy to

maCOS Tweak your Mac to get around quicker

& B "L File Edit View Go Windo

01: A home in every window

To automatically show your Home folder when you
open a new Finder window, choose Preferences
from the Finder menu.

04: Getting ticked off

Just click the checkboxes next to the cptions to
remove them from every sidebar. You can always
change your mind later if you wish.
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Whereis eve
kept on your Mac?

Put an end to the common problem of keeping track of

hing

save your stuff in the right place, quickly and often
without having to think about it. The key to this is
how your Mac handles Home folders, which are a
special set of folders that are automatically created
for each person that has a user account on your
Mac. Know your way around here and you may
never get lost on your Mac again.

Firdlis Prafarencis

=

Show thess fems on the deskbop:
El Hard disks
E Extarnal disks
B cDe. DVDs, and iPods
L R ]

B Siephen's M:

E I Documents
_ iCloud Drive

B A b Files

Prage. the space bar bo cpan immediasaly.

02: Home sweet home

While in the General tab, choose your personal
Home from the 'New Finder windows open’ menu
to set your preference.

05: Set your own shortcuts

To get your own folder to appear in every Finder
sidebar so you can get to it quickly, start by finding
the folder on your Mac,

Find the right folder

Finder sidebar

Every Finder window has
shortcuts to the common
folders in your Home folder.
Click on one to head there.

A s @ |
|*~.’luI i

[ i"® [P K

TR Head Home

—  Set new Finder windows to
. open your Home folder (see
steps below) and you'll have
common folders to hand.

T
T8l B

" _ " Keyboard shortcuts
— - In the Go menu, there are a

= = . host of helpful keyboard and
w = menushortcuts to get you to
I your favourite folders.

03: Trim Finder sidebars

Click the Sidebar tab and you can choose to turn off
any Finder window sidebar shortcuts that you don't
think you'll need.

06: Drag it on, drag it off
Click on the folder and drag it into the sidebar and

your Mac will pop in a shortcut. To get rid of it, just
click on it and drag it back out again,



What's where on your Mac...

Take a moment to snoop around your system and you may quickly become overwhelmed at the array
of folders hidden away. Luckily, you only really need to know about just a few of the important ones

" Macintosh HD

Applications
Here's where you'll find all of the
software that came with your Mac.

The Llhrary ancl System folders

With the innards that make your Mac tick
exposed inside the Library and System folders,
it's best to steer clear of these twol

Utilities
This is where you'll find the programs
you'll need for making tweaks.

1 This s the first folder that contains everything else. It represents the
physical storage device inside your Mac, called the Hard Drive,

Users

This folder contains the Home folders for
every person that shares your Mac. This helps
to give everyone the ability to have their own
settings, music, bookmarks, photos, emails
and documents. It doesn't have to all be
separate though, and there's a shared folder
in here too.

Shared

Other people’s Home folders

Even if it's your Mac, you won't be able to see
what's inside the Home folders of the other users.

Any files stored in here will be accessible to all the
users of the Mac — great for sharing documents.

Desktop Documents Downloads Library
Anything you dump on This is your general When you download The Mac’s Library is
your desktop is really storage area for all your a file from the Internet used to save your
kept here inside everyday, miscellaneous and you haven't preferences, settings
this folder. files and folders. changed the default and fonts — helping you
Used by: You, when Used by: Most folder, it'll be saved to to personalise your Mac.
you want to put a file applications that don't this folder. Used by: Most
somewhere quickly. use ancther folder. Used by: Safari. applications.
. | ~ Navigate th —
gate the
folders in your
Home folder

‘safe place’ on your Mac - it's
where you'll save your files,
folders, photos, movies,
music and more. Learn your

This is the default folder
for your pictures, so it
is used by iPhoto for its
library, Photo Booth also

iTunes will create a

folder in here for its

library, adding any
tracks you rip as well

as media you buy from uses it. way around it and you'llgoa  better job, you'll probably
the store, Used by: iPhoto and long way toward mastering never use them.
Used by: iTunes. Photo Booth. macOS and your Mac Used by: Hardly anyone.

These last two folders are
the only ones that other
users can look inside, As
the Shared folder does a

Your Home folder

This is where you'll find everything
that makes your Mac yours - your
files, folders, photos, settings and
even your desktop. Luckily, it is easy
to find, and so this is the starting
point for finding or saving your
documents. Learn the shortcuts
(Cmd+5hift+H) to get here fast.

Movies

This is where iMovie will
save projects, and so it'’s
where other iLife apps
will look for your videos
if you want to add them
to other projects.

Used by: The iLife apps.

Sites

If you're up for some
tricky setting up, you
can publish a website
from your Mac, Most
people won't though.

Used by: Fewer people
than the Public folder!
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IGetting started

Set up iCloud in macOS

Access your contacts, photos and documents everywhere

‘ When you hear people talking about the

(1 & cloud, what they mean is using the web to
e — provide various services for computers and
T e internet-connected devices, wherever you may be.
e iCloud is Apple’s online hub for all its devices. Some
I -, companies provide general services that anyone can use,

but iCloud has been optimised for Apple devices. It is
primarily a syncing service, but it also provides an online
storage facility for all of your files, apps and music,

The greatest benefit of using iCloud is that it enables
email, contacts, calendar appointments, reminders,
photos, notes and more to be synced across all your
devices, and made available to you no matter where you
are or which device you're currently using. You can create
a document on your Mac and access it via an iPad, or add LOcHBOND”  SFCCOSSRY -
a contact on your iPhone and find it instantly appearing
an your Mac,

iCloud is very easy to set up, even if you are new to the
service, It's one of the first things you will see when you
boot up a new Mac or if you log in to a Mac with a new
user account. You can even use your iCloud storage like
an online folder. Once set up, you can simply drag and
drop any file you want into your iCloud Drive on the Mac
to upload it, so you can access it anywhere, With High
Sierra, you can create and share links 1o files in your Drive
for others to view and edit.

iCloud provides 5GB of free online storage and this is

rnore than sufficient for most. Extra space is available for ”Once youfve US@d |C|0Ud Wl-

purchase, which is great if you take hundreds of photos

or want to store lots of files or music. You can buy 50GB, maCOS; y[:)u may \fery C[ U |Ck y

200GB or even ZTB of space. You can now share this

=

stoage space with family members if you have Family WON d er h OW BKO L] eVer | |"'1.jec
Sharing enabled. Once you've used iCloud with macOs, . I
you'll wonder how you ever lived without it. wW |J[ h O Ut |T

iClOUd Get started with iCloud

Crestn an Apple 1D Beag Aol 3 B

L L T | _n |

Bedurly Qutaiiong + Chooes o question
Whal wes [he ness of your bewi ried a8 5 lssnage?
Whal wes Ha nermo of yoer Frel pai?
‘Wb e the Bl dish you lesmed D coosc
Aharl wes the Bl e pou e N T cioema’?
Ahern did vou go e tral brre you bew or sn spanae
#hal in T remae of pour famonls slerentary o prirery schoo ey

e al iE T BTCeEE Wae! T A, phaibhes, creviects, calsewinin, sl
il 2N pias ik, RECTEICES

‘ e

B b T L A 1O

Choowr & quesiicn.. E_

Frruad Lipgates. B Speg mub un 40 rne adi® AL nasay,
St el e mn Dhes Dl
i T e el & pETvheR

01:Sign in 02: Free email accounts 03: Call for security

You can open System Preferences and choose the After entering your birthday, you must add your name As part of the sign up process for iCloud, you will be
iCloud section to log in. f you already have an Apple and email address. Even if you already have an email asked to create three security questions. Make these
ID, use it here, or click to create a new account. account, it's useful to get a free @icloud.com address. memaorable, as they're needed to reset your password.

40 Mac for Beginners



Get connected to iCloud

Keep everything in sync with your Mac

Enable iCloud Drive

Check this box at the top of the

list to activate iCloud Drive, This

is like an online folder — drag

and drop files into it to access

thermn on any device e ¢

i Photos Optors
l.- Mail

Aiden Dalby
‘ Contacis

Account Dalads

Set Up Family

el L

g B ] A
e ﬁ—h"i 2
s P T T, T G

Manage Family

If several people in vour family use iTunes

accounts, you can link them all by clicking
this button. This way, you can monitor and
manage what your kids are buying

Lied i Foi jors Ooosrards el OElE

B Loy i ahm

e - -
B il o e P e e e e

iCloud

BT
a8 =

s Pirgc iy i

Fir by Wb om0 e By ke e s e -
FHEHE TR A B 1

e

iCloud

It couldn't be simpler and the final step is just to tick
the iCloud features on for your apps and enable Find
My Mac, then macOS will do the rest in seconds.

04: Set up

Manage your account

This button opens a window that shows
which apps are using iCloud and the
amount of space they are hogging. Click
this if you are running short on storage

i il
AR o A et

. Ergeg Likrwry
™ LTy Dericree il

5 Fan imm
E
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Lol T SR o
FaanTier D Dl a8 wes
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05: Manage storage

Mrmhn..llr
———

By Ve v - e e w S
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Lo rimesarraiaes Foiam pome mms s eFe aen i e e b
o EE we T TR oR E AT T EEE

L rem P e e ——a e e e

Space evaders

Keep an eye on this bar at
the bottom of the window:. It
gives you an overall view of
the amount of storage space
you're currently using — you
get 5GB for free

E

CLOUD SPOTTING

Look for the doud icon in
applications; it indicates that
some feature or function
uses iCloud. For example, if
you start TextEdit, you'll see
options to create documents
on the Mac or in iCloud.
Safari has a cloud button
too, as do many other apps.

Tumais  Omyrmand

06: Update your account

Click System Preferences in the Apple menu and hit the
iCloud icon. Click Manage in the bottom right and you
can see what accesses iCloud and the space it uses.

Click Account Details to browse your details. You can
change your name and photo, or add a credit card for
iTunes, iCloud and other purchases too.
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IGetting started

. The Application menu
Or WI Clicking an application's narme in the menu bar gives you a
few options for how you see {or don't see) it. ..

P ® Hide The application's still running, but it will be hidden
from view. Click its Dock icon to bring it back
a I Icat Io n S Hide others Want to focus on just one app! This option
clears your screen of all other software

Show All Erings back all the applications you've hidden
Quit Closes down the application you're working in, giving

Without applications your Mac would just be a you the option to save any unsaved work
beautiful table decoration. Time to fire up some
iIncredible creative tools...

It's easy to think of your Mac as a wonderfully creative toolbox, packed to

the brim with inspirational tools to finely hone your projects. Those tools

are the software saved on your hard drive, the applications. Software, for the
most part, is kept in the Applications folder - a shared folder that any user of the Mac
can see and open applications from. The beauty of masOS is that each user's version
of an application can behave differently and use different files, the same way that each
user can have an individual iTunes library. Of course, before you start learning how to
use specific applications, it's worth taking a moment to look at how you open, close and
switch between them, which is just what we're going to do here.

Five ways you can
start an application

You need to open an app before you can start playing with it

iITursss File Edit

Song WView Conirols Account Window Help

Liprary For You

Listen now o

01: Launch it from the Dock | Start your 3
Apple places the most used icons in the Dock, The red button

where they require a single click to launch. You The great thing about Apple is that there's
can add your favourite programs by dragging the a wonderful consistency to the products.
app’s icon down among the others. Once you get used to thie way something

works you know it's going to work the same
way for everything... except on the very rare

. I - accasions it doesn't. For most apps, clicking
02' In thE Appl Ications fOIder the red button just closes that window,
If there's an app you want to launch that's notin leaving the application running — go on, try
the |]|:|ka click Iﬂlpphcaﬂﬁﬂﬁ in a Finder window it in iTunes. Now try the same lh-lr'llf;[ in iPhoto

and the app automatically quits when the
window shuts. Now there is a rhyme and
reason for this, and it has to do with how
the application works with Windows, but for

sidebar, and scroll through the software list until
- - you find it, then double-click its icon.

» ; . . most people it's just plain confusing!
» B @ ¢ (03:Double-clickafile
¥ Pt = LERE RS LEEY 2] HE .
L _— “ Your Mac is smart enough to launch the right A
. ok !-1 ' application when you double-click a file that
belongs to it. This is often the quickest method if
| - B you're working on a specific project.

hinded By Your Gr
F!' E =5 X 3 £ LS

N | Mies You (Teat

v " 04: Launch it using Spotlight

e '! Click on the magnifying glass in the top-right
= ; corner of the screen, then start typing the name of
e —— the app you want to launch. When it appears, and

== = it's highlighted, just hit Return.

05: Plug something in

= inhﬁ There are some applications that are smart

enough to launch automatically when you need
them — iPhoto can launch when you plug in a
- = digital camera, for instance,

EED WP NETeIRE. S

ki i il
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04: Click the

red button

Some apps, like App Store, quit
when you close the window by
clicking the Red button.

Five waysyoucan [== 1 0zLeamthe

e ¢ Shortcut

close an application |== ' coauderpesnecndie

and Q together to gracefully exit

e | the software.

11 03: Click the
| Dock icon

| | Click the Dock icon, keep the

o mouse button held down, and a
"B B menu containing Quit appears.

Finished playing? Close it down...

a BB, L

== @ 01: Application
e g IENU

=  Click on the application's name
in the menu bar and choose
Quit from the options.

05: Application
switcher

Press Cmd+Tab, release Tab, then
press it repeatedly to get the
app’s icon. Then press Q.

Lo Tue ZBNov 1823 O

rowse  Radio [ L Application windows
You can have more than one application open at once
and most applications can have more than one window

2 ;
not carefull Luckily you can hide windows, minimise

thern down to the Dock (click the amber window
widget) or use advanced features like Spaces or Exposé
1o manage your windows

he A-List:
Hip-Hop

Apple Music.
onth free trial.

IPhone X

Say hello to the future.

h Music

All Genres -

MUSIC QUICK LINKS

i an app doesn't respond lor a whille, salact its
namee and click Force Ouwil

iMunes
LEET

g s

LEET 17

Migraton Assistan
Photos

Safari

Finder

oW &

. | Krow Yoiui (fest. B £

Silence (feat. Khalid) VL £ Opoe T Sncow Dy DRRsng

1 Earce Quit
D CCPRTE E - CHTIaR - FSCa R Q

Applications that just won't quit

Sometimes applications run into trouble, and when that
happens they'll often just show you a spinning rainbow
cursor and refuse 1o quit. Should that happen to you, just
press Cmd+Al+HEsc to bring up the Force Quit window.
Click the name of the problem application and then click
the Force Quit button to shut it down
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IGetting started

Find your way around
Mission Control

Delve into the desktop management system that
recently got a big update

E Back when OS X El Capitan was released,  fairly subtle but useful tweaks, such as placing your

Apple consciously placed more app windows together more relatively and giving
emphasis on performance over obvious you the opportunity to arrange them all within a
updates. So while revamps to features are not single layer.
wholesale, this general streamlining does apply to When El Capitan was released, Mission Control
aspects like app workflow, received some fancy features such as Split View,
Mission Control remains central to the way plus the ability to create new spaces by dragging
you use your Mac, by providing rapid access to your apps upwards. These all helped to maximise
organising apps across a selection of spaces’ or the usability experience. Read on for our guide to
desktops. The latest iteration of the program makes the best bits of the Mission Control feature, LOCBOIRT | erC o008 - .

Inside Mission Control e~ o

Navigate the core interface elements required Spaces previews help you identify where your

for organ IS I:ﬂg YOUr spaces apps are. Rollover and click the icons to exit full
screen or Split View, or use the "' icons to delete

and release apps into your current space

The spaces bar

This bar shows tab labels and
thurnbnails of all the spaces you
have created, along with apps in full
screen or Split View. You can reorder
these by dragging them and
navigate between them by dlicking

Open app windows
Mission Control spreads open
apps into a layer, positioned
relatively to the ariginal locations.
These can then be dragged into
the bar and the desired space

ASSIGNING APPS TO
CERTAIN SPACES

When launching apps from

the Dock, you can assign them
specifically to an available space.
Click and held the app icon, choose

lllll

Create new spaces

The Add button (+) in the Spaces bar
creates a new vacant deskiop space,
up to a maximurn of 16, Alternatively,
drag your open app up here to drop
it into its own new space

Options and one of the four
choices. All Desktops opens the
app in every space; This Desktop
uses the current space; Desktop
on Display picks a display; while
None opens the app in whichever
is being used at the time.
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Mission Control oo vour app workiiow

L0 2 0

= e = —
L2

« Cardhop ¥

01: Ready for launch 02: Mission control 03: Give apps spaces

Enter Mission Control by either using the third from Open apps are then arranged, with a minimised bar Drag an open app up onto the Spaces bar. This
left Dock icon, Mission Control key (F3), the Ctrl+up across the top to show available ‘spaces, including creates a dedicated, full-screen app space for the
shartcut, or swipe up with three or four fingers. macO5s Dashboard if chosen in Preferences. first app that you can drag a subsequent app into,
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04: Split View spaces 05: New desktop spaces 06: Navigating spaces

Drag a second app into a full-screen space to make A desktop space can accept multiple apps . Create Maowve between spaces by clicking thumbnails. The
it Split View. You can't add any more but you may these via the Add (+) button on the Spaces bar or Spaces bar places a blue highlight around your
exit Split View by clicking the Minimise icon. by dragging apps onto the desktop thumbnail. current space for keeping track of screen flow.
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07: Mission Control Preferences  08: Setting your shortcuts 09: Differentiating desktops
Visit Mission Control in Systemn Preferences. Toggle Mission Control uses shortcuts and gestures by If vou assign System Preferences to all desktops via
here to arrange spaces, how they behave, app default. You can reassign or add more with the various  the Dock icon, you can change wallpaper within
groups, display and how to show Dashboard. drop-down menus. each 1o make each one more cbviously unique.,
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Organise Launchpad

Make Launchpad work for you with folders and Home screens

Launchpad is another great feature,
‘ introduced by Mac OS X Lion, mirroring
the functionality of Springboard on i0S.
Springboard is the app launcher that you'll find on
your iPhone or iPad, which allows you to arrange
icons for each of your apps across many Home
screens and, if desired, nested into folders.

Every app you install appears automatically on
your Home screen, and the same applies for apps
installed on your Mac, with each finding its way
onto your Launchpad. However, unlike the iPhone,

Organise your apps

Control Launchpad to keep things
in their rightful place

Gestures

Swipe with two fingers to slide
between pages of apps, hold down
Opt/Alt to automatically enter the
organisation mode (where the apps
quiver and allow you to move them
around). Do a four-finger reverse
pinch to exit Launchpad quickly, or
tap Escape on your keyboard

REMOVING NON-APP
STORE APPS

One of the limitations of Launchpad
is its reluctance to let you remove
apps that didn'’t originate in the
Mac App Store. Unless you're brand
new to the Mac platform, it's very
likely that you've got a reasonable
collection of apps that didn't come
from here, but when you enter
quiver mode, these apps don't have
a remaove option, so how do you
get rid of them? There are a couple
of solutions: the easiest is to simply
drag all your undesired apps into
one folder and hide it on a screen
all of its own at the end of the
screens. The second is to install the
preferences pane found at http:/
chaosspace.de/launchpad-control,
This lets you untick apps you don't
want to appear, removing the link
from Launchpad, but not the app
from your computer.
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the Mac App Store isn't the only means of getting
apps onto your Mac, so how do you add, remove
and control these non-App Store apps?

We've collected together a series of hints and
tips to help you get the most out of Launchpad,
including taking contral of those apps you don't
want to appear. We'll also show you how to spice
up its appearance with custom icons, crganise your
apps and navigate around Launchpad quickly. Read
on to find out how to tame your macOS Launchpad
into submission.

Hide apps
Hide unwanted apps by installing the
free System Preferences add-on, which

is available from chaosspace.de/
launchpad-control

Folders

Arrange your apps into folders by clicking

and dragging one app onto ancther. This will

create a folder that is automatically named for
you. Rename the folder by clicking on its title

and typing over the highlighted text

Pages

Each dot represents a different page of
apps inside Launchpad. You can navigate
between pages by swiping with two
fingers, or quickly jump to a page by
clicking on the relevant dot to save time




Lal.lnChpad Make Launchpad your own

01: Create folders

Drag one app icon onto another. As you release your mouse, the two apps will
form a folder, which will be named automatically for you.
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03:Livenitup

Use Emaoji icons in your folder names by cpening a new TextEdit document,
choosing Edit>Emojis & Symboels, and copying then pasting to the Launchpad.
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05: Set up a shortcut key

Choose System Preferences>Keyboard, and add a shortcut key into the
Keyboard Shortcuts tab.

06: Delete apps

To remove apps from your Launchpag, click and hold on an app icon until all
the icons quiver. Once they're shaking, click on the "X’ next to an app.

02: Move your apps

You can easily re-order your apps within your Launchpad simply by clicking and
holding on an app icon and then dragging it into position.

rhancenara

";Ei Launchpad-Control

Launchpad-
\ Control

04: Hide unwanted apps

Hide unwanted apps by installing the System Preferences add-on, which is
available from
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Get started with Dashboard

Learn everything you need to know about how Dashboard can make your life easier

The Dashboard has been present hundreds more that you can easily install for free You can change your widget settings by clicking
in macOs for several years now, but from Apple's website. the 1" that appears whenever you hover over them,
recently it has seen a lot of changes. At The Dashboard has recently changed from a pr ; ;
its most basic, the Dashboard is a place in which screen that overlays your desktop (so that you can At |t5 ) OSt baSIC, thf:‘
vou can put widgets — which are small, always-on see parts of it underneath, but never use it) ta a fully * :
apps that can only be used when in the Dashboard.  separate section to the left of the main Desktop Dagh bOa rd S d p |61CE?
macO5 has always included some useful widgets screen. Click on the Dashboard icon in the Dock or iﬂ Wh |Ch };OU can
that you can use straight out of the box, but use the keyboard shortcut brings it up, and allowing i =
independent developers have spent haurs creating  you to play with widgets to your heart's content. pUJ[ Wldg@tB

Discover Dashboard Find out what each standard widget is for

World Clock Safari Webclip Weather Calendar Translator Stickies

Displaying the time from You can add a snapshot This weather widget The calendar widget The translator If you're always forgetting
anywhere in the world, of your favourite blog will tell you what it's like features three colurnns widget lets you things, use Stickies to
adding a few of these or video by opening anywhere in the world, If - today’s date, a month chioose from a wide keep notes, Fonts and
lets you keep track of as the page in the Safari you click it once, you can view, and a column that range of languages, celours are changeable,
many time zones as you browser and choosing get a weekly forecast of displays your Calendar translating text making sure your notes
want 1o 'Open' in Dashboard yaur choice events for today quickly and easily will stand out

Tile Game

A simple game
widget, the Tile
Game is just the
tip of the iceberg
when it comes

o widget-based
BT ——— games. Check out
HEAVENLY == the Apple website
to find more

Unit Converter

Whatever you need
to convert, the Unit
Converter widget
will do it for youin a
pinch. Weight, time,
pressure and energy
are just a few of the
many options for
this powerful and
useful widget

Ski Report
Address Book If you're off on
This widget holiday to the
allows you 1o . mountains, and
G‘.uickl‘,»; search — . - — TR want to check

WVOUT COmputer’s SER— ny s % the Ski Report,

Ceeadr Gl

contacts to find o s ot 1 g YOU Can type a
the person you Pt Dupct el et o 290 ke L apedest o resort name in

3 wimanagscjera risdikioe -l €Ty, or RGN M A
need, without the P .0 et = o e o7 and view

need to open the e o o s maten s sy o, - 3 W the conditions of
Address Book app ' the snow

ESPN o Flight Tracker Movies Stocks
Calculator If you're an American Dictionary Choose an airline, If you live in the US, you If you're financially
Small, neat, and much Sports junkie, the ESPN The Dictionary widget departure city and can quickly check the minded and like to keep
quicker than Lion's app. widget is made for you. allows you to search for arrival city to view latest times in your area, an eye on stocks, this will
Typing numbers and Get news and scores for any word quickly, getting the status of flights, as well as buy tickets help do just that. Input
symbols is supported to hockey, football, baseball you a definition or Incredibly useful if you once you know what you yoUr companies and
increase productivity and more synonym quickly travel with your Mac want to see away you go
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Key features

Starting the Dashboard

Two ways to access
Dashboard

Lion made it even easier 1o access your Dashboard.
Since that version of macOS was released,
Dashboard has become a space to the left of your
main desktop that is there whenever you need it.
Getting there is easy. You can swipe your fingers
quickly to the right on your Trackpad or Magic
Mouse and watch the Dashboard slide onto your
screen, Alternatively, open Mission Control and

click on the Dashboard thumbnail.

Arrange your
widgets

When you first see your
Dashboard, there should be four
widgets in the middle of the
screen; the Weather, World Clock,
Calculator and Calendar. They
certainly aren't stuck in those
positions; if you want to move
them around, you can click and
drag them to a different area of
the Dashboard. Unlike normal
windows, there isn't a bar you
have to click to move each widget
— clicking and dragging from
anywhere will work.

radk your Neght by sl line
v ar TGk e

Adding new widgets
While there are only four widgets on the screen when you first open the
Dashboard, there are a lot more available, Click on the + symbol in the bottom
left cormer of the screen and a screen will appear showing all of the available
widgets. To add one, click on it and it will appear on your Dashboard and you
can click and hold and drag it into position. See the opposite page to find out
what each widget can do.

Manage your
widgets

If you wish to remove widgets
then the process is just as simple.
Click on the ~ symbol and a "X’
will appear in the comer of every
widget — click this to delete it.
Once done, click on " again to
return to normal, To download
new widgets that aren’t currently
on your Mac, click the 4+ symbol
followed by the 'More Widgets'
button at the bottom of the
window, and choaose from the
hundreds of free choices on the
Apple website,
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IGetting started

An invaluable central place to view all the important alerts, updates and
more on your Mac

Get to know Notification Centre

Holification Cenbter shows your glerls in the uoper-right of your soreen, withoul interruplng what you'ne

e —— N The NC.J'l'iﬁ cation Eentre-_ is a central focus for chIa nge on your Mac, Sy Show and s Natiication Canter by Gicking s con in the mon bar
i H“*""::::* /\ recurdlng new hgppenlngls and occurrences. It's a place where you O TR i Ao D
— . 8 can find information regarding updates for your apps and you can p—— g A
= e also see information on new mail that has arrived. Reminders are another area =S ety e e
.= A : : : ! : St Trr o D Mok Dt
. e that the Notification Centre handles, as well as information from the likes of g e
s IRt FaceTime, Game Center, Calendar, plus messages from other third-party apps. The ‘ e Whar the dtphey b saeping
i e Notification Centre can be configured by yourself, however, so it's not set in stone. & s DS
You can tell the Mac just how you want to see your alerts, in what style and format R N e i
and for how long you want these alerts to remain on the screen. This focuses b e i TR
on the visual end of the Centre, but you can also include sounds in that suite of - Bwron e et
features too. Let's take a closer lock at this useful facility. a o

Explore the interface

Manage your alerts and updates

Timing

Next to each alert
voul will see 3
relative time/date
to inform you when
the alert arrived.
On the desktop,
the notice badge
alerts provide an
alternative method
of bringing change
to your attention

-~ & ML

LO£EHGOTET ¢ seCCQOOTA -

DO NOT DISTURB

If you are busy or need to concentrate, then regular messages and
alerts will not help. Swipe the Do Not Disturb switch to On, at the top
of the Notification Centre, to remave them all. Also, every time you
get a notification an interactive bubble appears at the top-right-hand
side of your screen. You can automatically reply to any message you
get by hovering over the bubble and then pressing the Reply button.
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X next to the header

" Notification Centre

This main window is placed on the right of
the screen and is normally hidden from view
but can be triggered to open, revealing your
alerts, updates and news

Header

Each app provides a heading and icon, then the
alerts, news or updates undemeath. If you want
to remove the information for that app, click the




NOtiﬁcation centre Master the Notification Centre in macQOS
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01: Open Notification Centre

To open the Notification Centre, click on System
Preferences. On the first ling, at the far right, is the
Notification Centre icon, so click it to open.

Motification Centar shows your alerts in the uppor-right of your screan, withoud imterruoting wha
doing. Show and hide Hotification Center by clicking s leon b the menu bar,
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Motification Center sort order:  Aecenis H

04: Show in Centre

If you click on the Show in Notification Centre
option box, then the alerts will always appear in the
Notification Center on the right side of the screen.

Maotification Center shows vour alerts in the upper-right of your soreen, without imteniupting wh
doing. Show and mige Notfication Cenper by clicking s icon in the menu bar.
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07: Play sound

Tick the Play Sound for Motifications box to ask the
Mac to play its alert sound when you receive an
alert, update or news item.

Matification Canter shows ywour alerts in the upper-right of your scresn, without intemupting I

dioing. Show and hide Notfication Center by clicking its icon in the many bar.

Dia Mot Disturh Eaendar alert style:

e |
None sees
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02: Choose an app

Pick which app you want to modify by looking in
the left panel. Scroll the available list until you find
your desired app and then click it.

Matification Center shows your alerts in ke uapar-right of your screen, aithoul Irlum.mhn'nhi

damg. Shoe gnd hide Molilcation Center by clicking s ican in the maru B,
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Badgs app icon
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05: Lock Screen

For certain apps like Messages and Mail, you can
choose to have a preview of the message as well as
the notifications displayed on the lock screen.

Motificaticn Cantar shows your alarts in the uppar-right of your scresn, without intarrugting

doing. Show and hide Natification Center by clicking s ican in the menu bar,
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08: Sort notifications

Clicking Netification Centre Sort Order will produce
a pop-up menu, with two options presented to sort
Notification Centre manually or by time,

-Huﬂﬁnlﬁtmmt- shows your alerts in the woper-right of your screen, wihow! inerrupling what
| dicing. Show and hide Matification Camder by clicking fa icon in he memms ber,
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03: Choose style

You can choose from one of three possible styles:
None; Banner (appears for a short time); and Alerts
(stays until you remove them).

Mali¥icaticn Center ghoras your 8@ms in the upper-right of your scrsen, withaut intefrupting wh)
diaing. Show snd hide Motificatan Canter by clicking it icon in ths many b
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06: Badge icons

Click on the Badge app icon to enable alerts and/or
updates to show badges on the icon of the app in
the Dock. The red icon has a white alert number.

| Maotffication Cenbar shows your alarts in the uppar-right ol yaur scresn, without bennmupiing wi
doing. Show mnd hide Notification Certer by clicking s icon ir the menu bar.
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09: Order apps

If you aren't happy with the order of the apps
offered in the Notification Centre then you can click
and drag an app to rearrange their order.
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Set up widgets in Notification Centre

Extend Notification Centre’s functionality by using time-saving widgets that'll
enhance your lifestyle

emm,  Notification Centre was introduced to What's even better is that you can add
f}—k Macs back in Mountain Lion and for the widgets to your Today view by hitting Edit, for

past couple of years has served as an a fully customisable and personal Notification
at-a-glance method of viewing everything that's Centre. There are widgets 1o suit any interest
going on in your world. It gives you direct access o or need, so you can modify the Notification
all your social interactions and business Centre to your personal preferences. Essentially,

appointments. One major change in OS X Yosemite Notification Centre's usefulness has been improved
was the introduction of the Today view in the panel,  exponentially. We're going to guide you through

which — just like in iOS - gives you a run-down of setting up and using third-party widgets to

your day's events from Calendar entries, Reminders, Notification Centre, giving any new macQS user a
weather forecast and so on. Your entire day is laid time-saving method of checking vital information in
out for you, no time at all.

Notification Centre widgets i-depthinfo

Most widgets are expandable and
Up close with your pimped out provide even more information with

Notification Centre just a couple of clicks — just like the
Weather widget shown here. Time to

WEaEy LI WArTm

Notifications |
Don't forget the traditional e e bee Ot
Notifications tab, which lists all of |

your various unseen notifications and
enables you to respond straight from
Motification Centre

Do Not Disturb i e o e e e et ™
Taking your Mac into an important e W Tt Torm: o 3 ok Dk Wit
meeting? Sleeping with it under the _ . Sonee o
pillow? Just activate Do Not Disturb, ? e S
set a time period for silence and ' LI monl e
" = e b ] =5

tweak the settings as you wish _ i ; B9 o et T e

. Woren Dgs Wt Dbwwrs i camas on

Biberm ra e bred e e

App Store S

The ultimate place for an essential list
of compatible apps can be found via
this App Store shortcut in Edit mode

under the Today view

THE END FOR DASHBOARD?
When widgets for Notification
Centre were announced at WWDC,
everyone shared the same thought:
this is the end for Dashboard,
Apple's home of the simple widget.

Well, it still exists but its days are
surely numbered. Using a widget

in Notification Centre makes a lot
of sense, is quick and easy, and is
supported by a thriving community
of third-party developers.
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Notification Centre . .omie the Today view

Motification Center
Widgets

L 5
q "
i .

01: Basic setup 02: Mac App Store 03: Edit tab

Access Notification Centre through a three-lines A host of great apps already support the widget The Edit button at the bottom of the Today view
icon in the top-right corner of your menu bar. Your feature and there's a list on the Mac App Store’s powers up Motification Centre. Click it and you're
basic Today view is very useful but limited. Featured page. Take a look and get downloading! presented with a new row of compatible widgets.

04: Click the plus 05: Use a widget 06: Add social accounts

To add a widget click on the green plus sign next Most widgets require a bit of personalising. The Other widgets require you to add account details,
to its name. Click Done in the bottom-right and the World Clock, for example. Hit the i’ button and add like the Social widgets. Click Add Account and
widget is instantly added to your Today view. a face by typing in a place and hit Done. follow the steps to get your account running.
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07: Time saver 08: Reorder 09: System Preferences

Now you won't need the app or a browser. Send a MNotification Centre lets you reorder the widgets Edit mode leads you to System Preferences via
Facebook update or tweet a post with all the usual on your Today view. Click and drag to reorder and the cog in the bottom-right. Customise how you
additions, right from Motification Centre. banish widgets by hitting the red minus icon. receive naotifications from your widgets here.
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Getting started

Talk to Siri on your Mac

Siri is as useful on a Mac as it is on an iPhone

Siri has almost taken on a due to macO5 High Sierra, and it even
9 generic-trademark status comes with some extra functionality to

similar to 'Hoover' and 'iPhone' boot. Thanks to the High Sierra update, Siri
in that it's referred to by that name even  sounds less robotic than before. It will also 3 i e bk e s
when another service is used. It i learn what music you prefer to listen to . R ey
capable, fast and for many iPhone and and if you ask it to, Siri will make - L
iPad users has slowly crept into their daily recommendations. With no setup process, Vo Pembh: « B 08
workflows. The really good news is that Siri it shouldn't take long for you to start ! S B Pt by
works in almost the same way on a Mac enjoying Siri on your Mac. ' ¥

"Siri works in almost the same way
thanks to macOS High Sierra”

Do almost anything with Siri o r——

The perso nal assistant now lives on your Mac The main Siri interface looks very similar to what
you will be used to on your iPhone or iPad. It
offers visual and audible feedback to help you
understand the results instantly

Siri settings

There are sorme settings for you

to play around with to help you
change the style of the voice and to
set up Siri keyboard shortcuts, There
is nothing unnecessary included in = o
the Settings screen it - A D . ...

HEG
g Mam Coeinilh  ACTAAE ocs e

Hanay M8 HAE B

i s, o i T s et
e S

Manage apps .
Same Siri questions will open e o
an associated app to give you . | o2
the answer you need in greater
detail. For example, asking for a
route will immediately open the
macOS Maps app

______

gl ®

CHANGE
SYSTEM SETTINGS

Siri on a Mac is extremely flexible
and has the ability to directly
interact with the hardware itself.
For example, you can say “Turn
Bluetooth off” and it will be done
immediately, with a small panel
appearing. This lets you tum it
back on if needed and means that
most of the hard-to-find settings
are now easily accessible.

Pin the answers

You can click the + icon in a Siri
answer to pin it to the notifications
panel. This lets you get the info you
need and then refer to it when the
time is right
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Use Siri on your Mac 1< how to make lfe casier with sir
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01: Enable Siri

When you upgrade to High Sierra, you can enable
Siri. If you choose not to, you can do so in Settings.
There will also be dock and status bar icons.

04: Save the answer

Tap the %+ icon when an answer is previewed and it
will be added to the Notification Centre. It's simple
and quick to refer to later.
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07: Use dictation

Go to Settings>Keyboard and click the Dictation tab.

Enable it and then tick Use Enhanced Dictation. This
enables the Mac to listen for new vocal commands.

San balps you get Ehings done, juss by sskirsg. Find fies on you
Rllper, diciadn a pobe, chack the waather, and mang,

Koyboard Shortcut;  Hold Command Specc E
Mic Input: | Digital In [~ ]
Language: Englsh [United Kingtom) B
L Sirl Vioice:  Brish Male) 2]
& Erabile Asi S Voice Feedback: @ on  Off

B Show Sir in menu bar Sin Suggestions & Privacy..

02: Setitup

(G0 to Settings=5ir to change the voice and language,
choose the mic input and also set up a new keyboard
shortcut for Siri. The settings are minimal,
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05: Access more detail

Some answers come with a preview image and text
s0 you don't need to move away from Siri to find
what you need. Click to view even more detail.
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08: Say Hey
Go to Accessibility=Dictation and tick ‘Enable the

dictation keyword phrase’. Type ‘Hey' in the box and
the Mac will start dictation when you say "Hey"

03: Ask a question

Use a keyboard shortcut or click the status bar icon
1o activate Siri. Ask a guestion and the answer will
be spoken aloud and also visually displayed.
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Eiri halps you get things done, just by asking. Fnd file
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06: Set keyboard shortcut

Go to Settings=>5iri and set up a simple keyboard
shortcut to activate Siri. This is needed to use ‘Hey
Siri’ but is also handy at other times.
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09: The final setup

Click Dictation Commands and then 4. Type ‘Siri" in
the top box, choose Any Application and then add
the Siri keyboard shortcut. ‘Hey Siri' now works.
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IGetting started

Use macOS’s Manage
Storage facility

Master the storage management tools within Apple’s

latest OS

in computing, and in an era of photos,

videos, music and apps we all crave
more, Despite pocketing devices that boast the
sort of gigabyte capacity that would have made
Deep Blue blush, our fervour for file retention now
sprawls online — a move with useful implications for
desktops too.

i ' Storage remains as fundamental as ever

o 1 R e

01: About This Mac
From the macOS desktop, begin by navigating to
and selecting Apple=About This Mac from the main

Finder menu bar, The About dialog showing the
Overview tab should be displayed.
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04: Optimize options
Click 'Optimize’ and checkboxes toggle automatic
removal of watched iTunes videos and a choice

between downloading new email attachments or
none at all,
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Previously, with the release of macOS Sierra,
Apple recognised this increasing storage flexibility
by adding custom management tools for
decluttering your system drive. Useful for improving
performance, not least clearing room for more stuff,
these features embrace iCloud and iTunes and can
be tweaked to the max. So in this advanced guide
we take a closer lock. ..

02: Storage tab

Click "Storage’ to view connected devices. A colour-
coded bar shows how the hard drive is populated,
but click the ‘Manage’ button to the right to show
the Recormmendations box.
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05: Trash talking

The third button is useful if you often have a
brimming Trash basket. Turning this feature on will
automatically erase those files that have been trashed
for over 30 days.
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03: iCloud Storage

Click the first button and a prompt offers two
checkboxes for storing desktop and documents
files, plus any photos and videos on iCloud Drive
and Photo Library instead.
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06: Reduce Clutter

Click 'Review Files' to show the Documents itemns.
Large Files and Downloads are shown ordered by
size for selection and deletion, while File Browser

offers folder navigation.



Unboxing macOS storage

We pick apart the key components and tools within High Sierra’s new management utility

Recommendations
and file types

The first item shows the

Recommendations pane by
default, containing the four

main button-basad controls.

Below this are listed the various
stored file types, iCloud, and

programs you can view to
make more direct changes

DOWNLOADABLE
CONTENT

The Manage Storage utility allows
a number of files to be deleted that

you can always download again,

One such selection is Music Creation,
where GarageBand's Sound Library
can be removed completely and easily

re-installed through the app. Just like
Mail attachments and iTunes content,
these files can grow very large and are
useful to lose when clearing significant
space quickly.
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07: Deleting files

If a little cross icon shows as you hover over a

listed file, you can click this to choose the file for
permanent deletion, or the magnifying glass to view
within Finder,
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08: Applications view

Under the Applications tab, you can again view
installed apps by size and delete as desired. Clicking
the Open Applications button opens the folder
within a Finder window.,
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09:

Store in iCloud
This option automates the shifting of
all file and photo storage onto iCloud
instead of local system drives. Only
recently accessed documents and
storage-optimised photos are kept on
your Mac to maximise space

Optimize Storage
Click this button to take actions such as
removing any locally downloaded iTunes
videos once watched, such as TV episodes
and feature films. Additicnally, things like
only your most recent email attachments
will be retained

Trash & Clutter

[urn on this to toggle the automatic

Macintosh HD - 542.87 GB availabls of 999,35 GB

sk ?
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05 inataliers

- 25 May 2086, 18:08
- 3 Feh 20MT, 18:57
= 11 Jun 2094 1847

i 105 A for iPhone B
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i« Firmssare 1.0.3 for

1P

¢ Firmwarg FirmreareMSE for iPod Hano
i Firmware 1.0.4 for iPod Shuffle

I0S Files

Cancel
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erasure of trashed items after a 30-day
period. The Review Files button then shows
redundant files or content that can be
manually deleted to remaove clutter
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Aside from the other items, i05 Files is useful for
identifying old device backups and iOS installers.
They can simply be deleted in the same way, using
the cross icon.
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IGetting started

Take advanta
iIn macOS Hi

9

ﬂeSierra

Learn all about Spotlight’s new features and advanced
search capabilities

-

When you need to find an app,
document or other file, Spotlight has
long been the go-to tool for Mac users.
An updated version of this essential feature is in
macOS High Sierra, boasting some great features
and even better searches than before,

For example, Spotlight can be resized and moved
around the screen almost like any other regular
window, which prevents it from getting in the way
of other apps on the screen and shows more search

results. The range of Spotlight’s searches is wider
than before and it can find even more content on
the web than ever.

There is no need to fire up Safari when
performing a web search, because you can hit
Cmd+5Space and enter a Spotlight search (which
will now search the web as well as your computer).
It also has a better understanding of search queries,
too, and can find items related to a phrase written
as you would speak it naturally.

Intelligent Spotlight searches

Get much more from Spotlight searches

Top Hits

The Top Hit is Spotlight's best guess
and it is indeed the Harry Potter
book in this case, The result is an
email and the icons next to each
result indicate the type of item

Jump to here

Search results are arganised into
sections to make thern easier to
navigate, Jump from one section
to another section by holding
down Command and pressing
the up and down armow keys

CONFIGURE

SPOTLIGHT

The results that Spotlight shows
can be configured by going to
Systemn Preferences and clicking
Spotlight. Tick the items that you

want to see results for and clear
the ticks against anything that you
don't want to see. Ticking every-
thing might show too much, so use
the list tofilter the search results to
show important ones.
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4, James Bond

fors

of Spotlight

Related information

This really highlights Spaotlight's ability to find

not only direct results like the top hit, but related
information, It obvicusly looked up the author and
displayed anather book fram her, which is clever
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Resize and move

The window can be moved by
dragging the top bar and the top
and bottom can be clicked and
dragged up or down to make the
window bigger or smaller. The width
is fixed, though




SpOtIight Search using Spotlight
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01: Search with Spotlight

Click the Spotlight icon on the menu bar and enter
what want to find on the Mac or the web, such as
The Martian. There are books, movies and more.

04: Get the weather

Search for ‘weather’ and the forecast for your local
area is displayed. You can just as easily see weather
forecasts for any where. Just add the location.
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07: Access Spotlight contacts

Spotlight can be accessed from within the Contacts
app. Open Contacts and select a person in the list,
Go to the Edit menu and select Spotlight; 'name’

02: Move Spotlight

Clicking the music link opens the iTunes Store. Open
Spotlight and click and drag the window to any
place on the screen like a regular app window.
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05: Expand the window

Sormetimes there is too much information to fit in
the Spatlight results window. It's easy to resize it.
Click and drag the top and bottom edges.
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08: Intelligent searches

A degree of artificial intelligence has been built into
Spotlight and it can understand more than you might
expect. For example, search for 'emails from name’,

03: Search for videos

Add video' to the end of the search term and it
changes everything. Now the results include links to
movies on the web. In this case, the YouTube trailer,
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06: Get flight info

Spotlight can now show flight information such
as departure and arrival times. lust type the flight
number to see the details.
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09: Use dates

Dates can also be used in searches. Suppose you
want to see the photos you took in January. Just
type ‘photos from January’ in Spotlight.
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Getting started

Inside System

Preferences:

Personal

Learn how to tune and tinker with the inner
workings of your Mac by following this simple,
four-part guide to System Preferences. First

up: the Personal settings. .

Many Mac users are happy to leave their Mac set up
the same way it was the day they opened the box.
That's fair enough - after all, why fix what isn't broken?

However, if you're prepared to take a few minutes to delve into the
wealth of settings at your fingertips, you may just find a few that
could change the way you work, make your Mac a safer place or
just spruce the ol gal up a little. In the first of a four-part guide,
we're going to take you, icon by icon, through the top row of the
Systemn Preferences window: the Personal settings. ..
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- Security

Energy Saver

By setting your Mac to require
a password when waking it
from sleep or screen saver,
your Mac will autornatically
lock while you're away. You
can also set it to only respond
to a certain remote control,

FileVault

By using FileVault, you can
automatically encrypt every
file on your Mac — great for
security-conscious laptop
users worried about losing
their computer, and the
sensitive data it contains.

Firewall

It's no myth that Macs are
safer on the internet than
Windows-based computers,
but if you'd rather be safe
than sorry you can turn on
the Firewall to monitor and
block potentially dangerous
connections from the net.
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Scroll bar controls

With a scrolling mouse, you may never
hawve used the scroll bars on the edge of
every window, but there may still be
settings here that you'll find extremely
useful — such as the Jumping options
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Text smoothing options

Without smoothing, the wards on your
screen can appear harsh and jagged,
but you might find text too tuzzy to read
comfortably at smaller sizes. You can
fine-tune the effect here
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Search System Preferences
if you know there's an option you'd
like to change but can't remember
where it is, try entering its name into
this search box to see matching icons
dynamically highlighted

8 > | mii System Preferences
F 2 B Ao 2
Ganeral Desktop & Dock Mission Languaga Sacurity Motifications h ;
Screan Savar Control & Region & Privacy

& B .

COs B DVDs  Dizplays Enengy
Saver

®@ -

Internet Extensions
Aocounts

- N

Printers & Saund
Scanners

Trackpad

Mouse

>

Blusiooth

b i

Metwork Sharing

F = © @
N QD ¢ B

Usars & App Stone Dictation  Date & Time Startup Tima Accessibility
Groups & Speech Disk Machine

Notifications

In Notification Centre

In this panel, you will be able to
determine what apps alert you in your
Motification Centre and change the
order by dragging the appsarond s
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Alert style
Click on a listed app and then you will
be ableto determine how the alerts
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General

Here, you'll find the settings that affect how your windows and menus appear.
You have the choice between the usual Blue theme, with shiny blue contrals
and red, amber and green window widgets, or — if you find all the colour
distracting — you can switch to the Graphite therme where all the controls are
grey instead.

E8 Lafyysage & g

Lo e B Pt Dot g sl SO0 | 1o el i) Gl Y PPvrl D Dkl
arad by fravradn ol daies, Hirea, medd caresscess

Regiaf  Lrniles Exngdom
Furml dimy of wesl:  Worwiay
Calerlar eyt

T ferrral: B0 34-Hour Teri

Sorwlay, 1 Lwweay FE7E 3T 20 78 JwaT
G T T2 [T

| mrgamge & Naguee
O T
Foomes WEAOF  E-ghat H
Fra e e dnd "ty
Vo b s GroLpiop B tesen -]
Cumency:  Evitish Pourd leriiog i) B
Oreuping . D mad :

Wi e Lt Ihl-ﬂﬂ

BauXry, b ARy JLTT Y R A T
BTS04 O o 1% 8 LB 2

Hurylimisil

LS ST g L= S T et Rraeren

Pk -

(]
adi
=]

L=t
=m
L]

Py

Mesai a AT
S T
I =y el

Speing

Wy el oo
Sy o v TOB

for S Gl

tham | B P =% bes drd sl as b ® s nis e
AR T D N RN P P Py 0 T s
T i B e ey

By Kapyftanand & Dhavmcing Wiarairy o it b

B Up Bluaizcth dlaptaant

S iTiTabic by Langulags

‘mhc

Bleis Wiaws

I3 Gorroot aowiing avsicratiooly

£ Lira suan nuicien ard rashan
e Doihi Gusled. ae |

Language
& Region

General

For most users, this will come
pre-set, but you can quickly
change the language of
menus and controls in the left-
hand pane of this screen,

Advanced

Dates, prices or times not
displaying the way that you
would like? You can change
hiow your Mac automatically
formats numbers by clicking
Advanced on the Language &
Regions page. Presets for most
regional variations are here,

Text

Click Keyboard Preferences
from the Language &

Region panel to find the Text
options, You can set your
Spell Check options here, and
also set your Mac to replace
certain typed shortcuts with
special symbols, like (c) for

©, This only works in
supported applications.

Keyboard

While you're here, click the
Keyboard tab. The thing most
users will find useful in this
section of System Preferences
is turning on the Keyboard
and Character Viewer, which
gives you a map of those
hard-to-find symbols on your
kevboard, like &, O or °,
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Inside System
Preferences: Hardware

Get to grips with the technology inside your

Mac by following this simple four-part guide

to the System Preferences. Part two: get your
hands dirty with the Hardware settings...

The simplicity of macOS means that you don't have to
become an expert on computer hardware to enjoy using
your Mac, For most peripherals, you can just plug in and

play; at the worst, you may have to install the accasional driver.
However, with the improvements made in recent versions of macOS,
even these installations are becoming fewer and farther between. This
ease of use doesn't mean there aren't any settings to fiddle with,
though - System Preferences has a whole row of icons dedicated to
fine-tuning the hardware settings of your Mac, and a few well-chosen
tweaks could vastly improve the way you work.

Displays

Make sure you're using the optimum viewing
settings to get the most from your monitor
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o

Display
Everything seem a little
small on screen? The
higher up the list you
set the resolution, the
more pixels and screen
space you'll have, but
everything looks a little
smaller as a result,

Arrangement

If you're sporting more
than one maonitor for
your Mac, this panel
lets you tell your
computer how they are
positioned and which
one you want the Menu
bar to appear on.

Colour

Ensure you're seeing
the correct colours by
either selecting the
correct Display profile
or, even better, by
clicking the Calibrate
button to create a
bespoke setting.

Schedule

Want your Mac to be on when you
wake up or get home from work?
Use the Energy Saver schedule 1o set
when your Mac turms on, turns off,
goes to sleep or wakes up
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Keyboard
Considering how much of the'time
you spend sitting in front of your Macg,
you also spend time tapping away at
your keyboard, so it's good to make
sure you've got it set up perfectly. If
you're a slow typist then increasing are from this pane, you can also tweak
the ‘Delay Until Repeat’ setting is an and change them to better suit your
m=especially good ideaif you oftenfind __ fingertips - a great way topersonalise
your Mac for the way you work.

Keyboard Shortcuts W
macOS comes crammed with mafy S5 i
keyboard shortcuts that can speed vﬁff .
up how you work, saving your hand = =SS is
a trip to the mouse or Trackpad. Not 48‘;
only can you discover what they all .

| 'r : r-. lf t}rping r(}pﬂating letters.



Share your printer e ":,'::ﬂ" Printe I'S & SCBI"I ners

Although Wi-Fi printers are surprisingly

cheap these days, if you have a o i
non-networked model you can still share s i
it across multiple Macs (and PCs) by
ticking this checkbox
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The pane that you see here will dEpené'Ei -
onwhether you use a laptop with LS.
a Trackpad, a Magic Mouse, Mighty 1 b s
Mouse or a third-party mouse. As with

the keyboard settings, considering

hew much time you spend controlling

a cursor, it's important to get these

settings perfect — especially the

fracking and double-click speeds.
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Learn your gestures

As multi-touch devices, like the Magic Mouse or
the Trackpad on your laptop, improve the way

you get around your Mac, you'll find yourself faced
with more and more gestures and actions. You can
customise them so the different buttons suit you
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With every new version of macOS, Apple has significantly improved the
printer installation experience. S0 much so that many users will never
need to visit the Print & Scan preference pane - simply plug in your printer
and most times it will just work. That said, it's still useful to set your default
paper size or check the amount of ink in your printer by clicking the

Sound
Sound Effects

Your Mac makes a number

of small noises to give you
feedback on certain events.
Choose which ones youd like
to hear, and how loud youd like
them to be,

Output

On most Macs there are

a number of ways to pipe

the audio out - through
headphones, the built-in
speakers ar through a digital
optical cable, for example. You
can choose which one to use
from this pane.

Input

The audio input options are
less useful to most users,

until you decide to try Skype,
record a movie voice-over or
experiment with GarageBand.
Choosing the right input
device will depend on the
equipment you use, but it is
vital for a great result.

Ink

If you're the arty type and
use a graphics tablet, then
you might want to have a
play with the handwriting
recognition that's built into
macOs. Ink allows you to
enter text using your pen and
tablet instead of the keyboard,
and it can be great for taking
notes. You can also set up
gestures to control your Mac
with the pen.
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Sharing
DVD or CD Sharing . ==
Share your DVD drive with a Mac
that either has a broken drive or

doesn't have one at all, like the
MacBook Air or the Mac mini server.

Inside System
Preferences:
Internet &
Wireless

Get to grips with the technology inside
your Mac by following this simple, four-part

guide to the System Preferences. Part three: : v : . =
networking and syncing il R — o O ——
There's one aspect that sets the computers of today far 8 o e e S B
ﬁ apart from those we were using just ten years ago: iR o EE?E: i Ern
networks. Back in 2000, the internet was only just starting B et s sy o o s 8 amunciiios [MRACRRNEL 3 eesom . Ncsarmes
to become commonplace, and if you did have it then you probably o e ST et
only had it on one computer in the house (which wasn't really a
problem, as most houses only had one computer). Now, with the
advent of easy Wi-Fi and cheaper computers (plus iPods and iPhones),
many houses have a handful of connected devices sharing the e5
airwaves and, with a little setup, sharing their connecticns, files and - 2 ol -; o &
data too. The Internet & Wireless row of icons in System Preferences is “rinter:snaring »CAnr harlng f& S
all about your Networks — local and worldwide — how you interact mdc0S;these setting SRS
with them and how you choose to share across them, be it sharing incorporated into the Printer sharing
your files, screen, printer or even disc drive. settings on your Mac.
. ‘ - = o : = B "
Lreaton  Artamatc B
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o S v . For most users, this o S .
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= canfigures itself. Bliss.
e Internet Sharing Remote Login
| Bluetooth Share your internet connection with For those users happy typing
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"You should find your
Mac just connects and
configures itself”
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Learn m t iCloud ; " : Y
ICIOUd ‘ ks e Syncing across iCloud allows
. S 8 ] comimn multiple Macs and iPhones
Account Details gt s . e f
: ARE even those in different
Sign in with your iCloud details to be |ClﬂUd Conate Agpie ID | 5 @ s locations, to share the same
able to sync details, files, music and : BT e bookmarks, address books,
movies across all of your devices. | i RS e calendars and more,
Hohewond
® O > | EHE System Praferancas Q 9 By Mo Manage
— _ ° The iCloud is your virtual
'—]F-. ’ ' H E - nf G hard drive on the internet.
[ i
General Deskiop & Dock Mission Language Security  Motifications 111 1) e ..:::T;n awaw  YOU CAN USE i,t to store
Screen Saver Control & Region & Privacy = photos, movies and files,
Dot Dot ot G [his preference pane lets
r - you check your space - you
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are provided with 5GB as

CDs & DVDs  Displays Energy  Keyboard Mouse Trackpad  Printers & Sound standard but can purchase
Saver Scanners more if you need it.
» @ v @ 0 W e ~ —
iCloud Intarnet Extansions Metwork Bluataoth Sharing P b 6 b g Iew CCQU nt
Accounts T . _
\ You can use this option to
T, 8 s i check that your existing

Remote Management -"i’r'femote ﬂpplaEvents | — account detals are correct

F.79 a moin or edit them to reflect any
A stép*up from Scréen Sharing; .y + =% FOE the Teal power users, Remote PRI changes in your adaress or

Réfote Management allows system- <= Apple Events allows your Mac to be credit card information. You
‘:]E‘.'V'EJ control of }-"GUT_MFE ﬁrﬂrn_-afal'. automated t]-'l," other computers. WIS | wu—— can also upgrade your iCloud

1TB . account with more storage.

P Bun b

Purchase more space

R R i s s s PRI | e A Your iCloud account comes with 5GB of free space as
Ul - 2 s e standard, but if you come to realise that you require
- Lerpedier et

more, then click on ‘Manage Account’ and then click
‘Change’ next 1o the Storage option and purchase

Afow soosm dor £ A L

Cmmr v dpde Dy Sy iy ey
ol e anything up to 50GB in storage space

1 Weork pexoen

Stay safe
You don't want to let just anyone
send your files over Bluetoath,
especially if you use a laptop in
crowded areas like airports. To be
safe, tick both ‘Require pairing'
boxes and leave the "When'

' -_:, options as 'Ask What to Do’

."'l‘ i
il

Bluetooth Sharing Jaes -

[orgaie s (i Ll

L T S e e LT

_Share photas, ringtones-and et

more with a mobile phone B s [ S

; using Bluetooth Sharing to - :T"E: __,:__ ::“:, 8
T Tcreate a short range network R
to pass files across. e s L.
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Inside System

Preferences: System

Get to grips with the technology inside your Mac by following this final
part of our guide to System Preferences. In this section, delve into the

final row — the System settings

them, get deep down and dirty into the depths of

@ The System settings, like the Network settings above

macO5. Many of the changes affect all users of the Mac, and

it's here where you'll discover the tools you need to control which
users can do what. It's also where you'll find Accessibility, the first place
you should go if you have physical difficulties that make it hard for you

to enjoy using your Mac.
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Date & Time

Always be sure that
vour Mac's clock

is bang on time

by setting it to
automatically stay
synchronised with
Apple's time servers
over the internet.

Time Zone

Let your Mac know
where you are in the
world by clicking the
map near where you
are, then choosing
the closest city to
you from the pop-up
menu at the bottom
of the screen.

Clock

Set how your Menu
bar displays the date
and time. If Menu bar
space is at a premium
then you can choose
to see a tiny analogue
clock, or even get

rid of it completely
and have your Mac
announce the time on
the hour, every hour,

E ] m ke il Dbl & 15} Lipgrs 4 firoups
[ Passecrd R EETCH Faewon [ETCEEER
F An [
s o Gt ot j geane e e s vty e
Hoy e Lo ]

. P LT

Lmanlensor i mis o
i By Vet e T Eprlmabirr
i Bt Sy e e Epobowinr
i Ao § o e e dgers [ e

Rl 1M T G L g

Cordauty Carvd [ A iy e Mal By Bpckoator

Bl Do Apchoabor

W Padm i il i iy b e bt ] sk & Bt o P ik
LA il W R ™

ﬂwm Thaid Pusaviil Cieds i i'—'-ll" Cuers A

| Chce tha icca fa ruas cages L_| e ot b s crasces

!\'.n.- - - =
e NOra {I|F 2T

':.; E"..‘"\' o edit .'-r".; /) 1're \
LL}] :ﬁ § i ;i*.i:'w‘i"ﬂ -:"E-tl
g Y LA S E =TT - applica
" ‘é. .VAﬁi-._E..;ih‘_ E o fjﬂgfilu,
- ':I.Lm UL LTIENU T YOL CL YULIT TELUILATTY
Wy E $es notydU sHorName :",_f : ‘i#; o
- A % F ‘.’*t
e N,
- L 'ﬁ ; -':. r o i 3 -.
e R

TR - R

Dectatnw & Seraee®

SR o
Lims Doiren aSemar you car Syea e bz e desing, Sitars Woicm Morcess H
b B aheriedl o seleet S Dewtion Man e B8
P Blrmsb v Pt ' Pratg
g Fow Y=g =
Ptgtior; @on | oo w
Pl e LA =
ey L Enhasoed Dlomotion !
ey, e L e et S
S Iy e e Enmoures when sles o dosplarpsd
Lanpig | Eaglh i) 1 E ¥ Spash mdected Saxt whan B oy & proases
Current by Shikal | Cranga Ky,

Aotk s e Cavreern Ky Tass H

T P D @R T e Lov, Coan Dale & Tire Prodiiendes. .

To charge Yoeelve stings 1 Agrwidd iy Prafsmscm..

Bhewn [l miaa ared 34 anoy

Textto speech =™+
Not ofly'can you talk to your Mac, it
can talk straight back at you. Text to
Speech can give you valuable audio
feedback when your Mac requires

R/ Our attention, SpEaking alert boxes

“rand more. You can also choose your

Mac's voice from a wide range of
styles and speeds.

Dictation

Wherever you can type text on your

Mac, you can now speak it instead.

By activating this feature and.asing

your Mac's builtsin microphone, you
PN 9y FUS

e

3 LA (1A
LOTTHNG Wwilloe 1gTte .

S bt MR :
AR 2 o converted into text. Read

more about it in the pane itself.
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Startup Disk

Select the system you want bo use to start up your compuber
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General Desktop &
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CDs & DVDs Displays

ICloud Internet

Accounts

Screen Saver

Dock
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Energy
Saver
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Extensions

Raslarl...

Targat Dish Mode...,

System Preferences
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Mission
Control
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Keyboard

Network

Startup Disk

For power users with
different versions
macO5s installed
across multiple hard
drives, this pane
enables you to pick
the drive you'd like to
start from.
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Time Machine

macOS comes with
what is arguably the
best 'set it and forget
it" backup utility: Time
Machine, Tumn it on,

3 Show Time Machica in menu bar Opligns. .

Notifications

o

Printers &
Scanners

1 <

Users &
Groups

App Store

1
Dictation
& Speech

Date & Time

= ©

Startup Time
Disk Machine

Accessibility

Flash Player

e

Growl

r'

l_':_'

a

Launchpad

!

Universal
Type Gore

select a disk and then
rest assured that your
data is safe.
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Software Update

Software Update runs automatically to
ensure your Mac is always running the
most up-to-date version of any Apple
software you have installed, including
macQ5, iPhoto, iMovie, Pages and more.
It lives inside the App Store app, but you
can access Software Update via the App
Store tab in System Preferences.
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Accessibility

This pane houses all of the options

to make the Mac much easier to use

if you are visually impaired, hard of
hearing or find it difficult to hold down
multiple keys simultaneously. Here, you
will find options relating to the display,
keyboard, mouse and more, to tailor
your Mac to your needs,
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Learn how to change the settings in System Preferences

to master multi-touch gestures

- If multi-touch gestures, introduced with
ﬁ Snow Leopard, are the cornerstone of

the macQS experience, then the

trackpad can be seen as the bricks and mortar that

holds it all together. Without the built-in multi-

touch trackpad on the MacBook Pro or MacBook Air,

or the amazing wireless Magic Trackpad, macOS and

its myriad of features wouldn't run half as smoothly.
The trackpad settings pane in System Preferences

helps to make that experience even better by

Using the preferences

Make the trackpad settings suit
your needs with this window

MASTERING
GESTURES

In order to get the most out of
macO5, it's a good idea to get used
to the gestures that will save you
time. For example, pinching with
your thumb and three fingers with
a claw-like movement will bring up
Launchpad, while pushing three
fingers upwards will bring up Mission
Control, Both gestures allow you to
speed up things like organising your
desktop and launching apps.

Tracking problems?

If vour Magic Trackpad is slow or
unresponsive, your first port of
call should be the tracking speed
slider in the trackpad settings. If
that doesn't make any difference,
try replacing the batteries in your
trackpad and reconnecting

Video previews

Even if you don't want to change
any of your trackpad settings,

the video previews in Systerm
Preferences can really help you
master some of the more tricky
multi-touch gestures. They're time-

allowing you to decide which gestures perform
what action, as well as playing you a handy video

of exactly how ta perform them. It means you can artant vacka g vt
make the trackpad work exactly how you want it to e
DCioubda-lag wi®® Two S-ga

and tailor it to your needs. In this tutorial, we'll show wy Smart 2oom
you how to get the best out of this little-known s
feature in order to make the most of your macO5
experience. It's an easy process that will soon have
you finding your way around your Mac with smooth
moves that suit you.

Tabs

Different trackpad settings are grouped
under three different tabs - this makes
finding exactly what you want to adjust
a lot easier and quicker. It also helps to
de-clutter what can often be confusing

preference panes

Trackpad

TN AR N Scroll & Zoomn

Tap to click

Emnnﬂ click

v Click o tap with two fingara
Click in bothoen right cormer !
Click in bottom el comar f

Thres finger drag
Mova with throe Bngers

Tap with one Brger IEI

Tweak your trackpad settings in
System Preferences

Poirt & Click Moo Gesiuns

Making settings simple
Recent versions of macOS have
improved the Ul of its trackpad
settings by spacing out different
settings and making it clear which
ones relate to which gesture with the
use af highlights, arrows and videos

More Gestures

-
.
#

Sot Up Bluetooth Trackpad. ..

Ly WA ] 11 R ikt ol |

7

savers and worth learning
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System Preferences

01: System Preferences

Click on the Apple logo in the menu bar, then
click on System Preferences. Here you'll find all the
settings for your Mac.
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04: Change the gesture

Under some settings, you can change the gesture
that controls them. Click on the drop-down menu
and choose the gesture that best suits you.
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07: More Gestures

Under the More Gestures tab you'll find some of the
more complex gestures. Make use of the videos to
master these new features.

Tweak your trackpad settings
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02: Find the icon

Click on the Trackpad icon in System Preferences
— this is known as a preferences pane. When you
install apps, they'll create preference panes here.
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05: Hover and preview

A short video animation is displayed to help you
understand how to perform different gestures,
Simply hover over the gesture’s name to preview.
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08: Tracking Speed

Drag the Tracking Speed slider to adjust the
sensitivity to your finger movement. The faster
on the slider, the more responsive it will be.
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03: Check them

Trackpad settings are displayed as checkboxes;
check or uncheck them to activate or deactivate the
settings. A video description is included to help you.

St Up Bluateoth Trackpad. ..

06: Different directions

Uncheck "Scroll direction: natural’ to revert two-
finger scrolling to pre-Lion behaviour. Since then,
content follows your finger movement.
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09: Magic Trackpads
If you own a Magic Trackpad, set it up by clicking

‘Set Up Bluetooth Trackpad' in the bottom corner of
the Trackpad settings window.
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Use Hot Corners in macOS

Activate functions just by moving your cursor to the corner of your screen

~ . macOSs has an unfair reputation for not being
U customisable, but sometimes you just need a gentle

nudge to realise that you can make your Mac work
exactly how you want it to. Failing that, a trip to System Preferences
is always well recommended. Take Hot Corners as an example. You
might have heard of this macOS feature, but are you actually using
it? Probably not. Hot Cormers enables you to perform a multitude of
functions when you move your mouse’s cursor into one of the four
corners of your screen, The Hot Corners feature is hidden in System
Preferences, but once you know where to look, you'll find out how
easy it is to activate and use.

Our favourite Hot Corners

Why some shortcuts are better than others Desktop

ADD INSTANT SECURITY

If you're worried about prying eyes
getting access to your Mac's screen,
even when you've used a Hot Corner
to put it to sleep without clicking
anything, make sure you go to Security
& Privacy in Systemn Preferences and
select ‘immediately’ from the ticked
Require password option. This works
as a second defence when you move
away from your desk.

"'l...__-_

Application Windows
Having the Application Windows action
activated will give you access to all open
windows from the app you're currently
using. Great if you're working on multiple
Numbers spreadsheets, for example
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If you're a Mac user that keeps files on their
desktop, having the ability to wipe away all other
windows and access your desktop instantly is
going to save you closing down every other
window you might have open

Notification Centre

Your Mac’s Notification Centre
contains a plethora of information
about what needs your attention
and what you've got coming up. Use
it as a Hot Corner to get that info
without clicking anything

'-—_-""F,

*-._M

e L
e w

o

Disable Screen Saver

Doing a presentation that focuses
on one slide for a long time, or
watching a video! Activate the
Disable Screen Saver Hot Corner
and use it to make sure your screen
doesn’t go to sleep
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01: System Preferences

As with most systemn tweaks in macOS you need
to take a visit to System Preferences. Load them up,
click Mission Control in the top row and you'll see a
button for Hot Corners.
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04: Activate actions

Obviously you only have four comers in a screen, so
experiment with the line-up of actions you want.
Click an action from the drop-down menus to select
it. Click OK when done,

accidental
actions

If you have activated all four corners of your

Mac's screen with actions, you will find that you
action tasks accidentally throughout the day. This

is frustrating, but there is a workaround using
modifier keys. This means you have to hold down

a key of your choice (like Command, Shift or Alt/
Option) when you head to a corner to activate a
task. Without this key pressed, nothing will happen.

Here's how it works.

02: Hot Corners

Click Hot Corners. The four corners of your Mac's
screen are representad now by drop-down menus.
Click on one of them to see a list of all the tasks you
can now activate,

O .

05: Test them out

Hot Corners are now activated automatically. Test
them out by maving your mouse cursor to a corner.
You'll find that the action is enabled without you
having to do anything.

01: Secret option

Adding a modifier key is a secret feature in
macO5. Go to System Preferences>Mission
Control>Hot Corners like before, but now
hold down a key like Command when
choosing which action you want to activate
as a Hot Corner.
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03: Your options

There are handy system shortcuts, such as loading
up Mission Control, your Applications menu and
Notification Centre. You can start a screensaver, and
put your display to sleep.

Deskiog & Scrsen Raess

e I

06: Customised setup

To get rid of a Hot Corner action click anywhere on
screen. You can change the order, have fewer Hot
Corners and so on. There's even a Hot Corners menu
in Desktop & Screen Saver,

02: Add modifier

You'll see the Command icon prefixes the
action. Keep Command pressed and then
click. This will add the Command modifier
key. If you navigate your cursor to the screen
corner now, you'll need to have Command
pressed to activate the action.
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Learn how to place two full-screen apps side-by-side with

your Mac’s multitasking feature

_ One of the many great features of macOS
is Split View, a subtle tweak that is useful
for streamlining the way you use more

than one app at a time. Until now, any apps that
were maximised to full screen dominated the
desktop space individually, making it impossible to

work across two side-by-side.

Split View rectifies this, enabling you to choose a
pair of supporting apps that will share the current
desktop space. Working hand-in-hand with a

Split View in action

We take a quick look at how Split View appears
while selecting a second app

SPLIT SPLUTTERING?

If Split View doesn't seem to be
working as expected, some users
have found a fix worth trying.
Open up System Preferences, via
the Dock or from the Apple icon,

picking the fourth icon from the
top row to view Mission Control
preferences. From here ensure that
the 'Displays have separate Spaces’
option is ticked before rebooting
and trying to use Split View again.

Available apps

While initiating Split View and with
a first app fixed, available apps are
shown within the opposite vacant
portion. Mouse over and click any
of these to maximise alongside the
first app, or use the desktop instead
to exit

Unsupported apps

Any open and active apps that do
not support Split View are shown
as thumbnails in the lower corner,
Hover over these and Split View
will indicate ‘Not Available in Full
Screen’ instead
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revamped Mission Control, Split View can be easily
initiated using each app’s green maximise button
in the top-left cormer. Hold this down and a blue

overlay toggles the left and right sides of the screen,

snapping current and neighbouring apps to the
desired areas.

It's a neat trick and one to take for granted once
you have mastered it. Read on to discover lots of
ways in which splitting your screen can make life
easier for you.

Split View dividing line

When two apps are chosen and both
screen halves occupied, you can shift
the halfway point. Simply click and drag
the thick black line down the middle of
the screen left or right to adjust

Set up and use Split View

Things by half

In Split View, apps are maximised
within just one side of the current
desktop. With only one app selected
on either side, clicking again sends it
fully full screen instead

ﬁ ;I\II T

Give two apps your undivided attention,




Split View See in double vision
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01: Green for full screen 02: Click and hold it 03: Game of two halves

Start with the round green maximise button on Click and hold the green maximise button. If the If you release the green button without moving the
your chosen app. All Mac apps have these, the third app supports Split View, the desktop will show a app, it will maximise to fill the current half of the
of three, found within the top-left corner. blue overlay below a draggable preview of the app. screen, then you can choose a neighbouring app.
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04: Switching sides 05: Split or run 06: Split View
If you dragged the app to the opposite side of the After one half screen is filled, you can now click on With both halves filleg, you are nowv in Split View.
screen, the blue overlay follows. Releasing the app another app to occupy the other half. Click the first Hover to the top of either app and click the green
maximises it to fill that half of the desktop instead. app again to go full screen or the desktop to exit. button to exit.

Manipulate
Split View

Split View is all about improving workflow

and the sense of focus between two apps
in a busy desktop. It works in conjunction

with Mission Control too, to negotiate
windows within multiple workspaces. As

we've seen it's easy to access, but also 01: Acljust the divider 02: Swapping sides

manipulate slightly once initiated. Chiefly Rather nicely within Split View you aren't forced In addition, you can very quickly switch the
you can then adjust the split point from to use an exact 50-50 split. With two apps side- positions of the two apps within 5plit View.
halfway to give one app more screen by-side, hover the mouse over the black divider Simply click one app, hold and drag the app
estate over the other, while very easily line. Click this line, hold and drag the divider across to the other side and watch the two
dragging each app to swap positions. either left or right to adjust. obediently swap places as desired.
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Recover files with Time Machine

Your guide to restoring lost and changed

files with Apple’s built-in backup app

A lot of the files on your Mac will no doubt
@ be quite valuable. There are videos, music,
photos, personal and work-related
documents, and much more on the disk drive, How
would you cope if you lost thern? Fortunately, Time
Machine aims to solve the problemn by making
backups - copies - of files, and storing them
elsewhere in a safe place. If you lose a file for whatever
reason, be it an accidental deletion or a disk fault, then
Time Machine lets you recover it.

It is called 'Time Machine’ because that's what it
is. For all intents and purposes, it effectively allows
you 1o go back in time, and if a folder contained a

Work with Time Machine

The key parts of Time Machine
you need to know

macOS’S LOCAL
BACKUP

Suppose your MacBook at
home or work is connected
to a USB disk drive in order to
enable Time Machine to back
up the whole hard disk drive.
When you go out with yvour
MacBook, that Time Machine

disk is no longer available.
Don't worry; since Lion, Time
Machine continues to back up
files by using spare space on
the local internal disk.

Restore the file

You can select a single file

or a whole folder of files in

the Finder window, and click
the big Restore’ button. Curl/
right-clicking a file reveals other
options, such as 'Get Infa’

Back and forth

Guess when your lost file is located
by clicking a title bar in the stack, or
by clicking the timeline. Then use the
forward and back buttons to maove
one step at a time and find the file
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file last week that you can no longer find, then you
simply turn back the clock and retrieve it. It's a brilliant
feature, and not just for lost files; you can retrieve
earlier versions of files that have changed, too. The
latest Time Machine is the best yet, and you no longer
need to have a second disk drive in order to use it.

“You don't need 3
second disk drive to
use Time Machine”

Browse the disk

@

work

T??

O =

Bluatooth Sharing

= © ©

& Time Startup Tima Accessibility
Disk Machine
~ (A Ll
The timeline

fime Machine opens the current Finder

window or the desktop. You can then
navigate the disk, and change to any
folder using the usual Finder features.
The Sidebar shows Favourite locations

On the right is a timeline that stretches
from the present back to the distant past.
Dates where backups were made to the
Mac’s disk are in grey, and purple shows
backups to a USB disk drive




TilTIE MaChine Find and restore lost files

LaCin

354 GB of 250 GB avaiatio
Cigest bacwup: haone
Latest Dackup: Mons

Time Machine

Salect Disk... Piet ERAcKUR! Winen dhisk B conmascied

Tome Maching keops:

= Houry DRckDS for the el 24 howrs
+ Daily backups for the past mosth
& Wasicly backuna bor Al previous moentha

Thie oidesat bacioups & doelobed when yowr disk becomass Tull.

orr L) on

El Show Time Maching in many bar

01: Turn it on

Go to System Preferences on the Apple menu, and click Tire Machine' There is

a useful option to show the status in the menu.
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Enter Time Machine

03: Enter Time Machine

Once set up, you won't notice it. Click the menu bar icon, and there are options
to start a backup immediately, or enter Time Machine. Let's enter it.
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05: Select and restore

A file can be selected in the Finder window, but there are more options
available by Ctrl/right-clicking. Alternatively, click on Restore.
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02: Choose a disiﬁ

Click the "Select Disk’ button, and the disk drives connected to the Mac are
displayed. Time Machine works best if you select a large empty disk.

04: Browse the backups

A stack of Finder windows are displayed, and you can navigate the disk to any
folder. Move back in time using the arrows or timeline on the right.
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06: Save the file

Time Machine asks you to select a folder in which to put the file. It can be put
back in the folder it went missing from, or stored in a different one.
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Getting started

Use Disk Utili

Checking and improving the health of your hard drive is easier than
you think. With a couple of clicks you can set your mind at rest...

-

: “) It can become pretty scary when your application called Disk Utility, users can very easily

ﬂ, Mac starts to show tell-tale signs of check disks, repair damage and even erase free
wear and tear. As well built as they are, space to keep the volume healthy and happy. If

like everything else on the planet, they are used on a regular basis you can guite easily keep

susceptible to the pitfalls of ageing. Prolonged use your hard drive from slowing down and retain that

and writing and rewriting of data can cause things great snappy feeling you had when you first bought

to slow down, and in some cases cause errors. your Mac, You will also, with regular use, be able to
Luckily, Apple has made it very easy for you to spot any serious problems before they cause any
check on the health of your hard drive. Using an devastating loss of data.

Get a snappier drive with Disk Utility

Clearing free space on your drive can have a
marked improvement on performance

Tabitup

Clicking here will take you to the e
Erase section. Be extra careful before -

vou click anything here as you could
wipe important files
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to check the health
of your hard drive and repair it

“Luckily, Apple nas
made it easy to
check on the health
of your hard drive”

Erase options

Here you can choose the level of erasing you wish to
use. The 35 step is the best, but it will take an incredibly
long time. Pick whichever method suits you
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Erase Free Space

[his will only erase space that
isn't being actively used; so

if you've done some house
keeping and cleared a lot of files
out then this is a good way to
get some performance back as
a result of the change
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SERIOUS PROBLEMS

Disk Utility may not be able to
repair serious problems, but it will
definitely let you know if it spots
anything untoward, Any serious

problems will be highlighted in
red and often there will be advice
on the best course of action.

In serious cases, this will be to
contact Apple or a reseller.
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DiSk Utility Use Disk Utility to repair your hard drive
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01: Load it

You can find Disk Utility by going to your Applications folder. Once you

have navigated here, choose the Utilities folder and double-click on the

Disk Utility app. Alternatively, use Launchpad from your Dock and navigate to
the folder called 'Other’. You will find Disk Utility in here,
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03: Verify Permissions

Click the Verify Permissions button and the utility will begin checking the

disk for any errors. Depending on the size of the drive and the speed of your
processor, this could take some time so why not go and make yourself a cup of
tea while you wait?
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02: Pick a drive

The utility will work on any connected drive, including your startup disk.
These will be shown down the left hand side. You just need to remember
to click on the disk that you want to check before you start carrying out any
specific actions.
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04: Repair Permissions

When the disk has been verified you should get a report detailing what it has
found, If there are any warnings in there then you will need to click the Repair
Permissions button. Again, this could take a while, so be patient. After that
you're all done.

Mac for Beginners 77



IGetting started

Use AirDrop to share files

Get to know AirDrop, one of macOS's most
useful features for transferring files fast

Transferring files had, for a long time, the shape of a radar mast. Clicking this icon will

been an incredibly tedious process. start AirDrop, and any other users who have also

Before Wi-Fi was commonplace, users opened the AirDrop section will appear in the
were forced to save their files to floppy disks and finder window. From here, you can drag and drop
LSE Flash drives, unplug them, plug into another documents, images, movies and more onto the
device, then drag the files onto their desktops. Even icon and send them through the air quickly and
now, for many users the process involves creating simply in seconds.

an email and sending it to themselves, a process " :
that not only takes time, but also inbox space. D d d ]C =
Since Lion, there's been a much simpler solution ra g a n rop | eS '@g@
to this problem, and it's called AirDrop. When you d d h e
open up the finder, you'll notice that there are a a n Se n t e W .

number of icons in the sidebar on the left hand h h h - f}
side. One of these is the AirDrop icon, which is in t rOug J[ e alr

The AirDrop interface Mult-user Getinfo

If there are a number of computers in If you Crrl/right-click and select ‘Get
Find your way around the key the area with a recent edition of masOS Info, this window will open. For most
pa rts D,f th i5 Shari ng Service installed, you will be able to view them applications there is a lot of information,

all at once in the same window and drop but for AirDrop, all you can really do is

wour files into any one of them instantly copy the icon from the top left corner

WIRELESS NETWORK

Unlike applications like Dropbox
and DropCopy, you don't actually
need to be connected to a network
to use AirDrop and share your files.
When you open AirDrop, your
computer will start sending out

a wireless signal, and when other
users do the same, the machines
can detect each other. Even if there
is no wireless network around you,
you can still send files, as your Mac
will create a temporary, secure
netwaork specifically for the transfer,

Scanning
The spinning radar icon shows

that AirDrop is constantly scanning
for other users while this window

whiw L3

is open. They will need to open . bae View Citions
the AirDrop tab as well if you want : o A S S o s, S Tor ¥ o A 1 W P
to find them locally

Limited options

Again, because AirDrop is a
system-level application, you

are severely limited by the view
options, For most folders you
could change almost everything,
bt this is strictly limited
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Al rD rOp Transfer your files wirelessly

eoe® & ryan
< Bl=cw m- ¢ % -
| Back Wi Amangs Eham  Edit Tags Action
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B Oropbor 4
@ AirDrop Applications
71 Desktop
¥ Applications
e o o
[ m H . Documents Downloads
Iﬂ Documents
© Downloads i i o 4
All My Files Movies Music
™y iChoud Drive
“. Library T — S—

01: Find AirDrop

All you need to do to activate the system is open a
Finder window and look in the sidebar, AirDrop is
the circular icon with radio mast.

04: View options

It you Ctrl-click in AirDrop and choose "Show View
Options, you'll see a grey Menu. AirDrop is a system
app, so you can't change view options.

0 AirCinon
“wa Waiting for “Louise's MacBook Alr™ 1o accapl...

e 1)

o
Lerarge -:.n.l.'j i
1 T et

Louses... Book Ar

©

AlfDirap bals wouw share inakondty with peopia nes by
o Shaaend 'With SOmeons uaing a Mac, asi thom 1o 0o o AlrDrog in the Gnoet

07: Receiving the file

On the other machine, a prompt will let you know
someone is transferring a file. You have to choose
an option before the transfer can begin.

6

ArDrop lets vou share instantly with peopde neéarby.
To share with someone using a Mac, ask them to go to AlrDvop in the Finder.

02: Radar on

When you click the AirDrop icon, it will display a
radar-style display with a line rotating around the
main AirDrop icon.

0 AirDrag
i E ) «
wrangs BRam  Edin Toge Acton Search

Registratisn Form.pdd

®

AirDrap ks you shdrs instanty with paGpie nadrky
Ta aham with someors uping @ Mac, dak tham to go bo AlrDrap 0 Bhe Fader

05: AirDrop

When you have found the file you want to transfer,
simply drag and drop it onto the icon of the person
who has connected to you.

% AirDrop
) Q Sear
Shary Edit Tega Action Soarch

Louisa's... Book Ak

@)
08: Awaiting transfer

As the file is transferring, you will see a progress bar
that circles the icon of the sender. It will meet itself
at the top when the transfer is complete.

Loulsa’s. . Book Alr

®)

AlrDrop lats you shans instantly with peopla naarby.
To share with someons using a Mag, ask them to go to AirDrog in the Finder.

03: View other users

When another masOS user clicks on AirDrop, they
will become visible in your AirDrop window. You
can have more than two people at once,

Louisa’s... Book Adr

®)

iirDrop bets wou share instantly with pecple nearby.
To share with someong ualng a Mac, ask them 1o go to Alrrop in the Fender,

06: Prompted

Before it is sent, you'll be prompted to ensure this
is the file you want to send. It will give you the full
rundown of what you are transferring, and where.

@ 08 F AsDrop Inko
@ o
| ¥ Geraenl

Kind- &sliop

Deople measby.
g0 bo ArDrop in the Finde:.

09: Find out more

If you want the AirDrop icon, click in the window
and choose ‘Get Info' to see this menu. Nothing can
be changed about the file, as it's locked.
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Getting started

Setup

and explore
iCloud Drive

Access your files instantly — anywhere and at any time — with one of your Mac's coolest features

iDisk was Apple's previous virtual disk

drive, but with iOS 8 came a reinvention

and a new name - iCloud Drive - and a
whole host of new features to boot. Not only does
iCloud Drive enable you to store any type of file up
to 15GB in size, it syncs the documents created in
your favourite Apple apps such as Pages and
Keynote so they're ready for editing on all of your
other Apple devices - just like the Documents in
the Cloud functionality.

In this tutorial we're going to walk you through
the process of getting iCloud Drive set up and
ready to use ([don't worry, it's really easy). All you
need to do is upgrade your Mac's OS5 to macO5
Sierra or High Sierra, which is available from the Mac
App Store, totally free of charge.

“iCloud Drive syncs
your favourite apps”

|CIOUd Dnve Set up and use Apple's newest storage solution

01: Launch iCloud Preferences
Click the Apple logo (top-left). Select System
Preferences from the drop-down menu, then click

the iCloud icon.

Choud

ok i By
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04: Documents in the Cloud
Click Options. Ensure that the apps you were using
previously with Documents in the Cloud are ticked.
This will move your documents over to iCloud Drive.
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02: Sign in to iCloud

To sign in to iCloud, enter your credentials. If you are
signed in, ensure there is a tick in the box next to
the iCloud Drive option.

05: Access iCloud Drive

Access by l[aunching Finder and selecting iCloud
Drive. Create new folders or drag documents from
your Mac's hard drive to iCloud for instant access.

E | ke _.;.I' % " e .- e '.“- l_‘_._' R 4 <
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03: Activate iCloud Drive

Place a tick inside the iCloud Drive box. This will
activate iCloud Drive for your iCloud account and
move existing iCloud documents to the service.

I = “ o o D
(34 I = A =
a5 e

sy

06: Create new folders

To create a new folder, right-click in iCloud Drive and
select New Folder from the drop-down. Or, click on
the cog icon and choose New Folder.



Create a document

A quick overview of creating and saving
straight to iCloud Drive

View document in iCloud Set save location

To confirrn that your document is being saved in Select iCloud Drive from the left-hand column;

iCloud, select the File menu and hold down the alternatively, choose it from the Location
Launch Pages, Crd key. Click on the Save As option - the save drop-down menu in the top centre of the
Numbers or Keynote location should be listed as iCloud Drive interface, This will be the save location for your
Launch the Pages, Numbers new docurment
or Keynote app from your

Applications folder in Finder. If
you don't have them installed
on your Mac already, you can
purchase or re-download
themn from the Mac App Store

Ermule Popum F o ack

Sendew

ek YRR
okl Tt

ICLOUD DRIVE SYSTEM
REQUIREMENTS

iCloud Drive is only available on
Macs running OS X Yosemite or
higher and iOS devices running iOS
8 or later. If your Mac runs Yosemite
but your devices run iO5S 7 or earlier,

Create new document Ml W L TSR o N your documents will nat sync to all
To create the document, click the New o . devices. The most recent macO5 is

Docurmnent button in the bottom- i : available for free from the Mac App
left cormer of the interface, Choose a . Store, while 105 is free to download

template for your new document and _ on your iDevice.
pegin working on it in the app as you
would usually

07: Add items to iCloud 08: Add people 09: Share iCloud Drive files

To add items, drag and drop files from your Mac to You can share iWork files for others to editin You can share iCloud files and folders by clicking
the folder and they will sync to iCloud Drive — there collaboration. Click on the share button then Add the item and selecting the Share icon. Choose your
are no restrictions on the file types you can add. Peaple and select your share method. sharing method, then enter the recipient’s details.
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IGetting started

Get to grips with Family Sh

Get to know AirDrop, one of macOS's most
useful features for transferring files fast

Does your household have more than

% one Mac? One for you, of course, but also

' others for partners, children, grandfathers
and parents?

With Apple’s Family Sharing option that was
integrated into OS5 X Yosemite, you are able to
link these accounts to one credit or debit card. So
when an app is bought on one Mac, it will become
available on another and the same goes for iTunes
and iBooks purchases. That way, individual Family
members don't have to splash cut more than once.

You can add up to five family members to your
Family Sharing account. Children under 13 can have
their own Apple 1Ds and they can make purchases

Set up sharing for a child

Have a child under 13? They can
have Apple IDs too

Add the Date of Birth

The Date of Birth is the most
important part of the process
because it will determine the
services that will available to the
child and it will also help from
retrieving forgotten passwords

WHICH APPS CAN

YOU SHARE?

Not all apps can be shared but
you can clearly see which can
and cannot by heading over to

the Mac Store and looking under
the Information section on the
description page of each app. Ifit
says no next to Family Sharing, the
app cannot be shared.

Adding a child

Without an Apple 1D, a child will
be unable to participate in Family
Sharing. You will need to dlick this
%+ icon and then select ‘Create an
Apple ID for a child who doesn’t
have an account’
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using it as long as they have your approval (or not
— you can decide on this). You can also allow other
adults to grant permission to children within the
Family group.

What's more, all members have the option of
instantly discovering each ather's location. Of
course, Family Sharing doesn't purely have to be
about real-life families. You could easily set up work
or hobby families too.

‘Link your accounts
to one credit card”

Create an Apple ID

A child can have his or her own Apple ID
and this will be usable across Macs and
I0S devices, As part of the process, you will
be asked to use the CVV number on your
credit card to grant parental consent

Enter the child's information

Birthday: = Day [ Month B v H

Your child's birthday will be used 1o determing appropriaia
services and retrieve a longotten passwond

Bicloud.com

Password must bo af lonst § charsoters and include o numibe,
an uppercase lefter, and a bwercase efter

Share your child's location with your Family

Your chitd's location can e shared if Find My bac is burmed
of. O an {05 device lpcation can be shaned using Mesas)es
and Find My Friends. This setling can be changed ol &y time.
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Sharing your child’s location
Want to keep an eye on your child when
they are out and about? By sharing the
child’s location with your Family, their
location can be obtained via Messages
and Find My Friends




Family Sharing Setting up Family Sharing

Family Sharing
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01: Open System Preferences

First of all, go to System Preferences and click on the
icon for iCloud. To the left of the iCloud window is
an option which states Set Up Family. Click on this,
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Family Sharing

04: Share your location

A benefit of Family Sharing is allowing other Family
members to see your location via Messages and
Find My Friends. Just click Share your location.
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07: Confirm the account

Purchases made by the new Family member will be
shareable with other members, The new member
can choose whether to share locations or not, too.
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02: Choose an organiser

One person can become the Family organiser. If you
want to be the organiser, your credit or debit card
will be used by default and you can invite others.
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05: Add Family members

Now you are set up as the Organiser of your family,
you can invite up to five people. To do this, click Add
Family Member or select the +' icon.

Fumily Doichases: anna

ey S Tl ROl B0 Pl T
PCTLSES b Ml BOSSGED Wl N AT TR

e i

ke Bnrm 1o s pour lacerion
- e o i rywwn iy Wy
ww

08: Toggle the settings

You can make more amends, like whether individual
members can view your location and setting
people up with parent and/or guardian status.
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03: Select an account

Verify here to share purchases made with your
Apple ID with your Family or select Use a Different
Account. Confirm that your payment card is correct.

‘ O dirdd m Family merekar
& Critwr @ lamity mreebar's -ara o omai acdrasn
L]

Cesaim an Appds |0 for & chid wha dossn'i hees an acooani.

Caros

igsily B Pep pedpia to e oS oholoa.
T L]

Aaiky Family Mieminer

06: Input a member’s details

Enter a family member's name or email or create a
new Apple ID for them. The member can enter their
password immediately or receive an invitation.
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09: Settings for children

If you have a child under 13, you can ensure that
their purchases in iTunes, iBooks and the App Store
need your approval. Tick Ask to Buy on their profile,
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IThe next step

Discover how to use the essential Apple applications
to enhance your lifestyle and boost productivity

Set up email on your Mac
Get started with the Mail app

New features in Mail
What's new in Mail in High Sierra?

Browse the internet
Surf the web in style with Safari

Configure websites in
Safari 11

How to use this new feature

Start using Apple Maps
Explare the world and get from Ato B

Get to know the Mac App Store

Delete and reinstall apps on
your Mac

Easily remove apps from your computer

Clean your Mac and get
more space
Use a free app to find and delete files

Get started with iTunes
Discover Apple's media player

Organise your iTunes

music library

Discover how to keep your library well
organised when importing CDs

Download music from the
I Tunes store

Rent and buy movies on iTunes
Download films and TV programmes

Navigate iBooks
Read and build up your digital library

Get organised with Calendar
Structure your life with this handy togl

Add analarmto a
Calendar event

Add an alert to a planned event

Master Messages on Mac
Get the most from High Sierra's app

Discover FaceTime for Mac

Access and download exciting apps : s
94app Set up video calls with friends and contacts

Purchase songs and albums with ease

Download apps from the
Mac Store
Explore your hub for new software

Set up and use Apple Music

Stream from a vast music library

' -H U i
16 June 2016 o e
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Tharsciry =
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"‘Apple’s built-in software
s second to none. Youlll
be amazed at what you
can achieve on your Mac
without having to install
anything extra'

116
Discover
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Get to know
the App

Store
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with Maps

Browse in
Safari
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lThe next step

Set up email on your Mac

Follow these steps to get started and send and receive your emails with ease

using the Mail app on the Mac

It's easy to averlook Mail on the Mac

when we're accustomed to browsing

emails on the web. And with social
networking becoming ever more popular, many
people will communicate solely through the
likes of Facebook and Twitter. However, if we're lucky
enough to own an iMac or MacBoock, we really
should make use of our sophisticated machines and
allow them to do what they do best; make life a
whole lot easier! Mail on the Mac is a smart way to
manage your emails as you work and play.

Mall Get your mail up and running

01: Run Mail

Click on the Mail icon in your Dock to kick it into
motion. After a quick bounce, you should be
prompted by a Welcome to Mail pop-up window.

04: Create and enjoy

Click on Create in the Mail Setup Assistant and be
taken to your new Mail Inbox. You'll have the same
mailbaxes as in your web browsing version.
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Now, the beauty of your Mac is of course
its simplicity. But when that simplicity is a new
application staring at you expectantly, it can feel
a little intimidating. Pushing buttons at random in
the hope you will eventually work it out is never
going to be the best approach, so with this helpful
little guide to setting up Mail an the Mac, we'll have
you sending and receiving emails to and from your
favourite people in no time, We'll also show you
how to customise your messages to give them that
personal feel, and explain how to attach documents
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02: Mail’s Setup Assistant

This wizard can configure accounts that use the
most popular email services, including Gmail and
Yahoo. Choose your favourite.

05: Compose a message

Hit New Message to summon an email draft. Enter
the address of your recipient in the To field and fill in
your Subject and message accordingly.

and keep the Mail interface clean and tidy so you
know where all your messages are.

"Mail on the Mac
S a smart way to
manage your emails

as you work and play”
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03: Enter your details
Enter the full name, email address and password for

your existing email account the same as you would
in the browser of your service provider.

06: Attach afile

To send your recipient a file, click on Attach and pick
ane. Set up iCloud on your Mac and you can attach
files up to 5GB thanks to the MailDrop feature.



Master Mail on your Mac

Everything you need to be able to send
and receive emails

Happiness is shortcuts

As Mac users, we love our shortcuts. Ctrl and
click on the emails in your Inbox to bring up

various time-saving options: Reply, Forward,

Mark As Unread, Delete, and Mowe To folders
of your choice

The Mail toolbar

You'll find handy buttons for all the most-
used functions right at the top of your Mail
interface. Delete, send mail to the Junk
folder, Reply, Forward and create New
Messages to your heart's content
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ADD NOTES WITH MARKUP

If you are sending a photo or PDF
document to someone through Mail,

you can use Markup to add notes and
annotations to them. Click the arrow

in the top-right of the file and choose
Markup. You can then draw on the photo
or document, make notes, and even add
your signature to a letter or other file type.

Search and Top Hits

Use the Search field in the top right
10 track messages with spedific words
in the Entire Message, From, To or

= Subject fields. The most relevant
results will appear in the Top Hits
section, which can be found at the
top of the Inbox

07: Add some style 08: Save or send

If you're feeling adventurous, you can change your If you're not yet ready to send, click Save As Draft
fonts and add colour by clicking on the appropriate and it'll wait in your Drafts folder. When happy, hit
Fonts and Colors buttons. Send to start your message on its journey.

1I®0 TRC

09: You've got mail

Click Get Mail in the top left to download emails.
Unread messages are highlighted by blue dots — the
icon in your dock also shows new messages.
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IThe next step

New features in Mail

Discover and master the great new features in the Mail app for macOS High Sierra

L LR e OFgea il 32 T 1O B} ; i 5
When macOS High Sierra was released, Apple made a [y vt D rn_wmr v o
_ few tweaks to the Mail app. It was a great email client g e o s
Y already, so there aren't any major changes. However, there auw | © T 510 B oo
" are several improvements to existing features that make ey T Moo e
dealing with email messages easier. The use of trackpad e @] @S- e i e e e
gestures is handy, for example, and we show you how to use this - — :”'" _ ﬂ?":'m-

and configure it. There have been some useful changes to the search
facility, which now makes it easier to find messages you are locking
for - a bit of Al (artificial intelligence) puts the most likely results

W xS oo S

TS

T by

first, for example. The content of email messages can also be more
brightly coloured now that the background of text can be set,

Read Mall Configure Mail for you

il |

01: Top hits

Finding emails is now easier. Enter a search term and
in the results is a Top Hits' section. By analysing the
content of your emails, Mail shows what it thinks you
are looking for first.
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04: Enable split view

Another tweak to Mail is split view, which divides
full-screen view to show Mail and messages. Go to
Mail=Preferences and tick the split view option on
the General tab.
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02 See unread emails

Click the tiny icon in the header above the main
results and the messages are filtered to show just
the unread ones. There is also an option to sort the
results by date.
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05: Customise spaces

This step may be necessary on some Macs - it was
on ours, Open Mission Control in Systemn Preferences
and tick 'Displays have separate Spaces. Weird, but
essential.
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03: Filter search results

Click the ‘Unread’ link and a number of filters are
displayed. For example, results can be filtered by
email account, unread, flagged, only from VIPs and
only with attachments.
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06: Use spilit view

Click the green window button to go full-screen.
Double-click an email to open it or create a new
message and it opens on the right. Click and drag
the vertical divider.
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Mall S hew features Colour your emails and search better Colour your messages

There is a new option to set the
backaground colour of text when writing
emails. Select some text, then click this

colour chip in the toolbar to show the
& = palette and dlicka colour

Top Hits

When a search is performed, a small
number of iterns appear in a Top Hits
section here, They are what Mail thinks are
the messages you are most likely looking
for, based on your previous interactions

Message Format ‘Window Help
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i 250 T—— v g Click this one with the line through to

remove the background colour

KNOWLEDGE BASE

Clearing your email inbox is a
liberating experience and it can be
done with gestures. As shown in
the tutorial and annotated image,
swiping over a message will delete
. it or archive it depending on the
Swipe away Pre;lleregcﬂ EF."I“E“?; #here :u .
: L archived emails go? The archive is

¥t : : el

ou can clean your inbox by swiping simply a folder in the Mail sidebar.

left over an ernail, and it can then be e —————— ke e
either deleted or archived in one gesture, T | i e | e | s SRR | e S . S ; Sk Tt b aurginbzx bt
Choose which action you want to perform | et e ' S o = : o :

7 that you don't want to delete,

in Mail Preferences I

Use trackpad | Sesmeml | S

i o il N b - W Do b dend i B coreey devT

; . S| BEL e - e | ME
The Mail app responds to trackpad gestures - R o e | T T T OIEUELT e
that can make dealing with your emails T T Se— q Sen R |
much faster. A two-finger swipe up or down :

the trackpad is a standard gesture, However,

you may not have realised thatyou canalso  01: Move messages 02: Read/unread messages

swipe left and right with two fingers. This Use one finger on the trackpad to move the Position the mouse over an email and then
gesture, borrowed from the iPhone, canbe  mouse pointer and position it over an email swipe right to reveal a blue icon. Tap on this to
customised by going to Mail>Preferences>  preview. Then hold two fingers down and swipe toggle between read and unread status. Swipe
Viewing>Discard messages into. The options left to reveal a Trash icon (You can switch this to halfway and tap or swipe all the way to apply
are either Trash or Archive. Archive in Preferences). the action immediately.

o — . B ey Py
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IThe next step

Browse the internet

Apple’s Safari web browser makes it easy to surf the web

Safari is Apple’'s own web browser and Perhaps unsurprisingly it is the most Mac-like windows and warnings you get when visiting a
0 it's tightly integrated into the operating of any browser — it's sleek, polished and easy to website that might be fraudulent. All in all, you'll
system. Although for most of its previous use. Most of its options are accessed through the discover it's a great way to safely browse the web.
life it was much more stripped down than other Preferences section and it is here that you can, for
browsers, largely for the sake of speed, it has more example, change the default search engine and the 1 S ]( : ‘ k d
recently taken on more features such as Extensions location for downloaded files. a a rl |S S ee a n

that will enable you to
range of things you ca

Pinned sites
You can now pin your
favourite sites to your
toolbar. They will refresh
in the background 1o
always be available with

the most current content

Sidebar

By toggling on the
Sidebar you can view
bookmarks, Reading
List items and see

all the shared links
from your various
social networks

customise it, in addition to a There are also some great security applications, I
n change in its Preferences. such as the ability to block the annoying pop-up E‘a Sy tO U Se
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Naot every website supports
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icon will appear. Click here
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Sort extensions

The Extensions tab lets
you switch Extensions

on and off as well as
changing their behaviour
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e R ]

Extensions are small snippets of code  all, Extensions are digitally signed, If you head to extensions.apple.

P i Pty that use HTMLS, C553 and JavaScript which means you can't accidentally com you will find a list of all the

technologies to incorporate quick install malicious ones that might Extensions available. Some of the
links to other web services or tools do your Mac harm. They are also most popular include Twitter and
(such as ad blocking) into the sandboxed, which means that even eBay, the ability to add items to
browser. The idea is that you only if one crashes it won't take Safari an Amazon wishlist and the all-
download and install the ones you or mac 05 down with it. They even important ad blocker that gets rid of
want and that suit your needs. There install easily without the need foryou  embedded ads. There are some really
are none installed by default. Best of to restart your Mac, useful ones here,

Cepm v i piace dgilior iy oL




Key features

What does Safari do
that’s really cool?

Stop Intelligent Tracking

Advertisers can track the websites you

visit and searches you make and use this
information to make and serve up tailored
adverts that are supposed to appeal to you.
You might see one item when viewing

an online store and then notice you are
followed around by adverts for that product
when you're visiting other websites. You can
now block this behaviour in Safari by going
to Preferences>Privacy and enabling the
option titled 'Prevent cross-site tracking.”
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When visiting thes wolbite:
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Always use Reader View

Reader View is not compatible with all websites, but it greatly enhances those
that do allow it. Reader View shows the page with no adverts, navigation or
other intrusive links - allowing you to focus only on reading the text. If Reader
View is supported, an icon will appear to the left of the web address bar. In the
Settings menu you can choose to automatically use Reader View whenever you
load a webpage that supports the feature,

'~.. ;

Privacy

Qw O @ F &

General Tabs AutoFd Passwords Search Security Privacy Webshes Cxiensons Advanced

Webaite tracking: Prieven| crods-sie tradking
Ask wabsites not 1o track ma

Cookses and website dala: Biock all cookes

Manage Website Data.

e

No Auto-play

Many blogs and news sites include videos that will automatically play when

the webpage loads. This can be a pain, especially if you are listening to music
through your Mac. If a website does have this on its pages, dlick on 'Safari' in the
top-left corner and then select Settings for This Website, There will be an option

for Auto-Play. Here you can select whether you stop all, allow all or only allow
media that has no sound to play automatically.
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Tailor websites to you

You can tweak the browsing experience on each website by going to the
Settings for This Website menu under the Safari tab. The page zoom, auto-play,
camera, microphone and location settings can be tweaked here as well as
enabling content blockers and Reader View. These settings will only apply to
the website you are currently on, but will be saved. This means you can apply
different settings to different websites.
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lThe next step

Configure websites in Safari 11

There is a new Safari browser with an exciting feature. Here's how to use it...

B Newl Ny EF er Heaep Bochowis

Safari 11 is here, and if you have upgraded to macOS
High Sierra you will have it by default; but even if you
have not yet upgraded, with automatic updates on, it will

be installed in macQS Sierra too. It has a fantastic new feature thar

not just globally, but individually. Using the new configuration
settings in Safari you can tell it to always use Reader mode for that
one website that always takes too long to load images and video, or
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How to configure website settings vour web, your way
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01: New menu
Go to any website, such as Wikipedia.org, and

there is now a new item on the Safari menu
called 'Settings for This Website' It enables you to
configure this website,

s Develop Window Help Debug

& wawowikipedia,org

Wihen visiting this website:
G0

Use Read abe
To%
Enableca pgu fs
100%
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04: Set the zoom

The other items do not look like they are clickable,
but they are. Click the Page Zoom setting for
example, and select the zoom from the menu of
options that is displayed.
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{ Help Debug

= ALY

Copy ;
Paste and Search

Sattings for This Website...

WIKIPEDIA ™

The Free Encyclopedia
| Espanol
clas 1 352 000+ articulos
= Deutsch
-‘f L 2 068 000+ Arfikg!

02 Setl:lng5 shortcut

There is a quick way to access the settings for a
website and that is by Ctri+clicking the URL in the
address box. Select the item on the menu, "Settings
for This Website'

Develop Window Help Debug O
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05: Block unwanted media

Audio and video on web pages can be irritating
and are often nothing more than advertising. Click
the Auto-Play setting in the panel and set the site to
‘Never Auto-Play’,
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03: Tick the options

A panel is displayed below the site URL and the
contents depends on the site, Use the checkboxes
at the top to choose whether to use Reader mode
and content blockers.
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06: Set permissions

Websites may want to access hardware like the
camera and microphone, but you have to wonder
why. Set them to 'Deny’. Location is best set to ‘Ask’
as it may be useful.



Safari S New WEbSiteS tab Check out the new settings in Safari

The Websites tab

This tab is completely new in Safari 11 in
macO5 Sierra and High Sierra. It enables
you to configure the default settings for all
websites and sites so you're in control of

Change the settings

There are two parts to the sites list and
the top part shows the currently open
tabs. Select a category on the left, then
choose the settings you want for each of

your browsing experience the websites

Default settings
When visiting new websites not yet
configured, what default settings
are applied? Down in the bottom-
right corner is the default applied
when visiting other websites. Set it

| as you prefer

Site settings
Select each section in turn and
if a website has been configured

differently to the default setting, it
will appear in the list on the right.
You can then change the setting |
or reset it ‘

CONTENT BLOCKING

The content blockers feature in
Safari is controversial because it can
block adverts to make web pages
less irritating. Website owners don't
like it because It reduces their
income, and adverts pay for many
sites. Safari's content blockers do
indeed block some adverts, but not
all of them. You will still see some
ads and it appears to only block
the worst.

Websites
in Safari

Go to the Safari menu and select
Preferences. Then select the Websites tab.
This is new in Safari 11 and it enables you
to see all the sites you have configured and
their settings. It shows the tabs that are
open too. Using the controls in Preferences
you can reset options you have changed
back to the default, select new options, and
set the default action when new websites
are visited. This is a great new feature.

01: Website settings

Go to Websites in Safari Preferences and there is
a list of categories from Reader to Notifications.
Select one of the items, such as ‘Microphone’,
to see the websites that have been configured.
Change the setting on the right.

02: Default setting

Select any of the items on the left, such as
‘Auto-Play’, and down in the bottom-right
corner is 'When visiting other websites'. You
don’t have to configure every site individually
and this setting applies to all websites.
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IThe next step

Start using Apple Maps

Explore the world, get directions, find attractions, businesses and more

===_ Maps has been on iOS devices for some
-?ET_\I time and now it's available on Macs too.
“.L iPhone and iPad users will find many
familiar features, but there are also new ones — and
there's lots to discover in this fantastic app. From a
large map of the country, you can smoothly zoom
in right to your street, or whichever location you are
interested in. There are three different views to
select from and you can opt to view a standard
map, a satellite photo image or a hybrid of the two.

W Maps File Eor View Window Halp

All three are useful and switching from one to the
other is very easy and intuitive.

You can find businesses around you or look
up the attractions at a place you plan to visit. The
inforrmation, reviews and collections of photos
provided are very useful. If you aren't sure how to
get somewhere, Maps can display a list of directions
for travel by car or walking. It even displays traffic
information and roadworks. There are also stunning
3D views, which are great for exploring cities.

"There are also
stunning 3D views,
which are great for

exploring cities”
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Shortcuts
and gestures

Learn all the tips to
better control Maps
and get more out of
this powerful app
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Maps will put pins on
' the map. Click one for
| more information

it's true that Maps’ basic features are
easy to use, but there are advanced
features that aren't quite so obvious.
For example, Cmd+L positions the
map over your current location and
zooms in. You can move around
either by clicking and dragqging with
the mouse or using two fingers on
the trackpad. Although thereis a

hold the mouse over the compass as
you push up and down. This tilts the
map and, as it flattens, real buildings
are displayed in 3D. Many large
cities and attractions have 3D views,
meaning you can explore London,
Paris, New York and other places.
Pull down with two fingers on the
trackpad to fly over a city in 3D.

zoom infout control, you can also
double-click the mouse to zoom in
and Opt-double-click to zoom out.
Pinch and spread on a trackpad
works too. In fact, there are other
useful trackpad features such as using
two fingers to rotate the view.

Zoom right in using satellite view,
click the 3D button, then click and
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Key features

Use 3D views, find
businesses, bookmark
places and more

Explorein 3D

The 3D views are the most entertaining
features of the Maps app, offering a way to
explore the world from your desk. Go to 5an
Francisco and see the Golden Gate Bridge,
look around the London Eye and Tower
Bridge, fly low over Manhattan in New York,
explore the skyscrapers from every angle
and so on. You'll see world-famous buildings
and attractions as if you were really there.
There are some amazing views, so enter your
destination in the Search box,
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Bookmark favourite locations

Places of interest or places you regularly visit can be bookmarked, which enables
you to quickly return to a location without having to search for it in Maps. There
are a couple of ways to add a bookmark. For instance, after searching for some
place, click the pin in the map and then click the Add Bookmark button. You
can also place a pin in anywhere using the Drop Pin option on the View menu.
Simply click this to add a bookmark.

£

Find local businesses

The Search box in the top middle of the window isn't just for finding cities and
streets, it can also track down businesses such as restaurants, plumbers, garages
and so on. If you fancy a pizza, for example, just enter ‘pizza’ into the Search box
and pins are automatically placed on the map to show the locations. Clicking

a pin displays maore information, such as the address and phone number,
Sometimes there are reviews and you can even get directions.
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Build up your contacts

Maps is integrated into other apps and when viewing an address in an email, for
example, you can click it to open Maps and view the location. When using Maps
and viewing a business or attraction, you can click Add to Contacts to store the
name, phone number and address. It's useful to build up your contacts with
useful local businesses, particularly when you are planning a trip. You might not
have your Mac, but the information is synced to iPhones and iPads.
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IThe next step

Get to know the Mac App Store

The Mac App Store guarantees easy access to a wide range of free and
paid apps. Find out what it's all about right here...

folder, and can be accessed via Launchpad when
required. You can even search for apps by title,
developer/publisher, category or description. All
apps are organised into convenient categories and
this makes the process of navigating the store an
effortless experience. Here we show you how to
explore the virtual aisles. ..

apps is a breeze. This is largely because the store
has adopted a very similar look, feel and process
to shopping to that used by the iTunes App Store.
When you want to buy an app, simply enter your
iTunes ID and password, and it's purchased. It
really is as simple as that. The app is automatically
downloaded and installed in the Applications

0S X 10.6.6 and is home to a diverse
range of apps aimed at enhancing the
functionality of a Mac computer. As a bonus, the
majority of apps are either reasonably priced or free.
As we have come to expect from Apple, the
interface is intuitive, and finding and acquiring

@ The Mac App Store first appeared in Mac

Purchased

See all the apps that
you've downloaded,
and determine which
are currently relevant

Updates

App updates can

be accessed and
downloaded by clicking
the 'Updates’ button
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Categories
Apps are organised
into 21 categories.
Finding those you
need is effortless
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Featured - il =
Browse new and + . ,
ﬂDtEWDrTh}'I -ap p‘_‘-;_, Dr r e | rl::r_-....; : R T m : : ':!:': TaRE .I-H
vievy the staff favourites - an ! oo

Top Charts

The top apps lists

divide into 'Paid, 'Free'
and more

Log into
the Mac
App Store

Start downloading
apps immediately
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If you're new to the Mac App Store, there
are two ways to launch the service; either
click the App Store icon in the Dock, or
click the Apple menu and select ‘App
Store’, Do this, and you are free to browse
the store using the 'Featured’, 'Categories’
or Top Charts’ windows.

If you've ever used the iTunes App Store
then you'll already have an Apple 1D so
click 'Sign In’ from the 'Quick Links’ tab to
the right of the window, or Store=5ign In
from the Mac App Store menu. When the

'Sign In’ screen appears, all you have to do
is enter your Apple ID and password, and
click "Sign In’.

If you don't have an Apple 1D, click
the 'Create Apple ID' button on the
'Sign In’ screen, and you'll see a window
welcoming you to the App Store.
Click 'Continue’, agree to the terms
and conditions and follow the online
instructions to create an Apple ID. Once
you've completed the process, you can
start downloading apps immediately,




Key features

How to navigate the
Mac App Store
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Featured :
Take a look at the Mac App Store's main L T E—
storefront window. It's well organised, and : ﬁ cmn e
you'll see five buttons at the top. Select —— Ppaan T, T
the Featured’ view, and you can browse - s “ ey
apps that Apple has deemed New & , _ A -
Noteworthy, which is handy if you want to | S e $oias . S

see the latest apps Apple deems worthy of
your time. If you're more interested in apps
with favourable user reviews, however, then
scroll to the "What's Hot' section to see all of
the top rated apps.
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u “ree ' e il @ e @ e : If you're interested in the most popular apps that people have purchased, click
| —— the Top Charts’ button at the top of the main window, and get instant access
: ( : e et to the top apps. Here, you can download the most recent macOSs, if you're not
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o already running it, and apps that include Pages, Numbers and Keynote. To the
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Categories Updates
If you know the type of app that you are looking for, then try using the The Mac App Store offers similar functionality to the iTunes App Store. If you use
‘Categories’ view. All apps in the Mac App 5tore are organised into one of 21 an iPhone, you'll know that you are notified of app updates as and when they
categories, ranging from ‘Business’ and "Weather’, to 'Developer Tools' and 'Video.  become available. It's no different with the Mac App Store; click the 'Updates’
Click the category title to see all the apps in that specific category. You can now button, and you'll see all available updates for apps you've downloaded. You are
browse the apps. If you see one you'd like to know more about, then simply click then given the option to install them. These updates may iron aut any glitches
on the thumbnail image. or add extra features to your apps.
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IThe next step

Download from the Mac App Store

The Mac App Store is your hub for new software. Here's how to get your hands on amazing apps

offered Mac users an entirely new way to browse and download
apps that had never been seen before. There was widespread shock
at Apple’s decision to do this because it was a mowve based on the success of
the iPhone App Store, and one not guaranteed to work on the Mac platform, As
has been the case for many a year now, Apple was right and the Mac App Store
becare an instant success.

These days, a ot of people take the Store for granted, while others don't even
know it exists and have never even opened it up. If this is you, you're missing
out on a huge amount of incredible content. In this tutorial, we'l start you at the
basic level. If you have an Apple 1D, which yvou would use to buy iPhone and
iPad apps as well as songs and movies in the iTunes Store, you can use that to
log in. If not, check out the tutorial on the previous two pages.

@ When it launched at the beginning of 2011, the Mac App Store

MaC App StOI‘e Start downloading now
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01: Apple ID 02: Categories 03: Chart topping

Open the Mac App Store and look at the Quick Below the Sign In button you will see a drop-down Along the top of the Store are five options. The

Links on the right. Click Sign In. Input your Apple 1D box that says All Categories. Click it and you can second one is Top Charts; select this and you can see
and password, or create one if you don't have one. quickly navigate between categories in the Store, what is being downloaded the most.
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04: Well paid 05: App details 06: Screenshots

The opening page of the Top Charts section shows Clicking on an app’s name will take you to its page. Scroll down and you can flick through screenshots of
you the most downloaded apps. When you find an You can read a description here. Click on More 1o the app, just like on the iOS App Store, This gives you
app you're interested in, click its name or icon. reveal all the information about the app. a better idea of how the app will work.
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Mac App Store
interface explained

Discover a world of great software

Quick buy

If you know you want
an app, you don't have
to view the app's page

DON'T HAVE

THE STORE?

[t might be that you don't
see the Mac App Store
anywhere on your machine,
If you are running a version
of OS X from Lion onwards,
the Store will be included
automatically. However,
before Lion, the Store was
only available on 05 X 10.6.6

Past purchases

The Mac App Store recognises when you buy
sornething with an Apple 1D, You can click the
Purchases tab at the top to view all of your
previously downloaded apps

pEore Fdi Sioe Wesiow e

before you download.
These grey buttons

act as 'Buy’ buttons, so
you can click these and
download apps straight
from this page

— Snow Leopard. Earlier
systems don't support the
Store, and Leopard users will
need to download it from

~ Apple's website,

CEER)
,.-upEH'S'I’AH
..': 28 :"

biprg baamr

MacBook Air

Up-to-date

When one of your apps needs updating t© a newer
version, the Mac App Store will show an alert in your Dock.
Click it and choose Updates from the top of the window
to download the latest version of the app

L y
——— ——— 52 rch and download

If you know exactly what you're looking for and need to
fincl it fast, you can use the Search bar in the top right of
the window. This will offer suggestions of apps as you
type, 5o you can find things instantly

.

G

rﬂugh:utlyr in the

07: Tough crowd 08: Ready to buy 09: Installed

Mave further down and you can read reviews from If you want the app, go to the top of the page and Once you've clicked Buy App, the Mac's Launchpad
other users. These offer brilliant and real opinions on click the Buy App button, It will turn green, Click it will open automatically and your app will appear on
the app, away from the marketing blurb. again, then input your Apple ID and password. the grid. You can now click on it to launch it.
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IThe next step

Delete and reinstall apps
on your Mac

Deleting apps downloaded from the Mac App Store is a breeze

Uninstalling apps has always been a used an i0S device such as an iPhone o remove
@ whole lot easier on a Mac thanon a apps downloaded from the iTunes App Store, then

Windows PC, and you'll be pleased to you'll instantly feel familiar with the process. -
learn that the most recent versions of macOS Read on and we'll show you how to use oo
make the process even easier. Don't go looking for ~ Launchpad to delete an app that has been
an ‘Uninstall Programs’ setting, as you won't find downloaded from the Mac App Store. We'll then

one! The latest versions of the OS have adopted the show you how to reinstall the app should you
automated click-and-hold method used by devices ever require it again in the future. As a bonus, you

such as the iPhone and iPad. This means that don't even need to empty the Trash, as Launchpad
deleting any apps downloaded from the Mac App handles everything for you. It's an extremely simple
Store is an absolute breeze. In fact, if you've ever process and we show you how to do it

De I ete Wit h ease Navigate Launchpad Confirm deletion

; All apps (paid and free) that you download Rermoving an app that is no longer required
A quick look at the app From the Mac App Store can be viewed on s a breeze: simply dlick on the black X’
dE‘|E‘tIﬂQ prDCESS Launchpad. If there is more than one page badge, and then Delete’ when asked to
of shartcut icons, use your mouse to swipe confirm that you want to delete the app.
through the screens The whole process is autormated

Reinstall apps

You can reinstall apps downloaded
from the Mac App Store using the
Purchased view. Click 'Install’ and the
app will be reinstalled, and appear

in the first available space on the
Launchpad screen

Click and hold

Click and held on an app that .

you wish to delete, and all the _ 1 A et e s
app icons will start wiggling. Ky e R b Fo - Cances

Apps that can be deleted (that
is, those downloaded from
the Mac App Store) will sport
a circular black "% badge

DELETE FROM FINDER

Experienced macOS users may have
noted that apps downloaded from
the Mac App Store cannot be moved
to Trash from the Applications folder.
Although the easiest way to delete

apps is via Launchpad, there is an
alternative method. Open Finder,

click Go=Applications, and select an ﬂ

app. Press Command+Delete, enter
your password when prompted, and
the app will be moved to the Trash. -
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MaC App StOI'e Uninstall and reinstall apps
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01: Purchased apps 02: Click and hold
The first step is to check which apps you have downloaded. To do this, launch Browse the apps installed, find one you no longer need, and click the
the App Store, and click the ‘Purchases’ button at the top. Launchpad icon. Click and hold on the app's icon until it starts wiggling.
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03: Confirm deletion 04: Familiar process
All downloaded apps will now sport an "X icon. Click the relevant X' icon, and The app will now be removed. The process will be familiar to anyone wha has
when asked to confirm that you want to delete the app, click Delete’ used an iDevice, as the tap and hold method is used by all iO5 devices.
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05: Reinstall the app 06: Track progress
If you want to reinstall the app, launch the App Store, and navigate to the Launchpad will appear. You can track the progress of the app download and
‘Purchased’ view. When the store recalls your purchases, click 'Install’ reinstallation. The process is automated, with no user input required.
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lThe next step

Clean your Mac and get more space

Dragging apps to Trash leaves many files behind — use this free app to find and delete them

App Cleaner & Uninstaller is a great free app in the
Mac App Store that enables you to recover disk space
and clean up the system. It can find and remove all the

A
wvr

files associated with an app, even if it was deleted months ago. -

Select an installed app and it lists every file it created outside of the \iJ

Applications folder. It is then easy to select and delete them using Q : il _ _

App Cleaner Y e T
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If you dragged apps to the Trash to delete them, even a long time SRR ot ity
ago, App Cleaner is able to list all the files that were left behind and
you can easily select and remove them. Some features are limited in
free mode, but there are still enough to make this a must-have toal.
The Pro upgrade is £4.99.
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01: Sort your apps 02: Delete service files 03: View app installers

Got to the Applications tab at the top and then click  Select an app to list its associated files. Tick the Have you downloaded apps, installed them and
the ‘Sort’ menu, Select 'Size; Large to Small’ to see boxes and click 'Remove Service Files' to reset it so then forgotten to delete the installer? They are
which apps take up the most disk space. Do you it is like new. Drag the app to the Trash in Finder to wasting space, Select the Extensions tab and then
really need them? delete it. select ‘Installations’ to see.
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04: Delete installers 05: View deleted apps 06: Remove service files

The free App Cleaner will not let you delete When apps are dragged to the Trash, files remain Clean up the disk and free up space by clicking
installers. Point your mouse over the file path and on the disk. Select the ‘Remains tabto see theapps  ‘Remove Service Files', You might need to confirm
click the arrow to open Finder with the app selected.  and their files. Select items in the list to view the their deletion by entering your admin password.
Move it to the Trash. associated files. Click the ‘Confirm’ button.
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Apps and their files

Find the biggest apps and the location of their files

. ~

Top tools

Click the ‘A’ ‘'E' or 'R tabs
to view apps, extensions
and remains, Click

& ‘Applications’ to view the
installed apps and select
' an app in the list to view
all the files wherever
they are
-
——
|
Sort options

Click here to open the
sort options menu, Sort
the apps by size and you
can instantly see which
apps take up the most
disk space. Consider
deleting them if you
need more disk space

-

N

‘ _

Configure
App Cleaner

App Cleaner is good to start with but it
can be made even better by tweaking
the settings. Some files belonging to an
app might be in system folders and you
need to configure App Cleaner to look
for them. You might also want to protect
system or important apps from being
accidentally deleted.

01: Search system folders

Go to the App Cleaner & Uninstaller menu and
select ‘Preferences’. On the General tab, tick the
checkbox ‘Search Service files in the System
folders’. You will be asked to authorise this, but it
improves the app’s cleaning functions.

Pro features

The padiock indicates a feature that is

only available in the Pro upgrade, such
as deleting installed applications. There
are still many useful features in the free
version of App Cleaner

Select an app and all its
i files are listed. Tick these
? 1 g, boxes to delete all the

o o, app's assodiated files. You

can then manually drag
* the app itself to the Trash
., todelete it using Finder

|||||

WHAT ARE
SERVICE FILES?

App Cleaner & Uninstaller talks
about service files and it lets you
search for them, select them

and delete them, but what are
they? There are several types and
ane is caches. This is temparary
file storage used when the

app is running. Another type is
preferences, which is where the
app stores settings. There may be
other files too.

Eqiwnron

02: Protect your apps

Select the ‘Skip List’ tab. Any apps added here
will not be displayed in App Cleaner and are
therefore protected from being accidentally
deleted. Click the + button at the bottom and
select the apps you want to protect,
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IThe next step

Get started with iTunes

Learn to find your way around the iTunes app and
discover all the amazing content on offer

iTunes is the place you go to for The app comes in two, very big, halves: the .

O entertainment on your Mac, whatever it Library and the iTunes Store. The front page of the L

s you fancy doing. Movies and TV series, Store has a carousel that you can browse, featuring
new songs and albums, smart playlists that are new and noteworthy, albums, films and deals. All
based on tracks you like, books that you can start you need to do to get going is sign in with your
reading on your Mac and carry on reading on yvour iTunes account,
iPad, plus podcasts and audiobooks for your i05 Once you've loaded iTunes up with your favourite
devices; iTunes has it all, While the App Store (with content, you can use the Library, and the iTunes . o
its own blue and white icon in your Applications Player to enjoy your media. Sync everything with "X ] Py
folder) is the place you go to find apps like the your iPhone and iPad so you can enjoy it on those E m W e
Photos app, Pages and Numbers, iTunes is for too on the go. There's a lot to see, so we'll show you LT T T e ® ¥ o

everything else. around first. 5 “ n “ E
¥ g &2 y [ - " J

U S iTu nes to p | ay med ia Access a device Visit the Store

When your i05 device is plugged in, This contains a link to the iTunes
Listen to SONgs W ithout even you will be able to access its page of Store, where you can rent of
le aving the Store options, including syncing, or eject purchase more content, and you
the device by clicking on the relevant can also have links to things such as
button in the sidebar your Purchased apps
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71 Bacintly Addied

Find your content £ st
]
All the music, movies, TV shows, A Senge

podcasts, audiobooks and apps you A2 -
own can be accessed via the buttons D Doweicated
here, Click on the three-dot icon to

access more of your content
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Playing files TR st oe
Once you've selected and played a s " "o e e
track or playlist from the main area : CEE amaa -
below, use these playback controls so - d L Rk LY o Your Tomn
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s Tries

you can pause and skip tracks while
browsing iTunes
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STORE, LIBRARY
AND PLAYER

iTunes comes in two halves: a Store,
where you can buy and rent films

and TV episodes, audiobooks, music
and more, and then a Library and
media player where you can enjoy all
this content. While in each, you can
use the tabs at the top of the screen
to access other places.
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ITunes Find your feet in iTunes
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01: Find your music

Open up iTunes and use the menu in the top-left
corner to switch between Music, Films, TV Shows,
Podcasts and Audiobooks. Select Music.

R i O ] woeget Pepweae U indiaes

04 Use Gen:us

Choose Recommended for You from the Store
menu to get suggested albums and playlists
depending on the tracks you've bought.

Eeod eamiLy doe

ARIMATIEZN

A FILM

W COLLECTION

07: Find a movie

Choose Films from the menu in the top-left corner.
As well as featured content, there are further
categories. Pick a film you want to see.

Library  For You Browae Stone

FEATURED STATION
Charting Now

'he hottest tracks on the planet.

m
02: BI‘DWSE the tabs

Use the tabs in the bar along the top of the main

window to switch between Library, For You, Browse,

Radio and the iTunes Store,

E———

Yourr first 3 months free

rey Mo commitment. Cancel anytima.

I Family Lk

Univeraity Student

05: Apple Music

If you sign up for Apple Music, you can listen to and
download as much music from Apple’s library as
you want, for a monthly or annual fee.

08: Rent or bl.];' -

On the film's info page, depending on availability,
you can buy or rent in standard quality or HD, With
albums you can buy songs or whole albums.

03: Use the MiniPlayer

You can create a smaller version of the iTunes player
by selecting MiniPlayer from the Window menu at
the top. It's more powerful than you think.
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06: Go to the Store

Click the Store button at the top. Find new music,
films, TV Shows and more. Featured content is on
the carousel on the main page.

09: Hit play

Once you've downloaded something, it'll turn up in

your Library view. Hit play and enjoy it on your Mac,
or go and see what else is in the Store,
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IThe next step

Organise your iTunes music library

Discover how to keep your library well organised when importing CDs

Just like our CD and vinyl collections, many of us like to

keep our iTunes music database neat and tidy. This means

that all data is correctly recorded, all multi-disc albums are
grouped together and all album cover art is present and correct. If any
of those elements are missing or incorrect then your iTunes library
could become filled with multiple hits for the same album all featuring
the same generic missing artwork icon — and nobody wants that.
Thankfully, by investing a few minutes when importing your music you
can ensure that everything is catalogued and displayed exactly how it
should be. Here we show you a few handy pointers.

IR
S

1]
i -—— .
i
--|'ﬂ'|"'lr - 'u.':‘| !!
[Tl e

T Nl . PR

[ R R L

Thedr Grantes? Hits: The Recond
Pt Ui .

ol e AL E IR
aT Carms
BT g W e
B ngrie deg

i Ll WY

Keep an organised |ibral'y Adjusting album info

How to keep your imported music in order LRSS ol Hou NPRIe A oHIDy

is displaying the wrong information (such as
"Various'instead of one particular artist - which
usually happens if there are duets present that
feature another artist) then right-click and
choose 'Get Info'to make manual adjustments

COMPLETING ALBUMS

If you have incomplete albums

within your iTunes library, perhaps

as a result of purchasing a few Fiw it View History Bookmerks  Window el

individual songs, then you can e : : .

complete your album in the ' o B v e feoe| o

iTunes store for a discounted rate. W Sy o R LT SO American Idiot Orginal Broadway Cast
s Dy

Go to the store and click on the il
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‘Complete My Album’ link in the s

right-hand Music column and you e e —

can see all of the options. <z e S et
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sl )T M b Grouping double-albums
With a few simple adjustments to the
CD info, you can ensure that albums
consisting of more than one disc are
grouped within the same library entry,
keeping things nice and tidy

IFe WS § Lol af

Manually assigning artwork
Remember that you can assign whatever
artwork you wish to any album if you do it
manually, Just source an alternative piece of
artwork, click on’Get Info’and then copy and
paste or import from your computer

Displaying album artwork

If album artwork isn't sourced and displayed
automatically vou can click on the '‘Get
Album Artwork' option. If this also fails to
glean results then you may have to make
adjustments to the CD info
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iTunes Correctly labelling imported CDs
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01:Importa CD

When importing a CD into your iTunes database you
may be asked to clarify the artist and title if multiple
matches exist in the Gracenote database. Otherwise,
just choose to import it.
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04: Fine-tuning
Finally, untick the ‘Compilation’ option and, once you
have amended the various info fields, click on ‘OK’

and then right-click on the second disc and choose
the ‘Get Info’ option again.

07: Get album artwork

The album is still missing cover art, This might have
been because some of the info was wrong when
the CD was imported. Right-click on the album and

choose 'Get Album Artwork’,

02: Click Get Info

Here we are left with two iTunes entries for both
discs of the same alburm and one is credited to
Various' artists on account of one song being a
duet. Right-click and choose 'Get Info.
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05: Merging multiple discs

Once again, remove any unnecessary information,

in this case the TDisc 1] text after the allbum title,
double-check that everything else is in order and
then click on "OK.

08: Artwork added

In this instance the corrected data meant that the
correct artwork could be automatically sourced.
However, if the artwork cannot be sourced
automatically, you can do it manually.
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03: Correct album info

Click on 'Edit tems’ and then in the top field, enter
the narme of the artist. You can also remove the
[Disc 2] text after the album title as this is reflected
in the ‘disc number’ section.

= e, Y.

06: Library grouping

You should now notice that both discs merge into
one iTunes library entry. If you click on it you will
notice that both CDs of tracks run consecutively
within the album entry:,

THE HOILY RHILE
LA Bl

09: Manually adding artwork

Source a picture of the artwork, right-click on the
album, choose ‘Get Info” and then select the Artwork
tab. Choose ‘Add Artwork), locate the image file on
yvour Mac and click 'OK.
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IThe next step

Download music from the
ITunes store

Make the most of the huge catalogue of music available on iTunes

iTunes was born to help people manage down deeper within an artist’s catalogue. There are need to use any other service to get the music you
n their digital music, and over time it has multiple ways to browse music, and once you have want. Your only problems will be finding the music
grown to offer all of the entertainment an account set up with a valid credit card or gift you reguire within such a large library and making
you could possibly want to carry with you. card code, the process is as simple as choosing what  sure you have enough space to install it all.
The iTunes library is huge, and all of the major new you want and then letting the software do the 3 ) )
releases are available to download as quickly as they  work for you. E ‘ I
are on competing services, It has reached the point We explain how to download and purchase very a rUSt WI qave
where almost every artist you like will have a large music from iTunes and then move it to your iPod. | ‘ ' ]C
selection of content on offer, Indeed, there are settings you can choose to make a a rg e Se eCth q O
You can quickly search for individual songs, the process almost fully automated and with so ]Cf- 4
albums and tracks via the search bar, and also dig many options open to you, it is unlikely that you will CO ntent O n O er

iTunes purchasing options (Creckthe populary

: . . The popularity indicators will give you
Many purchasing choices are available anvidea of how populara particular
track is, which can be useful when
| making individual track choices

f Buy an album

Clicking this button will
prompt an immediate
purchase of an album.
You will need 1o enter
your password, and the
process only takes a few
seconds, The tracks will
then download
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Music + RBack + Eagles

Hotel California (40th Anniversary Expanded Edition)
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Songe  Ralings and Reviews “ FESIED

Hoiel Cakforma (Remasiered Englas
P Bl in Town |Famdastand] Englan

: Lite i thes Fast Lana (Hemastaned Englas
1294 By i

Wasaad Tima [Fernstond)

Winrssr Time (Aepriss! |[Hempastiersd|

Wictem of Love |Rosnosonesd)

Frafty basis AL IR B Aow (Reenaa]soad

Try ard Lones Agan (Hemastemd)

The Lusl Fesodl [Aerastessd)

THE AMAZON ALTERNATIVE i £ i

Amazon offers a huge library of 2 TakehtTo
digital music as well, and has built New Kid in Town (Live a1 the Los Angelea Fonam, 10v20-22/78) Eagios
fﬁEtﬂ"Er WﬁWﬂl’E that |Et5- }"ﬂu 1 James Dean (Live at the Los Angeles Fonem, T00520-28778 5
make purchases, which are then SRR N B SR e ) 2SR
automatically pushed to your iTunes e SV R RS T
library. The process is very simpie,

and almost as efficient as using

iTunes directly.

Live @l the Los Angeles Forum, TM20-Z278

this Limst {Live ol the Los Angeles Fonan, 105°20-22078)

. Individual tracks
Send a gift You can purchase individual
Clicking the arrow next ta the album price tracks as well, but if you buy
lets you send the album as a gift or add it to a lot of them it will work out
a wish list for purchasing later. You can also more expensive than buying

| share the album details with others . a whole album in one go

108 Mac for Beginners



| I unes Purchase albums and tracks from iTunes
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02: Search for music

In the top right you will search a search box. Enter the name of the artist you are
locking far and hit Return. A selection of songs, albums and videos will appear.

01: The music section

To access the iTunes Store, click on the iTunes Store button at the top of the
screen. Now use the side column to the right to ensure Music is selected.

03: Choose an album

Once you've checked the offerings and decided what to buy, you can dlick the
price button to make your purchase. Individual track prices will be available too.
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04: Enter your details

You'll need to enter your password. Once you have done this, a confirmation
box will appear. Select ‘Buy’, and your tracks will download in the background.
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05: Check the progress

You can select the arrow icon in the top right to display the downloads as they
progress. They usually download in minutes, depending on your connection.
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06: Use your purchase

Tap the "My Music’ option at the top of the screen, and you will see your recent
purchases. You can now play it or move it to your iPhone/iPod/iPad.
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IThe next step

Apple Music is Apple’s music streaming

service. This is Apple's equivalent to

Spotify or Amazon Music and it lives on
vour Mac in the iTunes app. Apple Music gives you
access to virtually the whole of the iTunes library
(that's a staggering 45 million tracks, in case you
were wondering) and a 24/7 radio station called
Beats One. Apple Music gets more powerful the
more you use it, and the For You tab gives you
persanalised playlists to enjoy, based on the music
that you've told it that you like or that you play a
lot of. You can also download tracks and whole

albums to your Mac to listen to even when you're
hot connected to the internet.

Apple has priced Apple Music competitively, so
much so that every user gets a free three-manth
trial of the service. After that you get the chance to
continue using Apple Music for a monthly fee of
£9.09/5999 or £4.99/54 99 if you are a student. You
can upgrade that subscription to £14.99/514.99 and
get access for a family of up to six users.

So if you're a big music lover, follow this tutorial
to sign up to Apple Music and see if you like what's
on offer,

Hicary Mayad
& ¢ i
),

Set up and use Apple Music

Make use of your free, three-month trial and get to know Apple Music

e
SER i) P A

“You can download tracks to your Mac for offline listening”

Inside Apple Music

Get to know what's what in Apple’s
MusIcC service

My Music

Any track or alburm
that you add to lives in
your Library. It's just like
iTunes, with cover art
presented in big square
thumbnails. Click on

a thumbnail to start
playing its contents

LISTEN TO THE RADIO

Apple Music comes with

its very own radio station,
Beats One, hosted by world-
leading DJs in Los Angeles,
New York and London. You
can listen live, to previous
shows or even to stations

by genre.

iTunes Store

If vou still like the idea
of owning your music,
you can head to the
ITunes Store as normal
and buy tracks, albums
and videos just like
you always have

For You

When you've told Apple
Music the genres of
music you like to listen
to and your favourite
artists, the For You tab
will be populated with

a personalised playlist
of music
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Download

When you add music

to your Library it

isn't automatically

downloaded to your
Mac. Click the cloud icon

to download the album

or click the album and

select individual songs



App'@ MUSiC Sign up and start streaming music
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01: Open up Apple Music
Open iTunes and you'll see this Apple Music screen. To get started, click Start 3
Month Free Trial or click Already a member if you have an account already.
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03: Apple ID

You'll need to sign in to the iTunes Store with your Apple ID, so enter your
credentials. Click Buy, even though it's a free three-month trial.

Pop It (feat. meash) - EP
Aramanaguci e .'

05: Play a track

Playing one of your songs or alburms is as simple as clicking on the album
cover's thumbnail, A track overview will drop down. Now tap the play button,

Your first 3 months free
et Mo commitment. Cancel amytima.
I

indiwiciLial

P et s Sl e
e
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University Student

02: Choose your plan

Now it's time to choose your membership plan. Click Individual or Family
depending on your preferences. Refer to the previous page for pricing.

B0l 4P

1 b

04: iTunes music

Because you sign in to Apple Music with your Apple ID, every track you've
previously purchased will be present in the main My Music tab.

borw by Dieeain Towermend Froject

06: Add to My Music

You can search Apple Music for any track or albumn using the Browse tab at the
top. Click the + Add option to add it to your My Music folder.
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IThe next step

Rent and buy movies on iTunes

Get the best new movies on your desktop with iTunes

As well as being one of the world's

| largest digital music hubs, the iTunes

/' Store is also home to great movies and
TV programmes from all over the world. To access
this incredible selection of brand new and classic
films, you can either scroll down on the iTunes Store
home page or select 'Films’ from the tabs at the top
of the screen instead.,

As well as being loaded with content, the Film
marketplace is an easy place to navigate. In addition
to searching through the Store with the search bar,
you can also use the drop arrow in the right column
to search by genres, like comedy, drama or sci-fi &

The movie page

Find out about your chosen film

Trailer

If you want to
see a sample of
wour film, click
on a trailer, You
can't download
it from iTunes
11, but you will
start streaming it
- when you clickit |

HD or SD?
Click the HDYSD buttons to change
between formats. If you plan on
watching on your iFog, it's bestto go
for SD. On your desktop, we would

| recommend HD
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fantasy. For some films, there's also the option of
iTunes Extras. Not entirely unlike bonus features
on a DVD or Blu-ray, Extras gives you the option
to check out exclusive behind-the-scenes footage,
deleted scenes and much more.

Once you've found the content you're after, you
can either buy or rent it. Buying will, of course, be
more expensive, but you can watch your film as
many times as you wish. Renting, on the other
hand, is usually far cheaper, but you only have 30

days in which to start watching it, and then only 48

hours to finish the video from the moment you
hit play.

TV PROGRAMMES

Thanks to the power of iCloud, you can watch
your downloaded film on any device. If you start
watching your movie on your desktop computer
through iTunes, but then have to hop on the bus,
you can download it on your I05 device and it
resurme playing from exactly where you left off.

“The marketplace is
an easy place
to navigate”

It's not just films that the iTunes Store offers — you can also
download entire TV series or individual episodes. They're

nat exactly cheap, but you can watch them on any Apple
devices you own, including iPod touch and selected iPod nano
generations. Most feature both SD and HD options. You can
download episodes in the same way you download movies.

spidar-Man: Homeacomng

"iTunes Extras

If your film has any
bonus footage or
deleted scenes, it
will carry an iTunes
Extras badge. You
will not have to pay
any more for this
added privilege

Ratings & Reviews

Click here 10 see what other people

thought about your chosen film. After

you've seen it, you can leave your own
- review and rate it out of five stars



iTunes Download a film from iTunes

01: Open the store 02: Find your genre

Open up iTunes an yvour computer and click the arrow next to the Music option Click the drop-down arrow next to the All Genres menu option and then pick a
in the right-hand column. Now select Films from the dropdown menu. genre that appeals to you from the extensive list of options.
BoE @ P e — i

03: Choose your title 04: HD or SD?

Once you've chosen your genre, select the film you want by clicking on it. This You may have be able to choose a high definition version (HD) or a standard
will open up the film's iTunes page, which will feature details, ratings and more. definition version (5D). SD's cheaper, but won't lock as good,
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05: Download it 06: Watch it
Click either ‘Buy’ or ‘Rent;, and you will start downloading the movie. Progress If vou have a fast connection, you will be able to stream it after a few minutes.
will be shown in the main media bar. When it's done you will find it in the "Movies' section of yvour iTunes library.

Mac for Beginners 113



IThe next step

Navigate the new iBooks

Use the iBooks app in macOS to read, manage, purchase and
take notes with more than 1.8 million books

Since then its popularity has kept on growing. iBooks connects to the iBooks

Stare, which functions just as iTunes does - giving users the ability to have
access 1o a digital library of literature that has made iBooks so successful. Since the
introduction of Yosemite, iBooks has been made available on the Mac. iBooks syncs
perfectly with all your devices, letting you access your books in any format. If you start
reading a book on your iPad then come back to it on your Mac, iBaoks will let you pick up
right where you left off, Although iBooks is much more tablet-friendly than on a desktop,
(since you might not be used to reading from your computer) there are a series of
functions such as note-taking, highlighting and searching within a book that are so much
more simple to execute from a Mac. Follow these six simple steps to getting set up and
reading in no time with iBooks app for Mac.

[ ’ iBooks has been around since 2010, first appearing as an app on the iPad.

"iBooks syncs perfectly with all your
aevices, letting you access your
books in any format”

Formatting options

To format a book's settings, click here to
access the Appearance window. Here you
can change the size of the book's text,
choose from a selection of different fonts
or change the text calour

Navigation

Here you can search through the
entirety of a book with key phrases
and words. The toolbar also offers a
table of contents and a bookmarking
tool to make browsing easier

iBooks reading interface

Navigating the reading interface and tools
of iBooks in macOS

Managing Notes

MNotes can be accessed here by clicking
on the page number to be taken to the
page where a note was added. Right-click
on a note to share it via Facebook, Twitter,
Messages or Email

Creating Notes

Select a body of text to open the
MNotes window where you can
highlight text and add notes. From
the More menu you can search for
the text online have the text spoken

IBOOKS AUTHOR

If reading via iBooks is getting you
inspired to write your own novel,
then why not download the free
iBooks Author software from Apple.

This tool lets you create and publish
your very own book from scratch

or by using templates including
images, interactive options and
videos — all built to work with iBooks,
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IBOOkS Master iBooks in macOS
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01: Launch iBooks

If you're starting iBooks for the first time on your mac, log in via your iTunes
account to sync iBooks with your iPad or iPhone app.
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03: Manage your collection

Double-click on New Collection 1 to rename it. Right-click on a book, then
select Add to Collection to include it in your new collection.
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iBooks Editors’ Notes
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05: Samples and purchasing

Select a book, then click Get Sample to add the first few pages of the book to
your library or purchase it using your iTunes account,
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02: Build a collection
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All previous purchases will sync with the app, placing them in the All Books
window. Right-click on a book, then click on New Collection.
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04: iBooks Store
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Click on iBooks Store in the top-right-hand corner. Search by Category, author or

keyword as you would in iTunes to find a book.
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06: iBooks' reading interface
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Double-click on a book in your collection to read it. Using the toolbar you can

adjust Font Size, add notes, bookmark and search.
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IThe next step

Get organised with Calendar

It's an incredibly important app that can help get you organised

(— — N @ Calendar (formerly known as iCal) is one of the

unsung heroes of macOS and i0S. It is the Mac-
based predecessor to Calendar on your iPhone
or iPad. This application has the ability to really help you
March 2016 _ _ _ ] T L3 arganise your life and — with the ability to share your
- : calendars - the lives of others.

As you would expect, Apple has made the app simple
yet effective, with an incredibly user-friendly interface. You
can colour code certain calendars, for example, so that
you can set up different ones for work, social events, sport
matches and mare. You can set any events that you create
to a certain time or to ‘all-day’, and there are plenty of
other options that will suit your needs.

In this introduction to the application, we'll show you
how to create a new calendar and add an event, as well
RRNRRLL : as how best to view your busy schedule. Armed with this

' information, you can keep track of important meetings,
birthdays, social events and much more with ease,

“This app can really
nelp you to organise
your life”
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01: Add a calendar 02: Name it
The very first step will be to open up Calendar (or iCal) on your Mac. Use the ¥ Naming your calendar is important, as this will specify the kind of events that
button in the top left cormer of the Calendar interface to add a new quick event. you add and help you divide the kinds of tasks you complete in your everyday
Alternatively, you can click on the File menu and click ‘New Calendar’ to create a life, which is impaortant if you have separate calendars for werk and home, You
brand new calendar. can, once your calendar is made, tick and untick it to reveal and hide events.
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Grasp the interface

View your calendar however
you want to
Month view
Lise this to view the weeks ahead and to
get a feel for how busy you are, You can
Dav view easily skim through months at a time,
Fyteis ey bsybes this which makes it the best place to plan
. holi | '
is where you'll need to be to DRcHys NG WgEr pinieets
organise every moment of your
life. Click on an event to view all of Week view
the details to the right This is our favourite view, as it offers you

enough detail to see entire days well-
planned-out, but it also offers a quick
overview of the entire week ahead. We
live in this view
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03: Double-click 04: Assign to a calendar
Double-click on a day and time to add a new event to your calendar. A pop-up If you've changed your mind about the calendar that you want this event to
window will appear, allowing you to add all the pertinent information you want apply 1o, just click on the drop-down arrow next to ‘calendar’ and select a
to the new event. Be as detailed as you can, as this will help you recall the event different one. As these are colour-coded, you can easily distinguish between
when the time comes. them. Once you're finished, click Done.
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The next step

Apply more detail to your events by adding notes

Add a note to a Calendar event

il
track of your hectic schedule, adding information, including the all-important start and Ad d a ﬂOtE’ to

@ Apple’s Calendar app is great for keeping  double-click on it to bring up a floating window of

events and inviting other people to finish times, and by clicking the various fields you :
attend them. When creating events that otherusers  can then start adding invitees, alerts and notes. g
will be able to see, it is obviously a good idea to Simply click on 'note’ and yvou'll be able to write a n eve nt to Ive
include as much detail as possible. However, you as much text as you want into a dialog box and, m h d ‘
don't want to pepper the main event window with once you click off the box, this information will be a S U C _ eta |
too many words, so what can you do? Easy: add a viewable to others clicking on your event. Here's a S OS SI b ‘ e”
note. Once you have added an event you can how to start adding in your own event notes. p

calendar Add more information to your entry
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01: Double-click the event 02: Click on note
Locate the event that you wish to apply a note to and then double-click on it to In the event bax will be a couple of '‘Add’ sections, one of which is Add Notes.
bring up an overview box of the event. Click on this section to start entering your own notes.
28 March 2016 ‘T wororoxs : 28 March 2016 T AR :
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. n: 0
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03: Enter text 04: Finishing off
Type your text into the field provided and then click off the event. The text will There is also the option to add a URL to your event. Simply click on the ‘Add URL
automatically be saved and stored with the event, field and then type or paste in the required link.
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Add an alert to a Calendar event

Set alerts to ensure that you never miss an important event

For all your good intentions of adding

events to your Calendars, they don't

mean a thing if you fail to take notice
and forget about them. Thankfully, to prevent this
happening, you can set yourself handy alerts so that
the app will inform you on the day, hours or
minutes before or at a precise time and date that
you determine. These alerts can consist of a
message, a message with a sound, an email sent to

Calendar Apply alerts to events
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01: Double-click the event

Like before, locate the event that you wish to apply an alert to and double-click
on it to bring up an overview box,
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03: Set alert

Set the desired times and then click on the Alert menu. This allows you to set an
alert in the run up to the event at a specified time,

yourself, the automatic cpening of an application or,
if you use AppleScript, you can set up a specific
script, or action, that your Mac will perform when it
needs to alert you at the specified time.

You have full freedom to determine the time
and date of the alert, and you can even set up a
sequence of alerts if you're worried about missing
your event, Simply use the drop-down menus next
to ‘alert’ in the event edit box.

"Alerts can inform
you of an event
minutes, hours or
days betorehand”
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02: Click on the alert box

Now click on the time box and this will expand the window to allow you to
enter start and end times and more.
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04: Set a custom alert

Click on Custom in the alert menu and then set your own desired alert options.
You can also choose to be notified via message, email or more.
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IThe next step

Master Messages on Mac

How to get the most out of the new advanced features of the High Sierra Messages app

You can track the location of your family members
using the Messages app in i0S 11, but did you know
you can also do so by exploring some of the great
features tucked away within the macOS High Sierra
version of the app? For example, you can access the same Tapback’
reactions present in the iO% app and, of course, you can still send
emaojis and audio messages. Best of all though, like the iOS app, you
can also track the location of loved ones, as long as they share their
location with you. In this tutorial we will showcase some of the lesser-
known options within the macOS Messages app and guide you
through pinpointing the location of your family members on a map.
This is most useful for MacBooks on the move,

01: Message details 02: Contact options 03: Using emojis

If you click on ‘Details’ in the top-right cormner of a There are three icons in the top-right comer of To use emojis in your messages, simply click on the
Messages conversation you can trigger key actions, the Details menu that allow you to call, Facelime smiley face icon to the right of the text entry field
such as Do Not Disturb’ and "Send Read Receipts by or share your screen. Screen sharing is handy for and a list of emajis will appear - click on the one you
ticking the boxes. project collaboration, want to include,
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04: Send an audio message 05: Using Tapback 06: Choose a reaction
Click on the microphane icon to the right of the text  You can also use Tapback,’ which lets you send A pop-up Tapback menu now appears above the
entry field and you can record audio messages. Click  instant reactions to your messages. Right-click on message. Click on a preferred reaction’ and it will be
‘Stop” when done and you can either ‘Cancel or a received message and select "Tapback’ from the relayed back to the message sender. There are six to
‘Send’ the audio file. menu to begin. choose from.
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Messages maSterCIaSS Exploring the various options on offer

e <= Location sharing
— - - Like the i0S 11 Messages app,
you can use the Messages app
i macOS High Sierra to display
the location of friends and family
_ members (who share their
@ location with you) and then get

' directions straight to them

Other options R
Take time to explore the various
menu items too. For example, by
clicking en View you will find
options to make the text bigger
ar smaller = which is useful as it is
: : I
displayed guite small by default Datailsinan
Clicking on ‘Details’ reveals a
menu of useful options, including
‘Do Not Disturb’ When activated
== you will not receive any alerts for
that particular conversation. You
will also see various buttons to
make contact

Tapback icons

Right-clicking on a message and
choosing the Tapback' option
will allow you to choose and
send instant responses. Whatever

response you choose will then be SENDING WEBLINKS

applied to the message and sent v P larl
back to show your reaction S TRy TS S0, g el Y
copy and paste weblinks into

Messages, in which case you will
discover that this is exceptionally
well implemented. When you copy
a link into a message the header
will be displayed underneath

a picture, followed by the web
source — far more sophisticated
than the bare link text of old.

sharing

Just as in the Messages app in i0O5 11,

you can view the location of your various
contacts through the macOS5 High Sierra
Messages app. However, the other person

must first go to Settings>Privacy>Location ()7 V|ew|ng location 02: Get directions
Services>Share My Location and enable the  yyhen the person you are having a conversation Double-click on the blue dot that represents
option and then, in Messages, select your with in Messages chooses to share their location the person’s location, your Mac's Maps app
conversation, tap the i' icon in the top- with you, you can click on the ‘Details’ option will automatically be opened with the location
right corner of the screen and tap ‘Send My  within Messages and that person’s location will displayed. You can now click on the ‘Directions’
Current Location’ appear in the Details menu. button to get directed straight to them.
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IThe next step

Discover FaceTime for Mac

With FaceTime for Mac, video calls are now only a few
clicks away. Learn how to install and configure this great tool

One of the most acclaimed features of

the iPhone, iPad and iPod touch devices

is also available on your Mac. From the
comfort of your laptop or desktop, FaceTime for
Mac now makes it possible for you 1o have a chat or
share a smile with your friends and family who also
possess an iPhone, iPad, iPod touch or Mac. It is
even possible to engage in video calls over your
local network. With the simple further requirements
of an email address and an Apple 1D, a whole new
world of enhanced communication is now easily
accessible, The sleek, simple and powerful interface
of the FaceTime for Mac application is fully
integrated into your macQ5 environment. Plus, if
you have an iPhone running iOS 8 or later, you can
now even make phone calls to any number if you
have your iPhone nearby.

"With your Mac, video

calls are just a few
———————————————  C|ICKS aWaY"

Facelime

01: Launch the app 02: Sign in

You can launch the FaceTime app by locating and double-clicking on the app When the FaceTime app has been launched, you will have to sign in with your
icon in your Applications folder or by selecting Launchpad from the Dock and Apple 1D to start using the app or create a new account, which you can do by
opening it from there. Alternatively, drag the app icon into your Dock to create a opening System Preferences and clicking on iCloud. When you have entered
handy shortcut if you intend to use the app frequently. your account details, you will be able to start conducting FaceTime chats.
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Find your Way Audio or Video? Quick calling

In FaceTime you can now make You can right-click on the FaceTime icon in the

a ro u n d Fa CETi m e' 22[; ;Lﬂg ?;t:?s i?:;;!;r{r!?;m Dock to bring up this contextual menu containing

your recent calls. Click on any ane of them to call

_ ' calls in each format, and quickly that person back instantly - it's a really fast way to
Make calls to your friends and e kol Y y ¥

family with ease

Search for Contacts

Click in the Search bar at the top of the left-
hand bar and you can type in a name, As
soon as you hit the first keys, FaceTime will
start making suggestions of who you might
mean, and you can call with a click

Contact information

To get more information about a
specific contact, click the ' icon next
to their name. A Contact window will
pop up, with all their information from
your Contacts app displayed

WHAT IS AN APPLE ID?

An Apple ID is a username and password - baatme
used to identify you on every Apple = = i~ =il
service, Whether you want to buy software e RN e s
or a device on the Apple Online Store, s P TN
music or movies on the iTunes Store or log e e

= o

in to iCloud, an Apple ID provides you with o
a single set of login credentials. o -
LO«HSOGIBT  's¢BRCECOOTA =

g l.com —

BATCn

A bpery

Adam

Alden Dy
Alex Brintow
Alga Garmblie
Abre

Andy Quddan
ANy S e

Appis nc

Adron Asad
Abe Pociork
Alv Pooock
Adam MpriciesscT
Adam M araecT

@I

03: Find a contact 04: Make a Call

You'll see Video and Audio options at the top of the screen. Click the search bar When your friend has been notified of your FaceTime invitation and accepts
and type in the name of a friend, or click the 4 button to add one from your the call, they will appear in the main window of the app and you will be visible
Contacts app manually. Then click on the phone or camera icons to make an in a stamp-sized screen in the corner. You can take a picture by clicking on the
audio or video call respectively, button in the bottom-left corner.
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Going further

Master the creative facilities of your Apple Mac
to capture and edit your images and video

creative
side”

124 Mac for Beginners

iMovie editing masterclass Keep time with Tempo
Turn your movies into something special Track techniques
Discaver the most crucial tempo tools

Master iMovie's Precision Editor

Achieve frame-accurate Edltlng Learn to Stay |ﬂ tune Wlth
0 _ oh b the Tuner
rganise your Photos Library Master your recordings and compositions by
Make sure you can always find your photos always staying in tune
Search your library by objects .
= =i
Use Photos' object-analysing search tools - = i “ o= — B
o=l NS

Take control with Photos’ Curves . o 5 ﬂ ". E -]

Fix exposure problems with Curves

How to use Drum Designer
Discover how perscussion levels can be

adjusted using a special plugin

TN S ol ol ol i B RS EEA




‘GarageBand allows
yOu tO recoro
music, edit and
export all with ease”

146

Tune your |
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Going further

Thanks to phenomenal advances
in technology, you can now record
HD video footage on gadgets such

iIMovie editinc
masterclass

Become an expert in recording, editing and sharing video

wheat from the chaff to create a short, slick and
watchable programme. As well as overcoming
problems such as camera shake and incorrect

on the cake’ and give your
programme the type of
professional production that

as DSLRs, GoPro cameras and even on your
iPhone. You also have access to the type of
video-editing tools that film-makers in previous
decades would have had to spend hundreds

of pounds to access. Today the only limitations

colours, we'll show you how to enhance your
shows with post-production assets like captions,
transitions, and a dash of special effects courtesy
of green screen compositing and picture-in-
picture effects. You'll also be able to add digital
on sharing high-quality videos are our own camera moves to clips and stills to enhance
imagination and a bit of technical experience. your programmes, thanks to iMovie's Ken Burns
This.iMovie.masterclass.is-designed to—wss=pools  Thesepost-production assets act as 'icing
help you become more familiar with the
video production workflow, so that you can
confidently capture high-quality footage,
import it into your Mac and then sort out the

people have come to expect.
It's now also much easier to
share your footage thanks to
social media platforms such as
YouTube and Vimeo. Anyone can
now find and build an international
audience from the comfort of their own

e

““Mac thanks to iMovie.

“Today the only limitation on sharing
videos is your Imagination”

Import footage into iMovie V- ;

iMovie keeps all imported clips in a Library. To work with clips more easily you need to
set up an event to store them in, and a project to edit them in. Here's how to get clips

into iMovie from an attached video camera or a folder located on your Mac,

03: Create the movie

The clips will appear in the event that you created.

Go to File>New Movie, Choose a Theme from the
options. Click Create. Label the movie and choose the
event you created.

01: Create a new event

Choose File>New Event. By default the event will be
labelled with the current date, but you can re-label
it to help identify its contents. Click the big Import
Media button

02: Import footage

From the Import window you can browse to an

attached camcorder, external drive or Mac folder,
Shift-click to select clips to import. Click the Import
Selected button,
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NON-LINEAR
EDITING

Once you've created

an event, imported
your clips and created a
movie template, you'll
see an empty timeline
appear. You can then
add your clips to the
timeline in any order to
start telling a story.
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lGoing further

Create a trailer

Atrailer is a great way of
presenting footage and getting
people excited about it

y - el
2 | .
W EPFORTE LY -

1: Choose a template

Click the New button and click the Trailer icon.
Click the Play icon on a trailer’s thumbnail

to preview its music, pacing and titles. Click
Create when you find one you fancy. Add it to
an event.

2: Use the Storyboard

Click on the Storyboard tab. This gives you
editable text fields and placeholder graphics
that suggest the type of shot you might
add. Music and transitions are all added
automatically.

3: Drag and drop

Modify the text fields to customise the

trailer’s text and click on your event's clips to
drop them one by one into an appropriate
placeholder. To see how things are shaping

up, tap the spacebar to preview how the trailer
looks and sounds.

"YOu can turn your
rampling raw
footage into a
Snappier story”
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Enhance your movies

Add titles, transitions, 3D Globes and travel maps

Once you have imported your footage into an event and created a timeline to add the clips to (see
previous spread), then you can turn your rambling raw footage into a shorter, snappier story. You
can trim clips’ durations to make them tighter and, just like editing an essay, you can swap clips
around to fine-tune how your story unfolds. Once you have told your tale you can enhance it using iMovie's
post-production assets such as titles, transitions and even animated travel maps. The latter are a great way
of setting the scene for your latest travelogue.
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2: Add terrific transitions

Press Crmd+H to summon the Transitions editor. This
lets you mix or wipe between clips. Drag a transition
between two clips. Double-click the transition's icon to
edit its duration.

1: Create some titles

Click the Titles browser (or press Cmd+2). Scrub over
a title thumbnail to preview it. Drag the title into the
timeline. Edit the font, text and colour in the main
viewer. Click the tick.
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4: Add a background

Below the maps are a further collection of still and
animated backgrounds. These are great for creating
attractive and slick-locking backdrops that can suit any
of your projects.

3: Use marvellous maps

Press Cmd+3 to summon Maps & Backgrounds. Drag
a map into the timeline. In the main viewer, type in a

journey start and end point for an animated arrow on
the globe,



extra colour balance controls
such as a White Balance
EVEAropper. This can banish
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Tweak

the temperature
fyour shot looks a little
oo warm, then drag this
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and create more natural
ooking skin tones, Drag
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blue clip

Boost saturation

fvour source clip's
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Sel your camera 1o
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flat contrast and subtle
colours, This helps yvou
avoid blowing out

highlights and shadow

. :
overall saturation. Be
caretul not to PN L OO0
5

tar or you'll create garish
unrealistic colours

Adetail arnd Creating over-
I ball gl 1) wleg 1LE LW

saturated colours
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0 access iMovie's tools
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clip's highlights
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Going further

Speed up or slow
down clips

Retime your footage to produce
creative results

iMovie makes it easy to speed footage up to produce
dazzling time-lapse sequences that show the ebb

and flow of people and traffic in a busy city, or slow

time down to watch a tree fall to earth. You can even split a
clip so that it starts off in real time and then seamlessly slows

down during a crucial moment. This variable speed effectis a

great technigue for enhancing action or sporting subjects, as

we'll demonstrate.

01: Split the clip

Scrub forward in the timeline until you
get to the moment when you want
time to switch to slow motion. Press
Command+B to split the clip (or right-
click on the clip and choose Split Clip).

02: Adjust the speed

Click to select the section of clip that
you want 1o re-time, Click the Speed
icon above the viewer, Set the drop-
down menu to the desired speed

(such as Slow). Choose a percentage.

03: Fine-tune the speed
After slowing a section down, a tortoise
icon will appear in the timeline. You can
click on the top right of the re-timed clip
and drag left to speed it up or right to
slow it down even more,

04: Fast forward

You can also change a selected clip's
speed by going to the Modify menu,
Here you can slow things down, speed
them up and even create a slow
Instant Replay of a sporting event.

"You can even split a clip so that it starts off in real time and then
seamlessly slows down during a crucial moment”

The Ken
Burns effect

Enhance your clips with
digital camera moves

iMovie's Ken Burns tools are brilliant
features that enable you to add

movement to statically framed clips.

These moves would be tricky to do
in-camera, but in iMovie you can
define a start and end size and let
the Ken Burns tools zoom and pan
between the keyframes smoothly.

130 Mac for Beginners

— TP W

01: Click to crop

Add a statically framed clip. This
example footage was shot on a
locked off tripod so only the people
move. Click on the Crop icon above
the viewer, then click Ken Burns.

02: Choose and point
Two baoxes show the Start and End
of the move. Click the End box

to make it solid. Drag the corner
handles to create a tight crop. Drag
inside the box to pan or tilt.

03: Make a move

You can click the arrow icon to swap
the size and position of the Start and
End boxes. Click the Tick to apply. In
this example the camera will zoom
in and tilt up as the clip plays.




Use a green screen effect [QEasiua=:

Present two clips at the same

Combine separate clips into a creative composite sequence time to tell a story creatively

By shooting a subject against a clean green when replacing a blue screen with other footage).
xﬁ/ (or blue) card, you can use iMovie's keying This compaositing technique is a great way of adding
P~ tools to replace the colour backdrop. Green  variety and texture to your productions. You can
screens tend to be popular as many people have place people in exotic locations or add special effects
blue eyes (and these could become transparent to your drama productions.

01: Layer two clips

Add a background clip to the timeline and
then drag an insert image onto the top layer
s0 both clips run parallel. Click the Video
Overlay settings icon. Set the drop-down

L q® qs s s 4e e

01: Source footage 02: Layer the clips menu to Picture-in-Picture.
To get the green (or blue) screen footage towork well  Drag the background footage to the timeline first.

the card needs to be evenly lit {or holes can appear). Then drag the blue screen clip onto the timeline and

Try and avoid shadows being cast on the card asthese  place it on a layer above the background clip. The two

might remain solid. parallel clips need to run together in sync.
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02: Refine composition

Drag the insert picture’s corner handles to
resize it. Drag inside the picture to re-position.
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03: Overlay options 04: Reduce fringing

Yellow guides will help you align it with
: y _ the centre. You can add a border and dro
Click on the top clip. Click on the Video Overlay The edges of the top layer's subject may suffer a fringe shadow. 10o. P
settings icon above the viewer. Set the drop-down of colour from the blue or green screen. Combat this
menu on the left to Green/Blue Screen. The blue card by dragging Softness right to soften the edges and
will instantly become transparent and diSEDDE&L reduce the strength of any fringingh
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03: Side-by-side

You can also change the Video Overlay

05: Clean up corners 06: Erase shadow settings to Side-by-Side. This causes the clip
If bits of blue background still appear at the frame's Click the eraser Clean-up icon. In our example there's a on the tl:{p. layer to slide in from the FIEﬁ oF
edges, click the Clean-up Borders icon. This enables hint of flower shadow on the blue card at the bottom- “f'j}ht until it shares half the frame with the
you to drag the corner handles inwards. Any areas right corner. By clicking the eraser on this area we can clip on the lower layer.

outside the handles will be completely transparent. make the shadow vanish.
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Going further

y

sound issues

pﬁr audio sounding its best with these post-production tools

Audio effects

Click here to access extra
audio effects that change
the sound in more creative
ways, such as altering pitch
or adding different room

ambience effects

Reduce

background noise

If background noise is
competing with your
interviewee's voice, tick
this box. Drag the adjacent
shiger to the right to get a
balance between reducing
the background noise
without flattening the
voice too much

.~ Adjust levels
A subject's voice

B should have levels that
occasionally peak yellow at
the loudest sections. Drag
this horizontal volume bar
up until the voice clip’s
sound is strong

i

Add
soun%ltrack

Use sound effects,
music and voiceovers

Once you've fixed your clips' recorded
audio problems, you can now start to
augment your programmes with extra
assets. iMovie's Sound Effects browser
is full of audio assets, from a collection
of Foley sound effects to a folder of
Jingles that suit a range of programme
themes and topics.
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GO EXTERNAL

For a professional voiceover, buy an
external USB microphone such as the
Yeti iwww.bluemic.com/veti/#). This
will create a more intimate-sounding
voiceover than your Mac's mic.

3

Pump up the bass
When you reduce
background noise, the
subject’s voice can sound
too flat and weak. Bring
back some of the lower
frequencies by choosing the
Bass Boost preset
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OF Add sound effects

In the Content Library panel, click
the Sound Effects browser. You can
then plunder the Sound Effects
and iLife Sound Effects folders for a
range of different stock sounds to
drag to the timeline.

el

Sound fixing tools
Click on this icon to
access iMovie's tools for
fixing sound. This will
surmnmon a handy Maise
Reduction slicler as well

KR the Fqualizer drop-

% down menu
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02: Incorporate
a voiceover

Click the Microphone icon to record
a voiceover. Use the slider to adjust
sound levels before you record so
that they peak healthily. Click the
Red button and speak.
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03: Bring in music

Go to the iLife Sound Effects Jingles
folder and drag a track to the
timeline. To stop the music from
competing with and drowning

out the dialogue, simply drag the
horizontal volume bar downwards.




Share directly to YouTube EEERIAES

Distribute your programme to the o to Facebook

world directly from iMovie E e Get your work seen on a host
to look and sound as good as it can, you can quickly

of social media outlets
w
7= and easily share your edited masterpiece with a

global audience thanks to iMovie's direct link with social media
platforms such as YouTube. YouTube enables you to create a
personal channel that fans of your work can subscribe

Once you've spent time getting your programme

to, so there are potentially plenty of people ready to be - L, s
impressed with your iMovie editing skills. b ' saaed 01: Click on share
y Facebook is a great place to get instant
feedback on your video productions from an
audience that knows you. Click the Share icon
and choose Facebook.

01: Choose YouTube 02: Select a size

Double-click to open up the project that you want In the next window, type in some keyword tags so 02: Chmse an audience

to share so that it appears on the timeline. At the top viewers can find your content. Choose an HD size You'll need to tell iMovie your Facebook login
right of the viewer, click on the Share icon. Clickonthe  such as HD720p (or the larger HD1080p if you shot in details. In the pop-up window choose a Size
YouTube icon. that resolution). — HD720p will be fine, Choose who can view

your uploaded movie and then click Next.
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| - 03: Slde-by-mde
03: Public or private? 04: Publish In the next window, click Publish. iMovie will

Choose a category for your programme and select A circular progress wheel will appear at the top right, notify you when it has uplue!ded edited
your desired privacy setting (to make your video indicating the progress of your upload. Then check programme to Facebook. Click Visit to see
public or private). When you're happy, click Next and out your programme an your YouTube channel and the video on your Facebook wall.

then click Publish, wait for comments.

Share with iCloud

Upload your files onto your iCloud for access over the web

Select the movie that you want to share by clicking on it in the Libraries panel. Go to
File=Share=File. Choose a resolution and quality setting, then click Next. In the next
window, click the drop-down menu and choose iMovie>iCloud. Click Share to upload
your movie. A Share Successful message should appear. Log into your iCloud account
in a browser and go to iCloud Drive's iMovie folder. You can play your uploaded
movies from there.




IGoing further

Master iMovie’ S Precision Editor

\chieve frame-accurate editing to create smooth-flowing sequences

r

-~ When filming a sporting activity, you can change your

Pl camera position to capture a subject using different
angles and shot sizes. If the action is repetitive you can

cut between different takes to add visual variety to the project. We'll
show you how to use iMovie's framne-accurate Precision Editor to cut
a series of action clips together, to make the subject’s action match
perfectly when we cut (or mix) from one clip to the next. This creates
a seamless sequence of shots. You can also fine-tune the edit point
to cut earlier or later to the next shot. Thanks to the Precision Editor
we can make the juggler in our supplied footage look much mare

preficient by cutting out mistakes.

- .
i MOVIE Produce frame-accurate edits

01: Import clips 02: Add clips to timeline

(50 to Projects and click Create New>Movie. Go to Shift-click to select Shot01, Shot02 and Shot03 in
File=New Event. Label it Juggling Event’. Click impart the browser. Click Shot03's + icon to add the three
Media. Browse to our supplied source clips on FileSilo, selected clips to the timeline. The three shots will
Click Import Selected, appear in consecutive order,
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03: View the clips

Play the footage. As the shots are unedited the action
doesn't flow as smoothly as it could. At the end

of Shot02 the juggler fails to pull off a trick that he
performs successfully in Shot03,

04: Add edit point 05: Set Shot01 out-point

Click on Shot01, Choose Window:>Show Precision Shot01 on the top is the outgoing clip. Shot02 below
Editor. Click the grey rectangular Add Edit Point icon is the incoming clip. Drag ShotO1's grey vertical edit
above Shot0Z, ShotO1 will jump to the top. Shot02 will point bar until the red-handled club is about to land in
stay on the bottom. the juggler's right hand.
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06: Set Shot02 in-point

On the bottom track drag Shot0.2's edit point bar to fine-
tune where it starts (jts in-point). Place the red-handled
club so that it matches the position of the same club in
Shot01's out-point.



Master the Precision Editor

Fine-tune an edit point’s cuts and transitions

SPLIT EDIT

When you cut between two clips
the audio will cut too. This can
make the cuts appear more abrupt.
When using the Precision Editor
you can drag a clip’s audio edit

handle independently of its video

edit handle, This enables you to

make sound from one clip overlap

another, which helps merge the
adjacent clips together in a less.
jarring way.

Play back the edit

To see how your cuts are shaping

up click in this middle grey bar
between the outgoing and incoming
clips. Tap the Spacebar to play the
sequence and see the cuts made

using the edit handle

07: Check continuity

Play the sequence and the action will flow smoaothly In Shot02 the juggler fails a trick. Drag Shot02's edit
between Shot01's trimmed out-point and Shot02's

trimmed in-point. Click the grey rectangular Add Edit right hand. Drag Shot03's edit point so the action

Point icon above Shot(3.

Refine an out-point

Drag an outgoing clips edit handle left to specify
an earlier out-peint for the clip. Drag the edit
handle right to create a later out-paint, The
out-point frame selected by the edit handle will
dappear in the Viewer

Add edit point

When you click a grey rectangle
| above a clip it adds an adjustable
edit point 1o two adjacent clips. The
outgoing clip appears in the top
track. The incoming clip appears in
the bottom track

- Use a transition

B4 Once you've matched the

4 movermnent between two cuts you
. can close it and add a transition
between an edit point. You can then
pop back into the Precision Editor
and fine-tune the position and
duration of the transition

Refine an in-point

You can refine the incoming clip's
in-point by dragging its edit handle
eft or right. Here we can match the
action in the outgoing close-up so
that the juggler's moves continue
smoothly in the incoming wide-shot

08: Match the action 09: Add a dissolve

Click Close Precision Editor. The action will flow
point until the three clubs have just left the juggler's smoothly (and without juggling errors). You can drop
a Dissolve transition between two cuts for a gentler

matches in the wider shot. blend between the matched moves.
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IGoing further

Keep your
Photos library
organised

Discover the top ten best ways to
keep on top of your packed Photos
ibrary on your Mac

Photos is the default app for all your iPhone pics,
and chances are you're going to be taking a lot
of them thanks to the iPhone’s stunning camera.

&

However, the problemn with taking so many wonderful shots
is that when you want to show them off to your friends and
family, it takes an age to trawl through them all and find the one
you want.

Luckily Photos has a whole host of features that ensure you

are never far away from your favourite photos, and you can sort
them in a range of ways to keep your albums fresh and easily
located. Here are just some of its options that mean you can
snap away to your heart's content without worrying you'll never
find that one amazing picture again.

BN ] L — i Wy ABmmie
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Createalbums ... =
Named albums are the = = _ _ :
best way to remember | i Er---_
that special holiday or =
party. Select a bunch - il et B s o
of photos by holding et e N

down Command and
clicking on individual
images, then click on
File=New Alburm and
name your album to
create a collection of
your chosen snaps. It
will then appear in the
Albums menu at the top
of the window,

Last import

This is another neat trick that
Phiotos uses to help you keep
track of your pictures. Click on

the Albums tab and then on Last
Import, which you should see on
the top line. This will always keep
your most recently added snaps in
place for quick and easy location.
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Share
your photos

One way to keep your
photos in check is to
share them on sodial

media. Photos makes
sharing your pictures very
straightforward. Select the
chosen photos or album,
right-click and hover over
Share, then click on your
preferred method.

Smart Albums

Srmart Alburmns are a great
way to get Photos to do
your organising for you,
with minimal effort on
yvour part. Tell the app to
create an album based
on certain criteria, such as
photos that you've edited,
and it'll do all the legwork
for you and stick the
completed collection in
the Albums folder.

Create

Memories

While making albums
and organising
images is easy to do
yourself, Photos can
offer a hand. As you
upload and impaort
images, the app will
scan for things such
as Holidays, places
or people and create
albums. You might
find photos you
forgot about!

Favourite
your photos

If there are certain images
in your Photos app you
know you're going to want
to see again or just love to
bits, hover over the photo
and tap the little heart that
appears in the top-left
comer. It will then appear in
your Favorites folder.
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Inside your albums

Take a tour through the most important tab in your Photos app

Shared photos

Remember which albums you have
sent around via ilCloud by tapping on
the Shared tab. This will help you keep
track of whao's seen what photos

Little and large

Whether you want 1o see a load of
alburms or just a few, you can move
the slider here up and down, altering
the size of the thumbnail images

Change slideshow themes
Alter how your images are displayed
by hitting the Play button at the

top of the window and select an
alternative style, such as Vintage Prints
or Crigami to add some individuality

s RN coomirs e & )
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Quick share

Share entire albums with your friends

Search
for photos

Use the same method
to tag a photo as to

add faces to it, include

a description of a place
or theme. That way you
can use the search bar
in the top right-hand
corner of the window to
quickly locate any photo
that happens to include
that particular tag.

Export images
As well as sharing your
images to keep them in
order, it might be worth
exporting them to an
external hard drive so
they are in a portable
format, Then, no matter
what occurs, you have
your albums safely
backed up and in order,
Hit File>Export then
Export photos.

and family in cnly a couple of clicks
by tapping on the Share icon in the
top-right corner and choose which
rmethod you want to use

AVAILABLE
EXTENSIONS

Image-editing extensions
for Mac from MacPhun are
already available to users
with the latest macO5.

These extension upgrades
cover the Tonality, Intensify,
Snapheal and Noiseless
apps and will help you
improve your pictures,

Recognise faces

Just as with Facebook, you can tag
peaple in Phatos. All you need to do 15
double-click on a picture with people
in, click the i’ button in the top right-
hand corner and select Add Faces. The
app will recognise faces so you can tag
themn. That information is then added
to the Faces album.

Sort it out

In the top-right corner
of Photos will be a
drop-down menu,
allowing you to filter
what images are
shown. You can choose
between Favourties,
Edited, Photos and
Videos. If you select

a group of images, a
counter will appear,
also in the top-right
corner. Right-clicking
the image icon next to
the counter allows you
to make changes.
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IGoing further

Search your library by objects

Use Photos’ object-analysing search tools to discover specific pictures with ease

Thanks to our continually growing collection of digital
photos it can be a struggle to find particular pictures,

= even if they are listed as chronological memaories. Photos
helps make this tedious task less of a chore by analysing your library
of images to categorise their contents. The new Faces section enables
you to find favourite people with ease, but what's less obvious is that
Photos can also recognise certain objects in a shot if they fall into
particular categories. So if you need to find photographs of cats or cars
then the Photos app can give you a head start in your search. Here's
how to make object-based searches of your Photos library.

Find specific objects

Make a search based on visual analysis of a photo’s content

Search field

To find photos that contain a specific subject
(such as a car), type the desired subject in the
Search field. Photos will search files visually for
relevant objects, plus it will look for appropriate
keyvwords in a file's metadata

MARVELLOUS
METADATA

Photos’ face and object-recognition
tools analyse pictures’ pixels to
produce search results. Photos

can also search an image file for
other information, such as the GPS
coordinates of where it was shot.
info attached to the file isreferred W - :

to as metadata. When you add Results
keywords, titles and a description P
to a photo this info is also stored in o2 e
its metadata. it

As you type in an object-based
search term a list of results will
appear in this drop-down menu. The
number of photos contained in each
search result are also displayed here
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Thumbnails

Click on a result in the Search field’s

drop-down menu to display the

object-based results as thumbnails,

For more detail, you can double-click

on a thumionail for a closer look at
the image

Hide failures
Here Photos can't differentiate between
two similar objects because it's not
contextually aware of the differences.
Right-click on a failed result and choose
Hide 1 Photo to remove it from the
current search results

=
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PhOtOS Find photos using objects

01: Scan the library

For cbject recognition to work, Photos needs time
to scan your library. It will also scan new photos as
they are added, so they may not immediately show
up in an object search,
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04: Search for objects

To try out an object-based search, go to the Albums
section and click on All Photos to display everything
in your library. Go to the Search field and type in an
object such as ‘water’.

Get clever

with keywords

Photos’ object recognition skills aren't
perfect. When we searched for pictures of
dogs many photos of cats also appeared
in our list of results. Object recognition is
a useful weapon in Photos' arsenal but it
can't win the photo-finding battle on its
own. To help Photos find specific shots,
it's good practice to add keywords to
your images. You can then find specific
subjects much more easily in the future.

02: Search for people

To check that Photos has been analysing your
photos for visual content, click on the People icon.
Photos will present you with thumbnails containing
shots of any people it can find.
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05: Choose a Category

A drop-down list will appear based on the search
term. It will also include any files that contain the
searched object as a keyword. If nothing appears try
using other terms for certain objects.

01: Add keywords
Click on a photograph to target it and then

press Cmd+l to open the Info panel. Type in a
description of the photo. Add as many keywords
you need to describe the content. Think ‘what,
‘who’, ‘where’ and ‘when’.

03: Object recognition

As well as recognising individual faces in your
collection of images, Photos can also recognise a
wide range of objects (though there is no Object
panel in the Albums section).
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06: View results

Click a Category to display all the files in your library
that contain that particular object. Photos can also
recognise certain objects (including animals) in
video files too.

02: Search for keywords

Once you've added keywords and a description
to an image's metadata, you can use the Search
field to display any photos containing those
keywords. This is very useful if an object- or
place-based search fails to find your desired shot.
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IGoing further

Take control with curves

Fix exposure problems by changing the shape of a curve in High Sierra’'s Photos

= With High Sierra OS, the Photos app now boasts a wider

“ range of image editing tools. One of the most powerful
new tools is the Curves panel. By changing the shape of a

curve you can selectively lighten or darken specific tones. This helps
you tackle problem shots such as our backlit start image. Due to
the scene’s high contrast lighting the camera has struggled to get
detail in both the shadows and the highlights. By adding points to
a curve we can claw back the castle's under-exposed shadow detail
without blowing out the sky's correctly exposed highlights. Curves
s an exciting addition to Photos, elevating it to a more high-end
post-production digital darkroom.

PhOtOS How to adjust exposure

01: Import problem picture 02: Summon histogram 03: Add control point

Go to File>Import and browse to our supplied Double-click on the imperted photo's thumbnail. In the Curves panel click the Add Points icon (at the
Backlit_start. NEF image. By editing a Raw format Click 'Edit’ Choose View=Show Histogram. The right of the three eyedroppers). Click on a dark part
file we can restore more shadow and highlight graph is peaking at the left, indicating strong of the castle. A control point will appear near the
detail. Click 'Review for Import. dark shadows. bottom of the curve.

04: Adjust the curve 05: Sample brighter areas 06: Fine-tune histogram

Drag the curve control point upwards to brighten Click on'Add Point. Click to sample some of the After making tweaks, go to the Light panel.

the shadows and reveal more of the castle’s detail. lighter clouds. This places a new control point near  Drag the slider right. The histogram graph will
The curve will bulge upwards and lighten some the top right of the curve. Drag the point down to now have a wider spread of shadows, midtones
midtones and highlights too. restore detail to the highlights. and highlights.
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Global adjustments

The Light panel brightens the shadows,
midtones and highlights equally. Once
you've created a more balanced exposure
using the Curves panel you can fine-tune the
overall exposure using this slider,

Find your way
around Curves

Selectively lighten shadows
and darken highlights

Adjust control points

By dragging a control point upwards you
brighten the tones on the underlying histogram.
Here we're predominantly lightening the
shadows towards the left of the histogram,

' Darken highlights

This control point overlaps the brighter parts of
the histogram, By dragging it downwards we

can darken the highlights and midtones to help G
stop them from being over-exposed, ~

ABOUT CURVES

By default the curve is a straight diagonal line
overlapping a histogram. The bottom left of the curve '
adjusts the shadows at the left of the underlying L7 .
histogram. If the curve bulges upwards in middle ; Add control point
this will brighten the midtones in the middle of the
histogram. Adjust the top right of the curve to alter the
highlights at the right of the histogram.

This tool enables you to add control points

to a curve more accurately. Click on this icon
and then click on a problemn part of the photo
(such as the under-exposed castle). A control
point will appear on the part of the curve that
controls the sampled tones.

Creative
colour curves

On your Mac’s display each photograph's
colours are reproduced by mixing Red, Green
and Blue channels together. By default, the
new Curve tool changes the brightness of
the RGB channels equally to create lighter or

darker versions of the shot’s colours. However, 01: Warm up the shadows 02: Golden hour effect

if you tweak an individual colour channel’s Import our Creative_start.NEF file and click on Set the Curves channel dropdown to Blue. Click
curve independently of the other channels the Edit button. In the Curves panel, set the on the curve to place a control point near the
you can produce creative shifts in colour and RGB drop down to Red. Drag a shadow control highlights. Now drag the point down to reduce
mimic old-school darkroom film development point upwards to lighten the Red channel and blue in the highlights and create a sunset

techniques. Here's how to get started. .. warm up the shadows. ‘golden hour'look.
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IGoing further

How to use Drum Designer

Discover how percussion levels can be adjusted via a special plugin

When you start a new drum kit types in various ways, all of which

GarageBand project, finding can be customised. In this guide we'll look at

a rhythmic groove can take a control element that lies behind the usual
time. Thankfully the growing roster of Drummer Editor - the Drum Designer. This
Drummer players is a huge help for instantly  useful Smart Controls panel defines more
adding intelligent percussion patterns acutely the volume or attack levels for each
that organically follow other tracks or element of a Drummer’s kit, toggling them
performances. These virtual players span on or off and also applying any additional
a myriad of genres and use their different plugin effects.

Get to grips with Drum Designer rick up the beat

e —

01: Acoustic Drummer 02: Smart Controls

To start, have at least one yellow Drummer track Rather than click the Editors button to open the
selected within your project featuring a real kit- Drummer Editor, view the Smart Controls via the
playing player. In this instance we're using Anders adjacent button top left or with the B key shortcut,
from the Rock category. showing the Drum Designer.

04: Drum levels 05: Toggled off

Each drum element from kick (bass) to percussion Regardless of which kit pieces are played within the
has a dial that quite simply sets the volume of that Drummer pattern, each element is turned on here.
kit piece within the output of the Drummer track’s Clicking the adjacent lit button actually switches
selected pattern, that element off,

142 Mac for Beginners

- o

03: Solo and cycle

From here it's useful to solo the track via the
headphone button in the header, cycle the
Drummer regions in the project timeline and press
play to preview adjustments.

=Sy

06: Electronic instead

Those Drummers playing electronic kits show a
vastly different set of synthesizer controls instead.
The same principle applies however, with dials for
each virtual element.



DESig ne r d@ta i IEd Compression controls

Compression is an extra track plugin often

Acquaint yourself properly with the wood-clad Drum applied to Drummer by default and is useful for

Designer panel found within Smart Controls rriaking druns tighter and punchier. These extra
controls turn it on or off while also adjusting the
amount applied

Drum Designer plugin

The Drum Designer is actually a plugin found
within the inspector of the Smart Controls
panel for any actual kit-playing Drummer, Extra
plugins listed in the box below will add controls
such as compression or effects, giving you full
control aver the rhythm you want

88 Effects selectors

i These effects controls often vary from
Drurnrmer to Drummer, reflecting any
extra plugins applied in the inspector,

M Usually they adjust general drum tone,
brightening or deadening it, along with
adding Room' revert for mare natural
sounding ambience

Drum Kit Designer
Also often labelled as MIX, this set of six dials
and toggle buttons sets the level of each
piece of featured kit, enabling elements to be
switched off entirely or raised and lowered in
volume, just like real microphone channels

o

SOME NATURAL
BALANCE

The real value of the Smart Controls

for natural kit or electronic Drummer
tracks is in balancing the performance,
Adjusting the volume or attack of a kit
part, whether it is drum, hi-hat, cymbal
or percussion, is useful for emphasising
those hits, strikes or fills within a pattern.
This is worth remembering as an
advanced customisation technique for
achieving a more natural result.

Picking
Kit parts

Most commonly, the kit parts or the drums

being played are defined within the Drummer

Editor (E) panel. Here you'll find a visualisation

that doubles as drum kit controls for toggling

on or off elements of the kit itself, before the

sliders and knobs dictate the number of fills. 01: Helping hands 02: Percussion power

Obviously this will determine what the Drum First we'll show the Drummer Editor on our If we switch back to Smart Controls and the
Designer within Smart Controls can do, so in selected Drummer track in our project. Here Drum Designer knobs, we can adjust the

the following steps we'll take a look between we will click on the ‘hand’ percussion icon to applied handclap percussion selection. Raising
the two panels at how one dictates to the add handclaps to the pattern. To add enough the level right up will elevate and emphasise its
other and observe the impact. audible fills, we have the slider set to two. volume, whereas dialling it back guietens it.
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IGoing further

Keep time with Tempo
Track techniques i

For new GarageBand users, perhaps for the project tempo to be changed mid-song
the single most important concept to using a Tempo Track and a series of automation
master within GarageBand is tempo. All points. This is vital for keeping time the way you
music projects are built around a predefined global want for certain passages within broader and more
tempo, measured in beats per minute (bpm} and complex compositions.
set within the control bar's LCD. Beginning from a
fairly typical 120bpm, lowering or increasing the i Th :
tempo will dramatically dictate the pace of your e J[e m pO S

project, most crucially rhythm loops or Drummer d : b ]
tracks. Importantly though, GarageBand also allows m eaSU re | ﬂ 0 m

Tracking down tempo

The timing tools you'll need to keep the beat flowing

Project tempo display

The current project termpo is

FLEX TIME measured in beats per minute, with
EDITING new projects created at 120bpm.

It is displayed within the control

bar LCD and can be clicked and
dragged, or double-clicked to edit
the Tempo field

GarageBand implements
tirming tweaks within
audio regions using

Flex Time, applying this
automatically when
groove matching. This
can also be toggled on
manually by enabling Flex
within the Audio Editor
inspector. Clicking a peak
or ‘transient” within the
audio waveform adds a
flex marker, which can

be clicked and dragged
to stretch the timing out
or compress it — making
more precise timing edits.

The Tempo Track

Project tempo changes can be au-
tomated throughout a song using
the tempo track. This is displayed
by choosing Track>Show Tempo
Track from the main menu bar and
can be expanded out as required

Groove Track
Tracks can have their timing Tempo points

synchronised around a nominated Changes are defined within the tempo
groove track, denoted by the gold track by editing points that plot the
star within the header. Subsequent bpm shifts within an adjustable range.
tracks are then told to follow by

N ' Points can be added, deleted, moved,
ticking the Match Groove Track box copied and used to form gradual
to the left of each header curves just as you would automations
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01: Set beats per minute

Projects begin with a tempo, typically set at
120bpm. The tempo is shown and easily changed
via the control bar LCD — just click and drag it.
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04: Plot tempo points

The Tempo Track shows a line for the base- level
project tempo. Raise or lower bpm above ar below
this line by double-clicking the target time paosition.

How to sync
track timing

With the tempo set, you may still find
that certain tracks are not quite locked

in when it comes to timing. This tends

to apply more to recorded performance
or real instrument tracks where the
musician’s timing may have strayed
slightly for whatever reason, GarageBand
helps you counteract this by choosing a
Groove Track that subsequent tracks can
follow and lock themselves into.

[T
I }in
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= e

02: Edit overall tempo

Double-click the Tempo count to enter a specific
bpm. The change immediately dictates the pace of
loops for tracks adhering to overall project tempo.

05: Position points

Tempo points are dragged up and down, or you
can position them numerically by holding the
Ctrl+Alt+Cmd keys when you click the target time.

e

i B [ 8 L]
[ 1 3

01: Choose the groove
The Groove Track is the constant rhythmic
bedrock through a project, such as a bassline,
Show it via Track>Track Header>Show Groove
Track before hovering over the edge of the
selected header and clicking the star to select.
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03: Show Tempo Track

You can use the Tempo Track to slow or speed
up the bpm throughout the song. Show it via
Track>Show Tempo Track or with Shift+Crmd+.

06: Ensure smooth transitions

Make tempo shifts more gradual by dragging the
black dot that appears above or below a second
point. Click and drag to draw a smooth, curved line.

e Me— b
e e

02: Match other tracks

Other tracks are matched to the chosen Groove
Track by ticking the boxes situated to the left

of each track header. These can be toggled on
and off instantly to preview, applying Flex Time
markers to the region to affect the change.

ee—
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IGoing further

Learn to stay in tune
with the Tuner

Make sure your instruments sound right with GarageBand’s handy note checker

instruments and layering tracks in GarageBand.

S0, thoughtfully, Apple’s masterful music maker
provides a pop-out Tuner within the control bar,
most commonly intended of course for guitar
(EADGBE) and bass (EADG). Working from either a
direct instrument signal or via an input microphone,
it's an essential tool we'll examine in full across the

When it comes to harmonious music,

the idea of staying in tune is non-

optional. It is the solid cornerstone all
musicians start from, knowing that when striking
a note or fingering a chord it should sound as
expected. Vital, therefore, when playing in an
ensemble. Staying in tune is equally important

when composing alone, recording your following steps.

GaraQEBand Tune your GarageBand instruments

02: Select a track

01: Use track with input

To get started with the Tuner, you need at least
one active project track. You also need that track to
have an input signal from an instrument interface
or microphone,

For example, we have three tracks for a connected
bass and guitar, plus a vocal track via microphone,
With either selected, click the Tuner button within
the control bar,

. ool

COMF DI T

RO O Jéﬂ
04: Hit the centre

The indicator, shown in 'cent’ points, moves from
left to right (orange). Crucially the desired position
for tuning the signal to the nearest keynote is in the
centre (green).

05: Sound a note

If tuning a four-string bass guitar, the strings are
typically tuned E, A, D and G. Plucking each tells
us if it is flatter (left) or sharper {right) than the
centre note,
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03: View Tuner window

The Tuner pops out above the project workspace
and will be active immediately if your track has
signal. Any detected noise should show the
indicator moving erratically.

GE  DeETORR

608
06: Tune up flat

When a string, for example, is flat it needs to be
wound tighter at the tuning peg. By making big or
gradual winds while checking the Tuner, the aim is
to move up the pitch.



Pitch perfect

Find your way around the Tuner’s core controls

Graphic tuning display
This gauge visualises the pitch fluctuations
of a note, in a scale of cents. The position at
—— 12 o'clock shows comect tuning, while left

of centre means the note is flat with right of
centre being sharp

i P

Mute button
Denoted by the M in the bottom
right corner, this button mutes
the input signal going into the
Tuner from the project or active
track. With this on the Tuner
display is inactive

Accurate tuning

As a rule of thumb, tuners

rely on a clear detection of

a single instrurmnent’s output
with no agditional noise, Extra
Rackgrounag sounds will throw
off the accuracy, proving less
of a problem when working
from a direct input signal from
electric guitar or bass. If tuning
an acoustic instrument o

Reference tuning field The keynote display

This setting stipulates the pitch to be
used as the basis for general tuning.
Defaulting to 440Hz for the note A, it
can be adjusted by dragging vertically

This main indicator shows the target pitch

of the currently detected note, to the closest
tuned pitch. To the right is the Tune Deviation
display, showing more accurately the number

indeed singing voice via a mic,
minirmising distractions will
improve accuracy

between 410-470Hz, although it
shouldn't require changing

of cents for any deviation ‘_! !
3. N - V

09: Explore additional options

07: Tune down sharp

Conversely, if the sounded string or note pushes The closest detected keynate is the centre point The Tuner has two extra controls. Left of the

the indicator right of centre, then it is sharp. and shows green, dencting the sounded note as keynote is a Reference Tuning field for moving
Winding back the tuning peg will drop the pitch tuned. Ideally, you want this to be as centred and outside concert pitch, while the M in the lower-right
down until correct. steady as possible. corner mutes the input.
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IWorking with

Lea rn hOW tO th_r,g ; . Manage

makethe mostof @YW |= = ==h 4P
productivity apps —— =
to work smarter —
either at home or
in the office

150 Master the new features of Notes
Learn how to insert tables in Notes

7

152 ngdp yr:ulé'r cx:!:'wtacta inan Pages,r Nurn berS

dadress Doo

Keep your contact info all filed away a n d Keym O.’[e
154 Build documents with Pages alre a ” (—:’XCE“ |ent

Create CVs, reports, posters and more .

office apps, anad

156 Create and st :

Pages template snould easily

Make your own template to use in Pages

cover most of

your needs’

Personal Finance

Personal

Business

Education

158 Create a spreadsheet in Numbers
Spreadsheets become exciting with Numbers

160 Visualise data in Numbers

Convert your spreadsheets into graphs

M Y Ol O 0

162 Keep notes to help you present
Make the more of Keynote's
presentation tools

160

Visualise your
Numbers data
with charts and
graphs
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IWorking with macOS

Master the new
features of Notes

The improvements in Notes in macOS High Sierra make

the app even more useful

Apple has tweaked the Notes app in macQOS High Sierra and has
added a couple of great new features that you are sure to find very

— useful. One is the ability to pin notes and this means that important ones eV

or ones that you often refer to can be made sticky in the sidebar list of notes.
They stick to the top and are not pushed down when new notes are added.

The other great new feature is the option to insert a table into a note.
Previously you had to use spaces or tab characters to put items into columns
and rows, and frankly, it wasn't that good. Now you can add a table and it
makes storing certain types of information much easier.

NOtES How to insert tables

%
r. FHTIRm
L Bwcinn o romd
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01:Create a note

The toolbar in Notes has buttons for all the functions,
but buttons may be hidden if the window is too
narrow. Make sure it is wide enough and click the
‘New Mote'button.

04: Add extra rows

Use the Tab key to move from cell to cell. Place

the cursor in the last cell in the bottom right corner
and press Tab again to add an extra row of cells to
the table.
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02: Insert a table

Click the new insert table button to add a table to
the note. It has only 2x2 cells and no obvious way
to add more, but we will see how to extend it to the
size we need.
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05: Add more columns

There is a little gadget above the column with the
cursor in, Click it to select the column. Click the
down arrow on the right and select ‘Add Column
After'or’.. Before!

New in Notes

03: Fill in cells

There are four cells in the table. Click in a cell and
then start typing to enter any information you
want. If the cursor is in the first cell, tab to the one
on the right.

-----

06: The rows menu

Place the cursor in a row and click the gadget on
the left of the table. Click the down arrow and you
can add rows above or below, or delete the row
from the table,



New Iin Notes
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Table gadget
This little gadget at the top and on
the left is used to select a colurmn or
row in the table. Drag colurmns left or
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Insert table

Click this button to insert a table into a note.,
It is initially only 2x2 cells, but mare rows and
columns can be added to make it as big as

vou need,
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Row/column menu
When a row or column is
selected by clicking the gadget,
there is a little down arrow in
the corner, Click it to add or
remove rows and columns in

the table.
B LOCKYOUR NOTES

MNotes are stored on your Mac's disk, which is encrypted
and also in your iCloud account, which is secured
online. However, you might still want to lock your
notes, perhaps because other people use your
computer. Notes can be locked with a password by
Ctrl-clicking the note in the sidebar and selecting ‘Lock
MNote'from the menu.

Pin your T |

(S Lt 1
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The number of items in the Notes app i e e Checkte
steadily grows as you use it and, unless you i S i

spend time deleting old notes, you probably e o

have quite a large number by now. Notes T

with important information can be buried 01: Pin your notes 02: Unpin pinned notes
right down near the bottom of the list and Don't let notes that contain important or often Pinned notes appear at the top of the list

this can make them hard to find, or at least used information end up at the bottom of a where they are easy to find. It's hard to see,
tediously slow. There are no sorting options, very long list of notes. Right-click the note on but the dividing line between notes is slightly
so the notes are in random order. Here is the the left and select ‘Pin Note' from the menu thicker after the last pinned note. Right-click on

solution for hard-to-find notes. that is displayed. a note to unpin it.
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IWorking with macOS

Keep your contacts

in an address book

Get to grips with the Contacts address book and master its iOS-like layout

Often overlooked, the Contacts app
‘ (previously known as Address Book) is

an important element of macOS. While it
might not be the first thing you open in your dock,
it's the hub for all your contacts and makes sure that
apps like Mail run a lot more smoothly. It seems only
fair, then, that the address book was given an
overhaul in El capitan, too. It now sports a cleaner,
simpler interface that before. It is easy to create and
edit contacts and you can also share them

01: A whole new look

The first thing you'll notice about the app is that its
view is very similar to that of its counterpart in iOS.
It's looking a lot cleaner, for one thing.
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04: Business and pleasure

Contact details can be categorised by type, such as
work or home. Click on the type next to the detail
and select one from the list to change it.
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152 Mac for Beginners

effortlessly. Managing your database is easy too as
the app can sniff out duplicates and merge them
with existing contacts in a single click. You can also
create Smart Groups by entering what criteria to
include and omit. Read on to find out more.

"An overlooked but
important element”

ContaCtS Explore your address book directory
Y
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02: Find a friend

Searching is as simple as typing a name straight into
the search box. Results are displayed in real time
and Contacts will highlight any matches.
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05: All a Twitter

You can add new fields, such as Twitter usernames,
to this version of Contacts. Clicking on a Twitter
username will take you to the Twitter app.
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03: Add an entry

Click on the + icon under your contacts to add
a new one. You can change what the default
temnplate includes in Contacts’ preferences.
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06: Share the details

Click on the Share button underneath a contact
card to email that contact to sormebody else.
Contact cards will be attached in vCard format.



Navigate your contacts

Find your way around the address
book’s interface

i0S-like interface
In keeping with El Capitan’s move
to be more like i05, Contacts sports
a new interface that is very similar
to the one found on the iPad or
iPhone. And like 105, it’s clean,
simple and textured
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Create new contacts TG
Clicking on the + button at Buiness
the bottom of the interface Cowarkers

Famiy
Foolball Team
Frivenirin

will allow you to create a new
contact card into which YOL
can enter all manner of details.
As you will discover, building
up a database rarmmed with
contacts is incredibly easy

Getting social

Contacts includes contact detail fields
such as Twitter, Facebook and Skype
usernames, allowing you to easily
ntegrate sodal media details into your
ist of contacts for quick access. They
are even compatible with the native
Mac apps
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BACKING UP

In macOs5, it's fairly easy to make
a backup of your contacts. Under
the File menu, click Export, then
‘Address Book Archive. ... Give
the file a name and choose
where to save it then hit Save. To
import contacts from a backup,
select Import from the File menu
and find your backup file.

Sharing is simple

The Share button makes it even
quicker to send contacts. It's fully
integrated with Mail and certainly
saves a few mouse dicks when it
comes 1o sharing your details
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07: Get a group

Clicking on the View menu will bring up the option
to Show/Hide Groups. Activate it to bring up a side
column with all of your groups listed.
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08: Smarter grouping

Smart Groups allow automatic grouping of contacts
by certain details. Click ‘New Smart Group. ..’ from
the File menu to set one up.
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09: Look for duplicates

Click on the Card menu and choose the Look for
Duplicates option to source multiple cards and
merge/delete them from your database.
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IWorking with macOS

Build documents

ith Pages
e At first sight, Pages looks just like

= a word processor and it's true that

it can create simple letters and

documents. However, there is a lot more to

this application, as it can create visually exciting
publications such as flyers, posters, newsletters,
brochures and much more. The app has been
designed to make the task as easy as possible,

Whether you need to create a letter, CV, work report, poster or
newsletter, Pages is perfect for the job

and this edition has some great features. For o -
example, there are some fantastic templates

to get you started, as very often creating a

publication is just a matter of selecting a template

and replacing the text and images with your own.,

It's brilliantly simple. Other new features in this

|latest version include interactive charts, sharing

facilities on iCloud and a whole lot maore.

“This edition has some great features”

PageS Create publications from templates

O b Femdibe

01: Select a template

When Pages is started, click the New Document
button to open the template browser. When Pages
is open, just select File>New, then pick a template.
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04: Format the text

When text is selected, the panel on the right
provides all the formatting options you need, such
as font selection, alignment and so on.,
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02: Edit the text

The template contains text and images, but it's
easily replaced. Double-click on the heading, for
example, and type in a new one.
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05: Layout options

Select the Layout tab in the panel on the right to
access features such as multiple columns to give the
text a newspaper or magazine look,
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Click the picture icon in the corner or Ctrl-click
a photo to replace it with one from your iPhoto
library, iCloud or photo stream.
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06: Expand sections

Many options are hidden, so click the triangle next
to each section heading to expand it. Expand
Spacing, for example, for line spacing options.



Master the Pages interface

Tools and features for document design Sharing options
You can share links to the file on illoud where it

can be accessed with a web browser. Alternatively
the file can be sent via Mail, Messages or AirDrop.
This makes accessing it far simpler

The toolbar

The toolbar lists all the iterns you can insert into
a document, such as shapes, photos, music and
movies, charts and tables. Hidden cormments can iCLOUD

be added too, for help during the design process
SHARING

These document files

can be created on your
Mac's disk drive, but

there are advantages to
storing them in iCloud. For
instance, this makes your
files available on all your
Macs and i0S devices, so
you can begin a document
on the Mac and continue
on the iPad and vice versa.
Pages documents shared
on iCloud can be accessed
by anyone you give the
URL to, which means you
can get instant feedback.
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Interactive charts

Interactive data charts o M

can also be placed in your T ittt Sy e Style and layout
documents. The buttons :E_.".'E__.L‘"’.’: Wes Mewre b emmnfy : The Style and | ayout tabs
that are displayed next to St e, R automatically change
them enable you to step et - : depending on the text or

object that's currently selected,
This whole panel is replaced
with new options when
working with charts and photos

through different data
values and instantly see
the changes in action
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07: Add shapes 08: Shapes and text 09: Share it

Click the Shapes icon in the toolbar to add lines, Add a shape, such as a speech bubble, drag it into Click the Share button in the toolbar to access the
arrows, curves and predefined shapes. Click the dots  position on the page, click inside it and you can easily  sharing options. The document can be put on
at the bottom to view the items, enter some text, iCloud and links shared on Facebook and Twitter,
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IWorking with macOS

Create and save a custom
template

E7 One of the reasons many people

Save your best ideas permanently within Apple’s
word processing app

uncommon to be unable to find a template that
really suits your needs, but thankfully Pages still
has you covered. Users are able to create their
own custom template, save it and then use it
whenever they see fit. Plus if you're really proud of
it, then Pages also has a share feature where you
can distribute your new template to friends and
family. Here's how to go about it.

will use Pages as their primary app

for creating documents is the vast
selection of templates that can be used. The
templates are a great way of getting a starting
point of what you want your document to
look like, before you go ahead and add your
Own Twists. However, on occasion its not

"Pages also has a handy share feature”

PageS Design your own template

|||||
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01: Start from scratch 02: Add basic text 03: Format text
Use the Format menu to bold, italicise and alter the
colour of all the text, You can also use this menu to

change the sizing and spacing.

Open the template chooser in the Pages app and
select the Blank template at the top of the window,
This is the blank canvas for a custom template.
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04: Import images from Photos
Open the Media tab from the toclbar and select
Photos, Highlight a photo to import and press the
Insert option on the bottom right of the window.
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Select the Text tool from the toolbar and add text
elerments to your template in the boxes provided.
You can make it as brief or as convoluted as you like.
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05: Alter image style

Mow use the side menu to alter the components
of your image. Formatted images are a great
placeholder for any future images you import.
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06: Add extra elements

Add the further elements of your template, via

the toolbar. You could add secondary images, or
perhaps a new table, chart or other form of media.



Manage custom templates

Permanently save your custom template creations

Edit names

To make your custom termnplates more
recognisable, double-click the default name to
edit them. When you then click off the name,
you should find it automatically saves

My Templates
When you load up the
Template Chooser, you'l
find the various different

opticns listed down the o
left of the window. Select ) il F

the My Templates option 5 /

at the bottom to find all o
of your creations

of T.: T
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Delete a template

Right-click on any template and select the
Delete option if you're looking to cut down
on your library of ternplates. Be warned,
there's no way to recover a deleted template,
50 use this option wisely

BORROWING
ELEMENTS

One of the best ways to
make your own template
is to borrow the best
elements from Pages’
other default templates. A
simply copy and paste on
the elements you like can
help you put together the
perfect custom template
without having to design
it all from scratch. Don't
worry though; you can
still save it as an original
custom template!

Choose to share

You're able to send your
custom templates 1o various
contacts by using the Share
option that sits on the toolbar
within Pages. There's a plethora
of different sharing platforms to
choose from

African Wildlif

Cicy o & safaril

07: Save as Template 08: Give it a name

Open the File tab before selecting the Save as Double-click on the name of your custom template
Template option at the bottom of the menu, when to change it {in the My Template section). Back out of
the custom template is done. Wait for it to save. the menu to permanently save it once you'e finished,

African Wildlife ® o

09: Share your template

Use the Share option at the top of the menu to
send custom templates to contacts. For a quick
solution, use AirDrop to send it to nearby devices.

Mac for Beginners 157



Working with macOS

Create a spreadsheet

Ensure your data is well presented and calculates perfectly with
the excellent spreadsheet features of Numbers

in Numbers
Spreadsheets may scare you, and with
iil good reason - they are not always
easy to use. Microsoft Excel is a very
powerful spreadsheet program, but it's complex.
So is Numbers, but it delivers all of the functions
you need in the simplest way possible and it even
offers up explanations to help you out. With a
range of templates and the ability to add tables,

‘It de

resize them, calculate and choose from a range of
maths options, you will soon be populating your
tables with reams of data.

You aren't confined to one sheet either, as you
can edit multiple ones at once by selecting the
Sheet button in the toolbar. Numbers makes it
easy to work with each one, providing you with a
tabbed options pane.

ivers all of the functions you need”

Numbers Get to grips with spreadsheets

01: Choose a template

First choose from a selection of useful, presentable
templates. They are sorted by categories including
Business, Personal Finance and Education.
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04: Resize tables

By using the arrow icon in the bottom-right-hand
corner of a table, you can resize it, Refer to the row
and column numbers for guidance.,
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02: Input data

We've selected the Basic template. Spreadsheets
hawve rows, columns and cells, so click each cell to
add data. You can use words and numbers,
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05: Alter the colours

Now choose cells to colour. Click the Cell tab, click
Fill and select Alternative. To change alternate row
colours, click Alternating Row Colour under Table.

03: Add new tables

As well as using the table in front of you, try adding
more via the Insert>Table navigation. Table types are
shown in the right-hand box.
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06: Add formulas

Click a cell where you want a total to be displayed,
For a simple sum, type =SUM’. You'll need to define
cells to work with,



Find your way around Numbers

Make presentable spreadsheets within minutes

Title

lap the word Untitled-Edited at the top of the screen
and input a new name that best describes the project
or spread you'l be working on. You can save this to the
iCloud and to your Mac
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The table

A table is made up of
rows and columns and
can be a combination
of words and text. You
can change the table
make-up in the Options
vindow to suit whatever
kind of table you're
looking to create

The tabs

This window lets you view the options available for
the overall table, cells, text and the arrangement of the
spreadsheet, Try clicking on each one 1o discover what
editing options it offers

HIGHLIGHT
CELLS

When creating a formula
for your spreadsheet, you
don't have to type in the
table co-ordinate (such as
B2, C9 and s0 on). You can
simply start off the formula
{ie =5UM) and then click on
the cell that you want to
form part of the formula,
similar to Microsoft Excel.
This is very helpful for
speeding up the process of
calculations and eliminates
any potential errors.
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Add functions

If you want to add a
particular function, a table,
a chart and more, then just
use the toolbar icons at the
top of the screen for easy
access. This makes creating
and adjusting your tables
much simpler
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07: Produce the sum 08: Calculate rows 09: Change text
To multiply the final two boxes by our first, type You can also calculate rows. Available functions Of course, spreadsheets aren't just about numbers,

=SLIMIB2x(B3+B4). Copying and pasting this cell
speeds the task for the remaining calculations,

appear in the right-hand panel and each of them is You can control the size, font, wrapping and style of

categorised and explained in full,

text under the Text tab in the right-hand panel.
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Working with macOS

Learn to visualise data in Num

Turn mundane data into something special
with the help of charts and graphs

One of the best things about Numbers  fantastic chart and graphical options that help o

“I | isthatit's a great place to manage all add a visual aspect to your data.
your data in a single area without Each chart you choose to use to represent
having to use any third-party alternatives from inputted data can be heavily customised to suit
the Mac App Store. Although having pages of your specific tastes or the data it's based on. Use

data may be beneficial to you, it can be difficult to  the following steps to learmn how to completely
read and differentiate between when not labelled  visualise from top to bottom and create the
appropriately. However, Numbers includes some perfect accompanying charts.

"Numbers includes some fantastic chart
and graphical options’

Understand your options

Numbers includes various
features to explore...

i Dl O E
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Lay out your page
Highlight your chart or table and
use the icon that appears in the top
left to move it around the page,
Use the guidelines that appear 10
cormectly align it with all of the other
elements on the page

Add the basics

Make sure 10 add a title and
reference points to any chart you
create, so that any other person
whao views it will know what it
represents. You can also edit the
labels that come with each chart
e [ I
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SHARE WITH FRIENDS

If you want some input on your page,
make sure to use the Share option
at the top of the program. Using

this will enable you to directly save
and send the page to any number
of contacts. They'll be able to make
further edits to the page and then
send it back to you to check out.

Edit data

The right panel is the hub for
all the customisations and
edits you're able 1o make. Use
the tabs at the top to switch
between different sections

Troubleshooting

If your chart isn't showing data
when you generate it, make

sure all the data has been added
correctly. Any errors will leave you
with a completely blank table



B i ]

01: Input data

Create a table of data in Numbers. Apply various
colours and stylise the table using the toolbar
located on the top of the program, if necessary:.

=“ II' | ..|. |

04: Edit data
After selecting the chart you want to use, your data

will be applied to it on the page. Select it and press
Edit Data References to begin adding changes.
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07: Move data
Select the Distance from Center option to move a

portion of data away. This is a good choice if you
want to highlight a specific section in a pie chart.

UMbers create charts in Numbers
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02: Select a chart

Highlight all the data and select the Chart option
from the top of the menu. By default, you'll be able
to see the array of 2D charts that are available to use.
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05: Background and borders

The right side panel will now be filled with
customisation options. Use the drop-down menus
to add a background or add a border.

To change how your data is displayeq, highlight the

chart and select the Chart Type option to convert it
into a completely different chart altogether,

»
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03: Interactive charts

Select the Interactive option if you want to use a
chart that can be heavily edited and is generally
more appealing to look at.
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Double-click on a specific part to edit data. A new
Data section will appear on the right side of the app
for you make further edits.
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09: Final edits and arrangé

Make final edits and line them up on the page.
Guidelines will appear, letting you know when each
one has been lined with the other items.
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IWorking with macOS

Keep notes to help you present

Create presenter notes for you to refer to
when showing off your Keynotes

Keynote makes it simple to create Keynote doesn't just stop helping you. When you

m fantastic presentations, thanks to its stand up in front of a group of people and give
== easy-to-use but surprisingly powerful your presentation, it can still help you.

tools. Whether you want to create a simple text- You can use the Notes tool o write down
based presentation or you need something a little important points that will display on your Mac's
more creative, with images, videos and screen, so only you see them. It not only makes
animations, Keynote gives you all the tools you presenting easier, it will also make you look
could possibly need, all with just a couple of clicks.  incredibly professional, and preparing your notes
But once you've created your presentation, doesn't take long at all.

by wporiaes of tha boction o wgards m e ren of tha g

"Keynote gives you all the tools you need” | ™™

Presentation screen explained suisremaining Close the presenter

: You can see the number of builds If you want to exit the presenter at
Understand INng h 'I:]"-.-"-.{ 1O use remaining on each slide above the any time you can click the 'x’ button
KE}#I"!GtErS presentation tools right-hand box. This will only appear in the top-right corner of the screen,

if you have applied animations to or simply press Escape to go back to
your slides before hitting Play your normal Keynote window

e ——ee il
Coloured bars 16:12:21 00:00:00
The bars at the top of the - Current: Slide 7.of 7
screen denote the status of your _ i e ; ® Builds Remaining: 2

2 resentation. Green means you
are ready to progress to the next
slide or animation with a click,
while red means it's in the middle
of an animation

Next slide

On the left is the screen that your
viewers can currently see displayed
on the external display, while the
right-hand box shows what is
coming up next, either in terms of

; _ : | can see, the sun rose high in the cyan sky..
animations or slides boud fhe sty

lar, LT

KEYBOARD
SHORTCUTS

When you use this view to work
with your presentation, you can use
a number of keyboard shortcuts to
make your life easier. For example,

with a single keystroke you can
pause your presentation and turn
the screen white or black, or skip
back and forth through individual
builds or whole slides. To see the full
list of commands, click the 7 icon in

the top-right. _
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KeyI'IOte Add presentation notes
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01: Open Notes

Open the Nates viewer, Open a Keynote and
choose View>Show Presenter Notes 1o bring up the

Notes section at the bottom of your window

Formal  Amangs  View Share  Window  Help
Play Sideshow

L Fecond Sldeshow. . e L
Fioy Hedis Commen

| Customae Preserter Display. .. |

04: Start rehearsals

Once you've finished your notes, you can start
rehearsing your presentation. Choose the Flay

aption and select Rehearse Slicdeshow,

As yvou can see, the sun rose high in the cyan sky...

+ TaW aboul Mme hisiony
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07: Edit your notes

Change the size of the notes in your Rehearsal view
by clicking the bigger or smaller letters in the top-
left of the Motes bar, or click Edit to make changes.

As you can see, the sun rose high in the cyan sky...

02: Add a note

[0 add a note, click in the new bar and type it in
The Notes section will remain at the bottom of the

window even when you switch between slides.

00:00:11

05: Customise your screen

[o customise your view, click this icon in the top-

right and choose the options that you want to

appear on-screen while you present.

L] L]
08: View your slides
If you want to see an overview of all vour slides, click
the Show MNavigator button in the top-left and type

in the slide number in the top box.

w (A

El'l_ i

As you can see, the sun rose high in the cyan sky...

+ Taik aboul the hisiony
v Bpediiste on e origins

03: Format notes
Click on the Format button and you'll have options
for customising your notes. You can change fonts

and colours, and add bullets it necessary

A U AN ihe pun rooa tegh i the opan iy,
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06: See your notes

Make sure the Notes section is ticked and you'll see
that vour slides move to make room at the bottom

of the screen for the notes vou previously wrote.
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09: Play your slideshow

II"'lI

When youre reaay to present, connect your Mac
up to an external display or projector and hit Play to

start with your notes appearing on your screen,
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I Essential apps




The ultimate guide to the Mac
apps you simply have to have

inding and installing Mac apps is easier than ever,
thanks to Apple’s brilliant Mac App Store, It works by
letting you install apps with just a click, and you can be
assured that they will be safe for the Mac device you are
using. You can still download and install apps from anywhere
on the web, but the App Store is by far the most efficient and
safe way to add new software to your setup. The apps extend

the functionality of any Mac greatly, and without them your
choices are limited as to what you can do. There are thousands
available, and they cover near enough every conceivable
subject or task that you need to complete. This feature will
highlight the essential apps from every app category, and
hopefully narrow down your search for the best of the best.
Your choice of apps is genuinely unlimited.
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I Essential apps

5 essential apps

The Lost Watch 3D
Price: £0.99/5099 Dewveloper: Igor Panichey

Mot all wallpapers are the same, and The

Lost Watch 3D proves that. Besides

looking beautiful, it will show you the
current date and time, and also lets you personalise
it in a rather creative way. It can work as a wallpaper
or a screensaver, and there are multiple themes to
choose from. If you want to add a personal touch,
then simply choose a photo, and it will be shown
inside the pendant displaying the time. However,
an app like this isn't about the features, but how
good it looks and how well it works, and it
succeeds in both areas.

Go for Netflix
Price: £499/5499
Developer: Chatsworth and Whitton Limited

This app is a great solution for heavy

Netflix users — mainly because it enables

you to access your account without
loading up a web browser. This way you get quick
and easy access to Netflix's huge collection of TV
programmes and movies, Go for Netflix isn't an
ofticial app, but it is well designed and features
hotkey and gesture support. Check out the
awesome Auto-Pause/Resume feature too.

Deskappp for YouTube

Price: Free Developer: Rocky Sand Studio L

Similar to Go for Netflix, this allows you to

access the service without opening your

internet browser. But don't think that
because this app is free it is lacking features. When
the window is minimised, it can automatically
pause the video and start again when re-opened.
You can also receive notifications when a channel

you've subscribed to posts new content.

MPlayerX
Price: £1.59/5199 Developer: Zongyao QOu
MPlayerX is an upgrade to your Mac's
"I@IH built-in QuickTime Player. By default your
Mac is programmed to play a select
amount of files, but MPlayerX brings compatibility
for virtually any file type you can throw at it. A
perfect app for anyone with a big movie collection
on a NAS drive or external hard drive.

Shazam
Price: Free Developer: Shazam Entertainment

Shazam has been around for quite a while

and it is a brilliant little app that will

ensure that any music your Mac hears will
be instantly identified. Handy if you're listening to
the radio while working and you missed the name
of the band or artist currently playing. So good that
it's been incorporated into mobile technology.
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Entertainment

Have a whole lot of fun on your Mac

The word ‘entertainment’ can cover a multitude
of things. From listening to internet radio to
watching movie clips and enjoying clever
screensavers, you can entertain yourself in almost
any way you like, It is a broad category, and is

hard to define completely, but it is also a category
with a wealth of apps that will help you pass your
spare time. You can learn magic tricks, watch Earth
from space, or simply sit back and watch a realistic
fireplace fill your Mac screen. The days of computers
being used purely for business are over; now, you

can use them for any activity you like. Entertainment
is one activity that everyone should spend some
time enjoying on their Mac - the only dilermma

is choosing from the huge range of apps that are
designed to make everyday life a little more fun.
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B Media is recreated perfectly in MPlayerX

“There are a wealth of
apps to help you pass
your spare time”
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B | oad up YouTube quickly and easily




B Neon Drive will give you a stunning
trip down Memory Lane

Have fun and keep your
brain engaged

Games

Gaming has historically been somewhat lacklustre
on the Mac platform, but the huge growth of iO5
gaming has transferred to its bigger brother. Popular
titles in the puzzle and strateqy categories have long
been standard, but there are now many hundreds
maore options available, most of which are at very
cheap prices. To complement these simple titles, there
is now a variety of high-end arcade titles available,
some of which actually rival games consoles in terms

of quality, longevity and addictiveness. You can choose
almost any game type you like, depending on your
preferences and the budget available, and can be sure
that the games you like to play are available. Every
possible genre is covered, and once you start you

may find that you play games on your Mac more than
anything else. Everyone needs some fun from time to
time, and a Mac is the perfect tool to help you relax
and enjoy yourself,

B The sinister themes and characters of the series
are taken to the heavens in BioShock Infinite

5 essential apps

Unmechanical

Price: £999/59.99
Developer: MP Digital

Unmechanical is a
ﬁ mind-boggling
puzzle adventure

that is guaranteed to put your
brain to the test. It is easy to
pick up and play, but
Unmechanical gets very tricky
towards its conclusion., It
combines puzzle solving
(more than 30 to be precise),
deep exploration and an
engrossing atmosphere as
you work hard to taste
freedom. In total, there’s over
three hours of gameplay.

Leo's Fortun

Price: £699/56599
Developer: 1337 & Senri LLC
Originally an Apple
Design Award
- winner on i05, Leo’s
Fortune has now been ported
over to Mac with some
prilliant results. Voyage
through stunning
environments, dodging traps
and solving puzzles on your
mission to follow the trail of
gold. The aim is to uncover
the truth behind Leo’s stolen
fortune, and it's so addictive
you won't stop until you find
everything out.

Never Alone

Price: £14.99/514.99
Developer: MP Digial, LLC

«i This atmospheric

‘ "-“q game combines

J elements of
platform and puzzle and is
based on a traditional story of
a boy and his dog's search for
the source of an eternal
blizzard. You can guide both
characters in single player
mode or team up with a friend
and solve the various puzzles
co-operatively. Striking to the
eye and fiendishly puzzling,
it's a beautiful game that lives
long in the memaory.

Neon Drive
Price: £555/5500
Developer: Fracula

Z \ If you're a fan of

\ | retro arcade games
~ and pulsating 80s
synth music, then you've
probably just comes across
your new favourite game. It’s
inspired by that classic era of
gaming, which at its heartis a
beautiful-looking, futuristic,
obstacle-dodging thrash-
around. For such a small
outlay you get seven levels to
complete, packed with
multiple twists and turns to
ensure hours of enjoyment.

g This epic first-person
shooter takes all of
the captivating

characters, sinister events and
stylish visuals that we have
grown to love about the series
and places them in the sky -
the flying city of Columbia, to
be precise. The high-tempo
action is aided by the
introduction of Sky-Lines, a
network of metal struts that
you can latch onto to traverse
the cloud city quickly (and
score impressive kills to boot).
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5 essential apps

Kindle

Price: Free Developer: AMZN Mobile LLC

. ae While your new Mac comes with iBooks as
k *‘ standard, you may already be familiar
_*% \ith the Kindle service. You might have a
Kindle or Amazon account and have bought books
on it. Well, if so, Kindle has a presence on Mac in the
shape of this app. A great reading experience on
the bigger screen, the Kindle app syncs with all
other devices and gives you access to over one
million books in the Kindle Store, including classic
bestsellers and new releases.

Any.do

Price: Free Developer: Anv.DO

3y Over 15 million people use Anv.do. the

t/ \ simple and powerful to-do list app, to
stay organised every day - and it's easy to

see why. For a start, it syncs between all your

devices, 50 you're always up to date. Anv.do will

give you handy reminders, and enables

collaboration between multiple users. You can

even attach notes and files to your to-dos.

Vinoteka
Price: £3399/53499
Developer: tlodie Morin-Ragei

. whether you have one or not, you can

now experience this feeling through Vinoteka. It
will let you monitor every aspect of your wine
collection, and is particularly useful for businesses
involved in this industry. No matter what your level
of expertise or interest, this app is a true example of
what can be achieved on a Mac.

Valt
Price: Free
Developer: Valt Inc

Serious devotees of wine like the thought
of having their own wine cellar anqg,

To put it simply, Valt hides all of your
q/ passwords behind one randomly
generated master password. This not only
makes your Mac more secure, but it also saves you
having to remember numerous passwords for all of
your accounts and social media profiles.

iLove Undelete

A

Price: £4.59/54,

Ly

Developer: Wu Yang
Ever accidentally deleted a file from your
w Mac? Well, trying to get it back is a very
long-winded process, and one that needs
some expert knowledge. Step forward, iLove
Undelete, the new app that will restore deleted
files, as long as you haven't restarted your Mac.
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M Valt hides all of your
passwords behind one
secure master password

Lifestyle

Tailor your Mac to fit in with your life

We all have different lifestyles, hobbies and
interests, and as such a wide range of apps are
required to cater for the majority. This particular
category is more wide-ranging than any other
because it covers all of our interests. From waking
up in the morning to keeping a diary, all of these
and more can fit in the Lifestyle category. With the
right choice of apps, and used properly, they can be
truly beneficial to your day-to-day life, and it is worth
checking as many as possible to ensure that you are
using the ones that are right for you. It is testament

—

B Recipes come to life in Yummysoup!

“The right choice of
apps can benefit your
day-to-day life”

to the creativity of Mac developers that even the

most obscure of interests are covered by Mac apps,

and it goes to show just how flexible and powerful

the platform truly is. Whatever your lifestyle, there
will be an app for it.
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B Effortlessly restore files you've accidentally deleted
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B The Kindle app makes reading on Mac a breeze
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B Discover new SoundCloud mixes with SoundMate
L

M Boom 2 will liven up your Mac's speakers

Music

The days of playing instruments and recording
the resulting sounds to make music could be
numbered. You can now create music in thousands
of different ways, and record your output in
extremely high guality. People now have the
capacity to use instruments that haven't been
designed yet, and have fun searching for new

music using apps that understand their tastes. No
matter what you want to do in the musical field, you

Get down to the
sound of the beat

LER LSRR RN ]

M Djay’s authentic turntables make you feel like a real DJ

can now do it, and some of the solutions also suit
professional musicians. Songwriters, guitar players
and producers can all use complex apps to create
new work, DJs can mix music, and individuals can
create completely original ringtones. Music has truly
reached the digital age, and the digital age has
brought music to anyone, no matter how talented
they are. Now, we can all create music, just as we
wanted to do when we were children.

5 essential apps

Logic Pro X
Price: £19999/519999 Developer: iTunes S.ax
Logic Pro X is a complete set of creative
tools for any musician who wants to write,
record, edit and mix music. It comes with
a huge collection of instruments, effects and loops,
making it easy to get crisp and authentic sounding
accompaniments on your tracks. Novices can get
up and running quickly thanks to production-ready
temnplates, while one-step track setup and a single-
window interface allows you to work fast with easy
access to all of the tools you need. With 40 built-in
instruments, 80 different effects and over 1,700
samples, this is a studio boffin's nirvana.

VirtualDJ Home
Price: Free
DE'\I"E'lﬂper: I."'-“TI._Ir'--||Z_ [-'; FOOUCTIONS .-'ﬂ":'-'l"| - Ir'i::' 5

-,

i y There are some apps that you can pick up
L . \ for free from the Mac App Store that

really make a mockery of some paid-for
apps. VirtualDJ Home is a great example of this. It's
used by some of the biggest DJs in the world to mix
songs, and features a cutting-edge beatlock engine
to ensure your tracks stay on the beat, Even
bedroom DJs will be creating perfect remixes here.

Boom 2
Price: £14.96/51499
Developer: Global Delight Technologies
It's no secret that the sound that comes

N from your Mac’s speaker isn't very good.
. It's pretty tinny, actually. The audiophiles
among you will want to download Boom 2, which
enhances and optimises the sound of music files to
instantly transform your listening experience.

djay Pro
Price: £48.96/54¢
Developer: algoriddim GmbH

F If you've ever wanted to be a DJ, but
‘ n didn’t have the confidence to try it, you
~ now can with this brilliant app. The
feature set is immense and the presentation is
realistic, so you have no excuse to not play around
with your music and spin some virtual discs. You
can even ‘scratch’ them like a true pro.

SoundMate for SoundCloud

Price: £499/5499 Developer: Deng Gao
SoundMate for SoundCloud is a social
network for musicians and music lovers,
populated by big-name acts showcasing

their latest projects and aspiring musicians who

upload their own tracks to get feedback. The

community is friendly and it is a great place to

share sounds with other users.
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5 essential apps

Reeder 3

Price: £599/5999 Developer: Silvio Rizz

% When it comes to news aggregation

‘ ‘. J services, few are as popular as Reeder. If
Y you want a clean, smooth and easy to use
news reader, then you'll want to grab a copy of
Reeder 3. Put simply, it's the best at what it does,
providing you with a home for all the news you
could possibly wish to read. Reeder has support for
multiple services, including Instapaper, Feedly and
NewsBlur. Thankfully, the design of the app takes
heavy cues from El Capitan — even the font is the
same system one used across macOS and iO5.

Feedly

Price: Free Dewveloper: DevHD

a Feedly gathers features and news stories

@ from your favourite websites, blogs or R5S
feeds and collects them into one handy

feed. You can select to have an unread counter so
you know when there's something to read. Feedly
is also available as an iPhone/ iPad app, having
both the mobile and Mac app means you can sync
the content across both platforms. You can have all
the news you need wherever you are,

Downcast

Price: £455/54.59
DEHE'HPEI‘! lamawkinaw Enterprises
Not everyone wants to get their news by
@ reading it digitally. A great alternative is to
listen to podcasts, and Downcast is an
ideal deal way to manage and listen to a library of
your favourite podcasts. Downcast first made its
name on iPhone, but has been nicely ported to
Mac. It's packed with features, but at its core it is a
place to search, subscribe and download audio. It
fully supports iCloud syncing too.

Pocket

Price: Free Developer: Read It Later, Inc
Packet provides a handy service for
storing all of the web articles and videos

= that you don't have time to explore
presently in the cloud and makes them accessible
through any device. You can even read articles
offline, making this idea for those long commutes.

Pulp

Price: £995/5595 Developer: Acrylic 50

‘arwdl | This innovative news reader transforms
‘g‘ your favourite news sites into your own
v/ personalised newspaper, making
scanning through the news quicker and more
enjoyable than ever before. By putting multiple
news feeds onto a single page, Pulp lets you quickly
browse through headlines to find hot topics.
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B Use Feedly to catch up on the
news that matters to you
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News

Keep informed on everything
in the world today

It used to be that the best way to keep up with
the news was to visit websites. Of course, this
works well for sites like the BBC, but for specialist
topics it can invalve hunting around for the

right places. Some Mac apps are now capable of
recreating news provided by websites in a way
that is more friendly, logical and easier to read.
Other apps will autornatically grab the latest news
and present it on the desktop, and the options for
reading a variety of topics are almost unlimited. No
matter what the topic or your visual preference,
there will be a solution that suits the way you want
to catch up with the world around you. Indeed,
some are so good that you may never visit a
traditional website for news again.

"Some Mac apps are
capable of recreating
news from websites”

B Whaole articles can be read without leaving the
MNewsRack app
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W Get your news feeds in your own personalised
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M The iGallery app is a must-have for
anyone who uses Instagram
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B Use Macphun's Filters for Photos to add
filters to your editing suite

B Get the power of Photoshop for a fraction of |
the price with Affinity Photo

Photography

Photographers will tell you that, often, a lot of

the work required to create a great photograph
happens on a computer after the photo has been
taken, and this makes the Mac platform ideal for
anyone with an interest in this field. It doesn't

matter if you are experienced or new to the world of
phatography because there will be a solution, and the
majority are designed to be as easy to use as possible,

WEADE

Store your memories, and
create new ones

From adding speech bubbles to making photos
look like they were taken many decades ago, you
can do almost anything you want with a Mac and a
collection of digital images. You can take this as far
as you like or just play around, but either way, the
platform and available apps will offer you everything
vou need to get started and enjoy the world of
photography for professional or personal reasons.,

B Fotor gives you everything you need to
tweak images to perfection

5 essential apps

Affini |t3r F’hﬂtu
Price: £33.99/53400
Develc}per Serit

Fotor Photo Editor

F‘rice: rr.-_-.-_- Deuelnper:

iGallery for
Instagram

Filters for Photos PicFrame

Price: Free Price: £799/57599

Developer: Macphun Developer: Active
Filters for Photos Develog
does exactly what its
name suggests,

supplying you with endless

Price: Free Developer:

N || Tol _hengyu Huang

; Viewing your
( €=} ) Instagram account

Qr -|--.-.|-:T

Fotor is a great way
of transforming
/ everyday images —

MM

The old saying goes

£ WY youneed Photoshop

» A good frame can

to do some really make even the

powerful image editing on

Macs. Affinity Photo proves
you don't, giving you the
power of Photoshop at a
fraction of the price. It's
engineered for professionals,
and includes support for
unlimited layers and
retouching effects of the
highest standard. Affinity
Photo is so good, Apple made
it one of its apps of the year.

filters to add to your built-in
Photos app in macOs5.
Accessible as a third-party
extension, this wonderful free
app gives you creative filters to
transform your images. Apply
one of the filters, tweak the
strength of it and then save it
to your Photos library or share
it via all the usual social sites
for the world to see.

dullest pictures look
attractive, and this affordable
app features 67 adjustable
frames, with support for up to
nine photos in a single frame.
Once you have composed
your photo arrangements, you
can share them on Facebook
or Twitter, or just enjoy gazing
at themn on your desktop. For
the price, this is a brilliant app
for showing off your snaps.

into works of art. You can
touch up photos, add filters,
text, borders or put a group of
images into a collage, Fotor
has everything you could
possibly need - plus it’s free
and easy to use. If you know
nothing about exposure and
contrast, you can also just click
on the 'Auto’ button and Fotor
will calculate the perfect edit.

online is a pretty
unwieldy way of using the
photography social network,
but iGallery for Instagram
solves that problem with its
gorgeous edge-to-edge
imagery, direct messaging
and upload support. The app
lets you view images and
videos at full resolution in
their original aspect ratio. A
must-have for Instagrammers.
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Productivi

IVlaximise your output

Productivity takes many forms, and there are
solutions that will help you be more productive,
no matter what your need or speciality.
Everything from creating text documents to
building databases can fall into this category,
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M Bear's focus mode is brilliant
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B Fantastical 2 will keep your calendar in
perfect shape and keep you productive

and it is without doubt one of the more diverse
categories, encompassing a wide range of apps.
If there is any task that you need to be more
productive at, there will likely be a solution
available. It may require some careful searching, but
a solution will arrive that could potentially speed
up every aspect of your work, which can have
major benefits for almost everything you do with
your desktop or laptop. Sometimes, the smallest
solutions offer as many benefits as the larger apps
and you should take time to see if a collection of
smaller apps will work better than ane large app.

“There are many great
productivity solutions”

B Multiple views are
available in Evernote

B Capture your thoughts and
create to-do lists with Wunderlist

5 essential apps

Bear

Developer: Shiny Frog
If you're a professional writer, or writing is

. a daily hobby for you, Mac users don't
have a huge selection of options. Bear is

multi-purpose, so it acts as a typewriter, an
organiser and a journal. Bear works so well in focus
mode as it allows you to concentrate entirely on
your words. Some of the features are locked behind
a monthly subscription but there is enough content
with the free version,.

Fantastical 2
Price: £4899/54999
Developer: Flexibits

MY The best third-party apps are the ones
that hugely improve your everyday Mac

experience. Fantastical, for example, adds

a huge amount of features to your stock Calendar
app. You can add events quickly, integrate
additional calendars from third-party sources and
link with your contacts.

1Password
Price: Free
Developer: Agilebits Inc
If you want to apply extra security to your
Mac and protect all of your various user
names and passwords then this app
works directly with your browser, saves all of your
details and then effortlessly creates strong, unique
passwords for each site. The app can then
automatically and securely log you in, enter credit
card information and fill in registration forms, all
while encrypting your info with one password.

Wunderlist

Price: Free

Developer: & '\Wunderkinder GmbH

- A If you need an outlet for all of your
creative ideas, or you just need an

W ¥/ efficient and robust app for creating

quick and easy to-do lists then this app fits the bill

perfectly. Through a simple interface you can get

down your notes and share them with others.

Evernote

Price: Free Developer: Everncte

i Evernote is a hugely popular online note
system and can help you manage and

organise many aspects of your life, This
free app brings all of your notes and quick
synchronisation to any Mac and is designed to offer
all of the main features on your desktop all of the
time. If you like to store thoughts, images and notes
then this is essential.




5 essential apps

WhatsApp desktop
Price: Free Developer: WhatsApp, Inc
Amazingly, it is only recently that Mac
g users have had the option to use the
WhatsApp messaging service, When you
sign in you can sync all of your chats over from the
mobile version so you can continue from where
you left off. Through WhatsApp Desktop you can
text your friends even if they are using the mobile
version. The app is relatively new so there are a few
features that are available on the mobile version
but not the desktop such as phone and video calls
but these may be added in future updates.

Tweetbot
Price: £9.99/5999
Developer: Tapbots
While the official Twitter app is more than
serviceable it is low on killer features, Of
the third-party options available to you,
Tweetbot is the one we'd recommend. It's designed
specifically for Mac (so it looks great and works
with Notification Center) and features support for
multiple accounts — a must for anyone who
balances work and personal accounts. You can view
everything with multiple columns or windows too.

PhotoFeed for Instagram

Price: Free
Developer: Gao Wei

Ever been frustrated by there not being a
@ standalone app for Instagram? Well

there's a quick and handy solution in the
Mac App Store in the form of Gao Wei's Photofeed
for Instagram app - a discreet widget-like app that
gives you direct access to your Instagram feed. You
can also check people's stories, see what photos
Instagram recommends you check out and more,
It's exactly like the mobile version of the app, but
running on your Mac.

Pin for Pinterest

Price: Free
Developer: Chatsworth and Whitton Limited

This app takes your Pinterest addiction to
a whole new level by allowing you to

e nstantly browse your Pinterest account
without having to open your web browser. You will
need Pin Pro to upload new images, but this app at
least allows you to fuel your Pinterest interest.

FaceTime

Price: £099/5099 Developer: Apple
Just because you run an older operating
system on your Mac doesn't mean you
have to miss out on cool apps like
FaceTime. You can grab a Snow Leopard-optimised
version of the app from the App Store and video
message anyone in your Contacts app.

e s HOORS
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Social Networkin

Stay connected with a variety of fantastic apps

-FA1-[.URN =

as standalone apps on a desktop or mobile, There
are apps available that can sit on the desktop and
update you as they work, and others that offer
miore features than the social networks do officially.
Other solutions attempt to bring all of your social
networks together in one place, and even allow you
to update multiple sites at once. If you use any of
the social networks, then there are apps available
that will completely transform the way that you
communicate with friends and strangers. It's just a
question of finding the ones that work best with the
way that you like to talk.

Social networking has grown to be one of the
most used forms of internet communication,
and for some people the big services like Twitter
and Facebook take up the majority of their
online time. Each service has websites associated
with it, but rarely is the web experience as good

“Transform the way that
you communicate with
friends and strangers”
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B Tweetbot uses a column
view to ensure you can

balance multiple accounts
P W PhotoFeed

for Instagram
wiorks just like the
mobile app

Mac for Beginners 173



I Essential apps

5 essential apps

Swing It Pro

Price: £1499G/5149499
Developer: FKE Datakonsult AB
Golf is all about the swing. Without a
good technique, your scores will be
higher and your enjoyment less. You can
either pay lots of money to get some coaching, or
purchase this app and learn at home. It uses videos
to help you visualise what you need to do. You can
crop the videos, create notes and work in your
spare time. It isn't cheap, but compared to
professional coaching, it could produce similar
results, and ultimately save you money.

Pilates Class
Price: £459/54.59 Developer: Tony Walsh

You don't need us to tell you that Pilates is
EV a great way to get - and stay - fit, If you're

keen to learn what it's all about, and you
respond well to video tuition, Pilates Class will be a
great addition to your Mac. The app gives you 380
videos to watch (this actually makes it really good
value for money), and searching is easily done, as is
rating your favourites. You can even see your video
watching history as a handy way to keep track of
YOUr progress.

iPlayBook
Price: Free
Developer: Aletheia Management Partners

“=% 1 This useful app enables a basketball coach
( \ to use their Mac as a tactical drawing
board. With no complicated menus to
navigate, you can be up and drawing in no time.
Arrange players’ positions easily according to your
strategy and even draw special moves with your
mouse, then share it with the players or staff.

7 Minute Workout Pro
Price: £299/ 5299 Developer: Rozga Wojciech
The two things that prevent people from
working out are no spare time and lack of
equipment. This app has made those
arguments obsolete as it provides easy and short
workouts that require nothing but your body, a wall
and a chair. Press play and a voice will talk you
through twelve 30-second exercises with short
breaks between them,

Scoreboard - Basketball Live
Price: £099/50.99 Developer: Jiafu Zhang

ﬂ' Any fan of the NBA will want to get their

= hands on this app. It lives in your Mac's
Notification Centre and provides you with
up-to-date scores and player statistics. You can
bring up a small window that goes over other app
windows so the score is always there,
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B With Swing It Pro you can analyse
any aspect of the perfect golf swing

Sports

Make the most of your sporting abilities

Sports is a category that is broad in that it has
to cater for a wide range of different activities.
Within each sport there are further groups of
people; coaches, players, fans and so on. This
means that app developers have to build a variety
of solutions for every conceivable activity, and this
category alone highlights just how popular the
Mac platform is for apps. No matter what sport
you enjoy, you should be able to find an app that
will increase your enjoyment or participation.
From getting up-to-the-minute timings on motor
racing laps to building strategies and plans for a

U &

Lunges

B Master quick workout routines

"No matter the sport,
you should be able to
find an app to help”

team you coach, you can do it with a Mac. As a fan,
you can also find specialist apps that will present
news and gossip for particular sports, and this
includes information from official sources, which are
presented in a unique way for the desktop.

B TET

B Map out your basketball team's tactics on your Mac
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M iStopMotion feels like creating a home video
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Video

The world of digital video is a curiosity in that
most people will have already been exposed

to it, but few of the creators will take the time

to enhance their media. It is very much seen as a
static media form; you take a video and leave it as
it is to view at a later date. However, you can do 50
much with your creations, and there are all sorts of
apps to help you manipulate all of your personal
and work-related videos. You can add special

5 essential apps

Final Cut Pru }(

Price: £ 20009/
Develanr. Apt

When it comes to

editing video on

your Mac, there is no
better choice than Final Cut
Pro X. It's an app used by real
Hollywood directors to store
and manage their footage,
apply pro-level effects and
share it with the waiting world
in all sorts of formats. Final Cut
can help you get smooth
audio too, as well as tweaking
the colour in your clips.
There's even green screen
features to try out,

Motion

Price: £48.99/549.55
Developer: Apple

Motion is another

app made by Apple,

and another must
have for video editors. Motion
lets you customise Final Cut
titles, transitions and effects.
You can mess around with 2D
or 3D titles, and apply a
variety of effects with the help
of over 230 behaviours, It's a
brilliant way to get natural-
looking motion without any
programming knowledge.
The app's 64-bit architecture
supports layered effects,

Watch the latest and best
videos in high-quality output

effects, funny commentary and even incorporate
them into professional presentations. The beauty

of the Mac is that even the lower-end systems

are able to cope with memaory-intensive video
production really well. The platform is designed to
cope with all types of media, even high-definition
video files, and the video apps available on the Mac
App Store make it all work together in an even more
efficient manner,

Compressor

Price: £48.00/54900
Developer: .

Compressor is an

dapp that anyone

using Final Cut for
professional reasons will want
to download. It adds power
and flexibility to Final Cut’s
export process, customising
output settings, helping you
to work faster with distributed
encoding and giving users
access to a comprehensive set
of delivery features.
Compressor works flawlessly,
even if you throw batches of
video at it.
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B Save your custom settings in Compressor and they'll
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M Final Cut Pro X is powerful enough to use 3D titles
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Price: £1999/51994¢
Developer: Boinx
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Stop motion is a

video effect that

most people had no
access to... until iStopMotion
came along, that is. With this
app, you can spend time
creating a stunning stop-
motion film, where inanimate
objects can be made to move,
which will surprise anyone
that you show it to. The time
required to become adept at
using this is surprisingly low
for the potential results.

Smart Converter
Price: Free
Developer: Systemic Pty
If all you requireisa

simple and effective
video converter app
then this free offering ticks all
of the right boxes by being
able to handle hundreds of
different file types to enable
that they play on all of your
favourite devices. All you have
to do is drag and drop a
media file into the app and
then choose a conversion
type. It will only convert what
is needed, making it one of
the fastest of its type around.
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Chanss & Plan

NEED HELPWITH
THE TUTORIALS?

Having trouble with any of the techniques in this issues tutorials? Don't know how to make the best
use of your free resources? Want to have your work critiqued by those in the know? Then why not
visit the Bookazines or iCreate Magazine Facebook page for all your questions, concerns and
gualms. There is a frendly community of experts to help you out, as well as reqular posts and
updates from the bookazine tearm. Like us today and start chatting!
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